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1 Introduction

The Fabasoft Cloud enables solutions across organizational, IT infrastructural, and international
boundaries. Basic functionalities like intuitively creating automated workflows, seamless
versioning, digital signatures, and full-text search enable a wide range of applications.
Information on the individual solutions can be found in the respective solution documentation.

2 The Web Client

An easy-to-use, completely accessible web client is available to you. Further information on
accessibility can be found in chapters 15 “Accessibility” and 16 “Keyboard Operations”.

Open your preferred web browser, enter the URL of the Fabasoft Cloud and log in with your
favorite log-in method.

Log-in
Depending on the settings in your organization, users can log in with user name and password,
client certificates, ID Austria, SAML 2.0, Active Directory or OpenID Connect.

For two-factor authentication SMS PIN, e-mail PIN and one-time password with RADIUS server
are available.

Linking With ID Austria

To be able to log in with ID Austria, you must create the link to your ID Austria in the account
menu (your user name) under “Login and Password” on the “Digital ID” tab. Click on the “Link
with a Digital ID” button. A new window will open in which you will have to log in again for
security reasons. Once the link has been successfully established, you can also log in with ID
Austria. Please note that you must be logged in with ID Austria to remove the link.

Using Mobile PIN

If you are requested to enter the mobile PIN when logging in, but have not received a PIN, you
have the following options:

e Click on “Send Mobile PIN via SMS Again” or “Send Mobile PIN via E-Mail Again”. This links
will appear after some seconds. You can repeat this process twice.

e Tryto login again.

e Check the cell phone number or e-mail address to which we have sent the mobile PIN. To
do this, briefly hover the mouse pointer over the label of the mobile PIN input field. A

tooltip will pop-up which shows the cell phone number or e-mail address to which the
mobile PIN was sent.

o Contact your organization administrator if, for example, you entered the wrong cell phone
number when registering. Your organization administrator can adjust your account
information accordingly.

e Contact your organization administrator if your cell phone number or e-mail address has
changed.

e [f the e-mail address is correct, please check your spam folder.

¢ If the e-mail cannot be found in the spam folder, please contact the IT administrators
responsible for your e-mail server so that any e-mail server issues (in particular server-side
spam filters, availability of the e-mail server, etc.) can be excluded.
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o If the cell phone number is correct, please check the availability of the cellular network. If
this is the case, please restart your cell phone and then log in again.

e To contact the support, click the support button.
e You cannot use virtual phone numbers (such as Google Voice).

Using One Time Password

Generate a one-time password using your RADIUS token or RADIUS app. You can enter this in
the Please enter your one-time password here field.

To use a different second factor, wait briefly until the “Send Mobile PIN via SMS Again” or “Send
Mobile PIN via E-Mail Again” links appear. These options are only offered if this is configured
accordingly for you.

Web Client

If your web browser is not optimally configured for the use of the Fabasoft Cloud, a warning
symbol (web browser state) will appear in the top bar. If necessary, click on the icon and follow
the instructions to set up an optimal configuration.

Natascha Falkner Austria
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The web client is divided into following areas:
e home (starting page)
e top bar
e tool area
o title bar
e menu bar (hidden by default)

e content area

Home

The dashboard concept of the home area allows you to show or hide widgets, change their size
and move them. The following widgets are initially available to you:
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e Personal Folder
In your personal folder, you can store Teamrooms that are important for you.

e Organization Folder
Contains all standard Teamrooms of your organizations in which you are authorized.
¢ Teamrooms Shared With Me
Contains all Teamrooms in which you are authorized as a team member. Teamrooms that

you have created yourself are excluded from this list. For a better overview, the list is
structured by years and months. Via the “Integrate in My Folder Hierarchy” action, you can

”

add the desired Teamrooms to your personal folder, to your favorites or directly to “Home".
e Favorites
Favorites allow you to quickly access objects that you need repeatedly.
o Worklist
Shows your worklist.
e History
Contains the most recently used objects and most recently sent e-mails.
e Follow-Ups
Contains your follow-ups that that fall within the period you defined.

e Other Dashboards
Apps that offer their own dashboards are also displayed directly on “Home".

Customizing the Home Area Individually
The following options are available for customizing your home area:
e Show or hide widgets
The “View” menu allows you to show or hide widgets (if allowed by your organization
policy).
e Moving or resizing widgets
You can move widgets using drag-and-drop or the context menu. You can also specify the
size in the context menu of the widget.

e Storing objects on “Home"
In addition to the widgets, you can also copy and paste important objects directly to “Home”
(if allowed by your organization policy).

e The “Restore Standard” background context menu command can be used to take over the
settings of the organization policy.
Top Bar

In the top bar, your organization logo is displayed on the left and on the right, you can find the
account menu (your user name), the data locations menu, the support button, the logout
button, the quick access button, the home button and the search field.

Tool Area
The tool area is available in all widgets, but not directly on “Home".

The context-independent tools “Tree View" and “Favorites” can be opened and closed via a
quick selection. The “Actions” are always displayed. Depending on the context, different actions
are provided.
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Up to three tool areas can be displayed next to each other (e.g. “Tree View", “Actions” and
“Authorize Team”). The tree view can be resized to be able to read even longer entries
conveniently.

Tree View

Here you can find your Teamroom and folder hierarchy in a tree view, which allows fast
navigation.

Favorites

You can add frequently used objects (e.g. Teamrooms or documents) to your favorites. To do
so, navigate in the desired object. In the “Favorites” tool, the object is offered to be added.

Actions

In the “Actions” tool area, you will find important actions that are relevant in the current
context.

Title Bar

In the title bar, you will find the breadcrumbs of the currently opened hierarchy. If you navigate
in a widget, all other widgets of the same level are display as tabs.

Menu Bar

In the menu bar (hidden by default), menu items are displayed that are available in the current
context.

To display the menu bar, proceed as follows:

1. Click the account menu (your user name) and then click “Basic Settings”.
2. Mark the Show Menu Bar field.

3. Click “Save”.

Note:

e If the window width is not sufficient for displaying the menu commands, they are hidden
and can be reached via the “More” button,

e Depending on the context, more buttons of important commands can be displayed if the
window width allows it.

e Regardless of whether the menu bar is shown or not, the status information of the list (e.g.
number of entries, sorting) is displayed. In addition, the “Refresh”, “Sort” and “View"” buttons
are available.

Content Area

In the content area, the content of the current object is displayed. This may be, for example, the
contents of a folder or the preview of a document. The top level is referred to as “Home".

Basic Operations
For your first steps in the web client:

¢ Click with the left mouse button on the desired control to execute the corresponding
action.
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¢ The “Actions” tool always contains the most important actions of the current context. The
actions apply to the object that is displayed in the content area. For example, if you are in a
Teamroom, the “Upload” action imports a file in the currently displayed Teamroom.

e The context menu of an element can be opened by clicking the right mouse button. Usually
you will find, beside the actions that are also shown in the tool area, further less frequently
used actions.

o Context menu of objects
Right-click an object in the content area. The context menu of this object is opened.

o Context menu of the title bar
Right-click the title bar. The context menu of the object that is displayed in the content
area is opened.

o Background context menu
If you are in a Teamroom or folder, right-click an empty area in the content area. The
context menu contains actions that are relevant for working with lists (e.g. to create a
new object in the list).

e To select entries in a list, click the check box beside the entry. This way you can, for
example, execute a context menu command on several objects.

Customizing the Web Client
To adjust the basic settings (e.g. the language) of the web client, proceed as follows:

1. Click the account menu (your user name) and then click “Basic Settings”.

2. Make the desired settings and click “Save”.

Note: The Show Menu Bar option refers to the content area. In the property editor, menu bars
are always displayed, regardless of the setting.

3 Collaboration with Teamrooms

A Teamroom offers the possibility to work together and exchange documents with your
contacts.

Via the Teamroom, you define the team and consequently the access rights. Using folders, you
can structure the Teamroom and classify documents accordingly.

3.1 Creating a Teamroom

To create a Teamroom, proceed as follows:

1. Navigate in your “Personal Folder”.

2. Click the “Create Teamroom” action. Alternatively, click the “Create Teamroom” card in the
content area.

Enter a name for the Teamroom.

4. Select another organization, if applicable.
Note: The organization is only changeable, if you are a member of at least two
organizations.

5. Click “Next”.
Note:
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e The “Allow Public Links” and “All Team Members May Invite Members"” options are disabled
by default.

e If you are a member of several organizations that are assigned their own tenant, you must
also select the tenant to which the Teamroom should belong.

3.2 Structuring Teamrooms

For structuring documents in a Teamroom, folders are provided.
To create a folder, proceed as follows:

1. Navigate in the desired Teamroom.
2. Click the “Create Folder” action.

3. Enter a name for the folder and click “Next”.
Note:

e You can also create folders within folders.

e In Teamrooms, additional Teamrooms can be created. The access rights defined by the
Teamroom only apply to assigned objects but not to contained Teamrooms. A Teamroom
always defines its own security context.

3.3 Documents in a Teamroom

Documents are managed in Teamrooms. Below you will learn how to open, upload, download
and create documents.

3.3.1 Editing Documents

You can open documents directly from the web client in the corresponding third-party product.
As prerequisite the Fabasoft Cloud Client and an appropriate third-party product has to be
installed.

Note: To check the status of the Fabasoft Cloud Client, open the account menu (your
username) and click “State” > “Web Browser State”. If errors or warnings are displayed (e.g.
because of a not installed or not current Fabasoft Cloud Client), follow the instructions and
resolve the problems.

To edit a document, proceed as follows:

1. Navigate in the desired document. In the content area, the preview of the document is
displayed.

2. Click the “Edit” action (document is editable) or “Read” action (document is read-only). If
several options for opening are available (e.g. with Microsoft Office on the device or with
Microsoft Office for the web), these can be selected via a submenu.

The third-party product associated with the document is opened.

3. Ifyou have opened the document editable, carry out the desired changes in the third-party
product. When saving, the document is directly stored.

4. Close the third-party product.
Note:

Fabasoft Cloud 15



e To have metadata available in a Microsoft Excel worksheet, you can enable the option Use
Fields in Microsoft Excel on the “Contents” tab. The “Define Fields” button allows you to
define the available fields and the name of the worksheet on which the values of the fields
are to be included.

The selected fields are exported to the defined worksheet and can be linked in the Excel
workbook. Available columns: “Identity” (short reference), “Display Name” (tab > property
name) and “Display Value” (value of the property).

¢ If Office for the web is enabled for you, you can define how documents should be opened,
click “Basic Settings” in the account menu (your user name). In the Office Documents field,
you can choose how to open Office documents (always in Microsoft Office on the device,
always in Microsoft Office for the web or on demand). If the Office Documents field is not
available, your organization administrator does not allow the use of Microsoft Office for the
web.

¢ If you choose open always in Microsoft Office for the web, the preview of documents is also
shown with Microsoft Office for the web.

e Microsoft Office for the web supports the file types Microsoft Word, Microsoft Excel,
Microsoft Visio and Microsoft PowerPoint. Currently there is a known issue of Microsoft
Office for the web that files with “docm” extension cannot be edited.

e Editing LibreOffice documents (OpenDocument Text with extension “odt", OpenDocument
Spreadsheet with extension “ods” und OpenDocument Presentation with"odp”) is also
possible with Microsoft Office for the web.

e To be able to use Microsoft Office for the web, Microsoft Office 365 Business or Education is
required.

e Documents in encrypted Teamrooms cannot be opened with Microsoft Office for the web.

3.3.2 Uploading Files

To upload a file, proceed as follows:

1. Navigate in the desired Teamroom or subfolder.
2. Click the “Upload” action.

Select the file that should be imported. Depending on the web browser, you can select
multiple files.

4. Click "Yes" to confirm the upload.

Note: In the settings of Teamrooms, on the “Content Settings” tab, in the Remove PDF
Document Restrictions on Uploadfield, you can specify whether to remove the PDF document
restrictions when uploading PDF documents. A possibly defined password to open the
document will not be removed.

3.3.3 Uploading Files With Drag and Drop

To upload a file with drag and drop, proceed as follows:

1. Navigate in the desired Teamroom or subfolder.

2. Locate the file you want to import in your file system. Depending on the web browser, you
can also import whole folder structures and several files with drag and drop.

3. Drag the file with pressed left mouse button into the web client.
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Note: When a file is uploaded directly in your personal folder, a Teamroom is automatically
created and the file is stored therein.

3.3.4 Uploading Files With Keyboard Shortcuts

To upload a file with keyboard shortcuts, proceed as follows:

1.
2.

3.

Navigate in the desired Teamroom or subfolder.

Locate the file you want to import in your file system. Mark the file and press ctr1 + c. You
can also mark a folder or several files.

Switch to the web client and press ctrl + v.

Note: When a file is uploaded directly in your personal folder, a Teamroom is automatically
created and the file is stored therein.

3.3.5 Downloading Documents

To download a document, proceed as follows:

1.

Navigate in the desired document.

2. Click the “Download” action.

The file can be found in the “Downloads” of the web browser.

Note:

¢ You can download multiple files or entire Teamroom or folder structures at once. To do so,
select the desired objects and execute the “Download” context menu command.

If the downloaded folder structure contains recursions, the recursion-triggering folders are
downloaded only once.

In the basic settings, on the “General” tab, in the Download a Folder or a Selection of
Multiple Objects field, you can specify whether the Fabasoft Cloud Client or the web
browser functionality should be used for downloading.

o If you have installed the Fabasoft Cloud Client and enabled the corresponding option,

multiple documents or even extensive folder structures are downloaded using the
Fabasoft Cloud Client. Single documents are downloaded using the standard web
browser functionality. You can access the downloaded documents or folders by double-
clicking the automatically selected entry in the opened overview of the notification
symbol or by pressing the Enter key. Alternatively, the “Show” context menu command is
available. Folders with more than 200000 objects cannot be downloaded.

In the options of the Fabasoft Cloud Client, you can define the download folder.

If you have not installed the Fabasoft Cloud Client or you have enabled the web browser
option or in case of public links, folder structures are combined into a ZIP file. Note that
you can download folder structures with a maximum of 1000 objects. The ZIP file must
not exceed 2.5 GB in size.

3.3.6 Moving Documents Within the Web Client

To copy or move a document within the web client, proceed as follows:

1.

Localize the desired document. If you want to copy or move several documents, mark
them.
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2. In the context menu of the document click “Copy” (ctr1 + c)or “Cut”(ctrl + x). When you
copy the document, it is copied into the clipboard, when you cut the document itis
additionally removed.

Navigate to the desired target Teamroom or subfolder.

Open the context menu in an empty part of the content area and click “Paste Shortcut”
(ctr1 + v)or “Paste Duplicate”. If you paste a shortcut, it is the same document. If you
paste a duplicate, an independent copy of the document is created.

Note: The “Orphan Objects” tab of a Teamroom shows objects that are assigned to the
Teamroom, but are not stored within the Teamroom. This is the case when an object was
removed with the “Cut” command but was not stored again in a Teamroom.

For more information on shortcuts, see chapter 3.6 “Working with Shortcuts”.

3.3.7 Storing Documents by Performing a Search

To perform a search, proceed as follows:

1. Enter the desired search query in the search field in the title bar and press “Enter”. For
more information, see chapter 5.1 “Search With Mindbreeze”.

2. The search result is displayed and the “Refine Search” tool area will open. Only results are
displayed, you are allowed to search for. You can use the tool area to further restrict the
search (e.g. to Teamrooms or organizations).

3. You can use the "Copy" context menu command to copy the required documents to the
clipboard and store them in a Teamroom.

3.3.8 Creating New Documents

To create a new document, proceed as follows:

1. Navigate in the desired Teamroom or subfolder.

2. Open the context menu of an empty part of the content area and click “New".
3. Select what you want to create (e.g. Microsoft Word Document).
4

Enter a name and click “Next".

The document is stored in the current Teamroom or subfolder.

3.3.9 Commenting Documents

PDF documents, images or documents that can be converted into PDF documents can be
commented using an integrated PDF viewer. The comments are extracted from the PDF
document and saved in a public or private layer. Thus, the document does not have to be
duplicated if you want to share general comments with other team members but private
comments should only be visible to you.

Note: When using a read license, comments can only be attached via an external PDF viewer.

Integrated PDF Viewer

To attach comments, navigate in the document. In the PDF preview, use the “Comment” button
to open the PDF document for commenting.

e Select “Comment Privately” or “Comment Publicly” in the toolbar.
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e Use the “Drawing”, “Note”, “Text” and “Line" buttons to select the desired comment type.
Depending on the comment type, further options are available.

¢ In the left area you will find an overview of the attached comments, which you can also
delete again if necessary.

e The adding of public comments is also possible with read access.

External PDF Viewer

To attach comments, navigate in the document. In the PDF preview, use the “Show comments
toolbar” and “Comment Privately” or “Comment Publicly” buttons to open the PDF document
for editing. The comments attached in the external PDF viewer are saved as private or public
comments.

Note

e Commented documents are marked with a status symbol.

¢ If you edit the PDF document using the “Edit” action, the attached comments are saved as
public comments.

¢ If the content itself changes (e.g. by replacing it with another file), the previous documents
including comments are still available. The documents can be selected via a drop-down
field in the PDF preview.

¢ When you download a PDF document or execute the “Send” > “Send Commented PDF"
context menu command, the PDF content is commented with the comments visible to you.

e When an AutoCAD file is printed to PDF, comments are implicitly created. These comments
are not separated.

e Comments can also be attached in the two-part view of documents (e.g. in the course of
registration).

e For Teamrooms, the following can be defined on the “Content Settings” tab:

o Allow Comments
Defines whether PDF comments can be added to documents of the Teamroom.

o Allowed Types for Comments
Defines the allowed types of comments (public or private).

o Preferred Type for Comments
Defines the type of comment initially selected when commenting (overrides the setting in
the user's basic settings).

o Users With Read Access Are Allowed to Comment Publicly
Defines whether users with read access are allowed to add public comments.

3.3.10 Digitally Signing Documents

To digitally sign documents, the following options are available.

¢ If your cloud organization does not have its own organization certificates or no certificate
has been released for you to use, you can use a certificate provided by Fabasoft for signing.
This enables you to confirm that the document has not been changed since it was signed.

¢ If your cloud organization has organization certificates that have been released for you to
use, you can use them for signing. This enables you to confirm that the document has been
signed by an authorized person and has not been changed since then.
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¢ If you have a personal primesign signature certificate from the qualified trust service

provider CRYPTAS (https://en.cryptoshop.com/fabasoft.html), you can sign with qualified
electronic signature. Alternatively, the trust service provider SwissSign
(https://www.swisssign.com/) can be used for the qualified electronic signature (SwissID
app and SwissID account required).

Note: To be able to use a qualified electronic signature, you must enable the Use Qualified
Electronic Signatures option under “account menu (your user name)” > “Advanced Settings”
>“My Signatures”.

To digitally sign a document, proceed as follows:

1.

Localize the desired document.

2. In the context menu of the document, click “Sign Digitally” or “Sign Digitally and Close”.
Note: If the document is already closed, the “Sign Digitally” context menu command is
provided.

3. If signature elements have been predefined, they can be filled with a double-click.
Alternatively, an overview of all signature elements is available on the right side. Click the
corresponding element to fill it.

4. If you want to select a certificate or add a remark, click the “Further Information” button.
Note: The certificate selection is only offered if multiple certificates are available.

5. If you want to add a company stamp, click the “Insert Company Stamp” button.

o Click on a predefined company stamp to insert it.

If you want to add a signature element, click the “Insert Signature Element” button.

If you want to add a visual signature, click the “Insert Signature” button.

o To sign with a qualified electronic signature, enable the Qualified Electronic Signature
option.

o Click on an existing signature to insert it.

o Click “Add Handwritten Signature” (if supported by the device), “Add Textual Signature”
(enter a text) or “Add Image Signature” (select or upload an image) to apply a new
signature.

8. C(lick the “Sign Digitally” button.

Note: If you sign with a qualified electronic signature, you are redirected to the trusted

service provider.

Note:

The position of the inserted elements can be changed by clicking in the element and
moving it with the mouse button pressed. The size of the position frame can be changed
using the corresponding frame points. If you use the frame point of the lower right corner,
the content will be scaled additionally.

A PDF document with the digital signature is created and saved as final form with the
document.

Use cases such as “Read” or “Download” refer to the signed PDF document in the final form
of the closed document.

In the document properties, the signatures are listed in the Signatures and Digital
Signatures fields on the “Signatures” tab.

Your visual signatures and company stamps can be found under “account menu (your user
name)” > “Advanced Settings” > “My Signatures”. You can also add or remove signatures
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here. You will see the organization certificates that have been released for you to use. You
can enable or disable the option to sign with a qualified electronic signature.

Signature Elements

The position and size of visual signature elements (signature area, name, date, place, company,
text) can be predefined.

When inserting a signature element, it can be explicitly assigned to a signee. Thus, signees can
jump directly to the corresponding signature area via the symbol bar. For signature areas a
company stamp can be selected that is to be displayed with the signature. In addition, you can
define that a qualified electronic signature is required.

You can define signature elements as follows:

¢ In Microsoft Word documents, the “Insert Signature Element” button is available on the
“Fabasoft Cloud” tab.

e For other documents, use the “Define Signature Elements” context menu command.

o In the Signeefield, you can define whether you want to use a new signee or no signee for
the signature elements to be inserted.

o Signees already in use can be selected as the default value in the Sjgnee field. This
enables the signature elements to be inserted efficiently.

o You can drag and drop the signature elements directly to the desired position.
Alternatively, you can insert a signature element by clicking on it.

o Signature elements that have already been inserted can be edited by double-clicking.
Note:

e Signature elements in Microsoft Word can best be positioned using "In Line with Text".
e Signature elements cannot be inserted in text modules (Word).
¢ Signature elements cannot be used in Microsoft Word documents in compatibility mode.

e Signature elements cannot be used in Word documents that are merged programmatically.

When you double-click a signature area during digital signing, the signature selection dialog
opens. After selecting the signature, it is inserted and the signature area is deleted. When you
double-click on other signature elements, the corresponding predefined text is inserted, which
can still be modified.

Signature Folders

Using a signature folder, several documents of a file can be combined, visually signed, and
digitally signed. Signing by means of a signature folder is started on a file via the “Tools" >
“Prepare Signature Folder” context menu command. Alternatively, the “Prepare Signature
Folder” activity, which is available for BPMN and ad hoc processes, can be used. The signature
process offers the following options:

“Prepare Signature Folder” activity
The "Prepare" work step can be used to create the signature folder.

e Name
The name of the signature folder.

e Handwritten Signatures
Defines whether the documents should also be signed by hand. For this purpose, the
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documents are printed together by a responsible person and scanned again with all
handwritten signatures.
o No handwritten signatures
There are no follow-up activities regarding handwritten signatures.
o Handwritten signatures take place before digital signatures
The “Print Signature Folder” and “Upload Signed Document” activities are assigned to the
defined responsible user before the “Sign Signature Folder” activities.
o Handwritten signatures take place after the digital signatures
The “Print Signature Folder” and “Upload Signed Document” activities are assigned to the
defined responsible user after the “Sign Signature Folder” activities.
o Handwritten signatures are already on the document
The “Upload Signed Document” activity is assigned to the defined responsible user
before the “Sign Signature Folder” activities.
e Signees
Defines who should sign the documents. The “Sign Signature Folder” activity is delegated to
the signees in the defined order.
You can either enter users or contacts directly or add signees using the “Advanced Display”
button. The advanced view allows you to specify signees based on Abstract Participant,

Useror Organizational Unit.
When a contact is selected, an external user is automatically created.

e Documents
The specified documents are closed and digitally signed.

“Print Signature Folder” activity

The "Print" work step can be used by the responsible user to print the documents that have
been combined into one PDF document.

“Upload Signed Document” activity

The "Upload" or "Scan" work step can be used by the responsible user to upload the combined
document.

The "Sign Manually" work step can be used to record manual signatures digitally.
“Sign Signature Folder" activity

The "Sign" work step can be used to visually and digitally sign the combined PDF document. The
individual documents are also digitally signed.

Note:

¢ In the properties of a document signed using a signature folder, the “Signatures” tab
displays the Signature Folder of Last Signature field. The Signatures field displays the
Signature Folder column.

¢ In the properties of a file, the “Signatures” tab also displays information about the signature
folders.

o For the definition of standard processes on signature folders, the “Insert Signing Process”
activity can be used.

Fabasoft Cloud 22



3.3.11 Creating a Final Form

You can create a final form for documents that are convertible to PDF. The generated PDF file
complies with the PDF/A standard.

To create a final form, proceed as follows.

1. Show the menu bar if necessary (“Account menu (your user name)” > “Basic Settings” >
Show Menu Bar).

2. Mark the desired document.

3. Execute the “Object” > “Convert Final Form” menu command.

The generated PDF document can be found in the document's properties on the “Content” tab
in the File as Final Form field.

Note:

e When you close a document (e.g. "Sign Digitally and Close" or “Tools” > “Close"” context
menu command), a final form is also generated.

¢ If afinal form already exists and can be changed, the “Update Final Form” and “Remove
Final Form” menu commands are available.

e If the document is a PDF document with a digital signature, you can choose to take over the
existing content as final form or generate a final form (the digital signatures will be
invalidated).

3.4 Defining Team Members

To define access rights for a Teamroom, proceed as follows:

1. Navigate in the desired Teamroom.
2. Click the “Permissions” action.

Via the plus symbol, you can add users to the team by entering their e-mail address or you
can create new external members. Additionally, you may authorize whole organizations or
organizational units.

The Teamroom is stored in “Teamrooms Shared With Me" for the added team members.
Therefore, it makes sense to prepare the Teamroom first, to create structures and to store the
documents before the team is authorized.

You can also inform team members by e-mail via the “Send E-Mail Invitations” action in the
team area. In the properties of the Teamroom, on the “E-Mail Invitations"” tab, you can define
the default text for the invitation e-mail.

Access rights:

e Read Access
These team members can

o read existing documents,

o only see release versions (if existing),

o create public links (if generally permitted for the Teamroom) and
o add additional team members with read access.

e Change Access
These team members can
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o change existing documents, create new documents or folders and delete them
(wastebasket),

o define Teamroom templates,

o create public links (if generally permitted for the Teamroom),

o define logos and

o add additional team members with change access or read access.

e Full Control
These team members can

o change existing documents, create new documents and delete documents (wastebasket),
o define Teamroom templates,

o permit and create public links,

o empty the wastebasket,

o dissolve the Teamroom,

o define settings regarding access protection, shortcuts, public links, team visibility,
invitation possibilities and organization restrictions,

o define logos,

o delete the history,

o read audit log entries,

o change the branding,

o change the organization and

o grant all access rights.
Note:

¢ Via the context menu of a team member, you can change the access rights or even remove
the team member.

e In order to make it clear that the owner or co-owner of an organization has all rights to the
Teamrooms of the organization, the organization is displayed under “Full Control”. When
you expand the organization, you see the actual owner and co-owners.

e The e-mail addresses of users are displayed if the e-mail domain differs from the e-mail
domains stored with the organization. This allows you to see at a glance which users do not
belong to the organization. If you do not have rights to read the user's e-mail address, only
the e-mail domain is displayed. Please note that the display refers to the organization
assigned to the Teamroom,

¢ Inthe properties of a Teamroom, on the “Teamroom” tab, you can define following
restriction:

o Access Protection
Defines who is allowed to access the Teamroom. By default, only the specified team is
allowed to access the Teamroom.

o Restrict Shortcuts Within Teamroom
Defines which type of shortcuts may be stored in the Teamroom. You can restrict the
permitted shortcuts to objects that are assigned to the organization or to objects that are
assigned to the Teamroom. In this way, you can prevent, for example, that shortcuts are
stored to which the members of the Teamroom do not have access.
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Holiday Table
Defines the holiday table to be used in the Teamroom context (otherwise the default
holiday table is used).

Default Thesaurus for New Terms
If a default thesaurus is specified, new terms can be created directly during tagging.

Restrict the Downloading or Opening of Content on the Device
Allows to restrict team members who can open or download content at the device.

Roles That Are Allowed to Open or Download Content on the Device
Defines which permissions a team member must have in order to open or download
content at the device.

Team Members Visible to All Members

Defines whether all members are allowed to see the team members. Note that disabling
this setting also restricts other use cases.

Note: Team members with change access can be eventually seen by all members, since
changes are logged in log properties such as Last Change by.

» Only team members with “Full Control” have access to the “Permissions” action, can
start processes, duplicate objects, use templates and release templates and
presettings.

» Only team members with “Full Control” see the events by default. The display of
events can also be enabled for team members who are not allowed to view the team.
However, only events that could not lead to conclusions about team members with
read access will be displayed.

» Team members with read access cannot use remarks, public comments, signatures,
processes or comment on news feeds.

» Team members with read access cannot use the time travel.
» Team members with read access cannot be selected as participants in processes.
= Team members with read access cannot create public links.

= Team members with read access cannot view the “Processes” and “Activities” tabs of
assigned objects.

Display Events for Team Members Who Are Not Allowed to View the Team

Only team members with “Full Control” see the events by default. The display of events
can also be enabled for team members who are not allowed to view the team. However,
only events that could not lead to conclusions about team members with read access will
be displayed.

All Team Members May Add Members

Defines whether all team members can add users to the team or only team members
with “Full Control”. Members with change access may grant or revoke change access or
read access to other members. Members with read access may grant or revoke read
access to other members.

Restrict Team Members

Defines the organizations, organizational units, teams and external organizations whose
members may be added to the Teamroom. If the list does not contain any entries,
members can be added without restriction.

Main Administrator
Defines the user who will receive the automatically generated e-mail messages
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concerning the Teamroom. Otherwise, all Teamroom administrators receive the e-mail
messages. The user is also listed as contact in case of missing permissions.

o Support Coordinator
The support coordinator team has access to all support requests in the corresponding
context and can perform the same actions as the support request initiators.

o Support Team
The support team handles the organization-internal management of support requests in
the respective context.

¢ When editing the properties of several Teamrooms together, you can also define the
permissions on the “Security” tab. This allows you to efficiently adjust the access rights of
many Teamrooms.

3.5 Sending an E-Mail to Team Members

To simplify collaboration even further, e-mails can be sent directly from Teamrooms to the
team. The “Send” > “Send E-Mail to Team Members” context menu command is available for
Teamrooms and for objects assigned to Teamrooms. When using the context menu command
on objects, they are added as links to the e-mail.

For easy selection of recipients, they can be set based on their role in the Teamroom or based
on a team, organizational unit, or external organization used in a role. Additionally, recipients
can be filtered based on membership or registration status.

Note: The sent e-mails can be viewed in the Teamroom properties on the “Recently Sent E-
Mails” tab.

3.6 Working with Shortcuts

The same objects can be stored as shortcuts (context menu command “Paste Shortcut”) in
different Teamrooms or subfolders.

e When you delete a shortcut, only the shortcut is removed. The object itself and other
shortcuts are not affected. If the object is in the wastebasket, the shortcuts are displayed
with the additional text “(Deleted)". If the object is permanently deleted, the shortcuts will
be removed, too.

¢ When you store shortcuts within a Teamroom in different folders, the shortcuts are
visualized with an arrow. If the object itself is cut, the next succeeding shortcut becomes the
“object”.

e Each object can be assigned to only one Teamroom, which defines the access rights. If you
store an object in several Teamrooms, the shortcuts are visualized with an arrow in a
square. Note that team members have no access to the shortcut, if they are not authorized
in the assigned Teamroom of the object.

e When you cut an object that has no shortcut in another Teamroom and paste itto a
Teamroom, the object will be assigned to that new Teamroom.

e When you cut an object that has a shortcut in exactly one other Teamroom, the object will
be assigned to that Teamroom. If shortcuts exist in several Teamrooms, the object is not
assigned automatically to another Teamroom. In this case you can assign the Teamroom
manually with the “Tools” > “Change Teamroom” context menu command.

The change of the assignment can only be carried out, if you have full control in the original
Teamroom and at least change access in the target Teamroom.

Fabasoft Cloud 26



¢ In the properties of an object, on the “General” tab, in the Teamroom field you can find the
assigned Teamroom that defines the access rights. The Contained infield shows the
Teamrooms and folders in which the object is stored.

¢ In the properties of a Teamroom, on the “Teamroom” tab, in the Restrict Shortcuts Within
Teamroom field you can define which type of shortcuts should be allowed. This way, for
example, it can be prevented that not accessible shortcuts are stored.

3.7 Changing the Teamroom Assignment

An object is always assigned to only one Teamroom. In case shortcuts of the object are stored
in further Teamrooms, the assigned Teamroom can be changed.

To change the Teamroom assignment, proceed as follows:

4. Locate the object, which should be assigned to another Teamroom.
5. On the context menu click “Tools” > “Change Teamroom”.

6. Select the Teamroom the object should be assigned to.
Note: If the object is stored in exactly two Teamrooms, the Teamroom must not be
selected.

7. Click “Change Teamroom".

Note: To change the assigned Teamroom of an object, full control is needed in the original
Teamroom and at least change access in the target Teamroom.

3.8 Changing the Organization Assignment

If you are member of several organizations, you can change the organization assignment of
Teamrooms in which you have full control.

To change the organization assignment of a Teamroom, proceed as follows:

1. Navigate to the desired Teamroom.
On the context menu of the Teamroom click “Tools” > “Change Organization”.

If you are member of more than two organizations, select an organization. Otherwise, the
other organization is already selected.

4. Click “Yes".
The following conditions apply to the change of the organization:

e App configurations, app rooms, Teamrooms with forms, processes or with objects with
running processes
The current user must be allowed to manage forms or processes in the target organization.

e App configurations, app rooms, Teamrooms with objects that have a category assigned
The category must either be defined in the corresponding context or already assigned to
the target organization.

¢ Inboxes with rules
The current user must be allowed to manage inboxes in the target organization.

3.9 Setting the Access Protection

The access protection defines whether non team members can read the Teamroom.
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To change the access protection of a Teamroom, proceed as follows:

1. Navigate to the desired Teamroom.

On the context menu of the Teamroom, click “Properties”.

Select the Access Protection on the “Teamroom” tab.

(o]

“Default”
The Teamroom and its content can only be read by team members.

“Extended by category”

The defined team can access the Teamroom and its contents. Access to individual
objects can also be granted via the category.

Note: You can assign access rights on the “Permissions” tab of the category. When the
category is assigned to an object, the defined permissions are considered.

“Extended by category and workflow”

The defined team can access the Teamroom and its contents. Users participating in
workflow are granted read access. Access to individual objects can also be granted via
the category.

“Generally readable”
The Teamroom and its content can be read by all users.

4. Click “Next". You will receive a notice that this Teamroom becomes public. Click “Next”
again.

3.10

Creating Public Links

You can provide documents read-only to users who have no account.

To create a public link, proceed as follows:

1. Navigate to the desired Teamroom, subfolder or document.

2. Onthe context menu, click “Create a Public Link”.

You can define a description, a validity period and a password. In addition, you can define
whether the “Download” button is available for the public link (if basically allowed in the
organization or in the Teamroom).

4. Click “Create”.

You get a link that can be directly sent or you can copy the link in the clipboard.

Note:

e |Nn

the properties of the Teamroom, on the “Content Settings” tab, you can define following

settings:

o

o

o

Allow Public Links
Defines whether public links can be published.

Block Downloading of Content

Defines whether the “Download” button is offered for public links (even if they already
exist).

Storage Period of Expired Public Links

Entries for expired public links are deleted after the specified period of time. If no time
period is specified, the entries are kept.
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o Default Access Protection
When creating public links, the specified default values are suggested and used when
sending directly.

¢ Via the “Send” > “Send Public Link” context menu command you can directly open an e-mail
with the public link. In the Teamroom properties, on the “Content Settings” tab, you can
define the default access settings that apply to directly sent public links.

¢ If public links exist, it is visualized with a chain symbol.

¢ Existing public links can be managed with the “Manage Public Links” context menu
command.

o You can also retrieve an access report.

o For Teamrooms, you can use the “All Public Links” button to open a query-based list that
allows you to search for objects with public links. Within the query-based list the “Delete
Public Links” context menu command can be used to delete all public links of the
selected objects.

o For Teamrooms, you can use the “Delete Expired Public Links” button to manually delete
the expired public links of the Teamroom.

e The Statefield of a public link shows the state. Public links can be deactivated (Teamroom
or organization level), valid or expired. If the issuer's rights in the Teamroom have been
revoked, access to the public link is no longer possible. When revoking the rights, a
corresponding warning is shown.

3.11 Defining a Logo

For each Teamroom an own logo can be defined. This logo is displayed in the card view, the
thumbnail view and the preview.

To define a logo for a Teamroom, proceed as follows:

1. In the context menu of the Teamroom, click “Properties”.

2. Click the “Logos” tab.

3. Click “Select” to browse for an image on your computer or select one from the Cloud.
4. Click “Next".

Note: You can select a second logo that is used as a thumbnail. This logo will be displayed for
example on the welcome screen.

3.12 Defining a Description

You can define descriptions for Teamrooms. The description is displayed in the content area, if
you are in the Teamroom at top level.

To define a description for the Teamroom, proceed as follows:

1. Navigate in the desired Teamroom.

2. Click the “Define Description” action.

3. Define a title and a description for the Teamroom.

4. Click “Next".
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3.13 Managing Teamroom Templates

You can define objects in a Teamroom as Teamroom templates that are available in the create
dialog.

To define a Teamroom template, proceed as follows:

1. Navigate in the desired Teamroom to the object that should serve as template.

2. On the context menu of the document click “Tools” > “Add to Teamroom Templates”. The
document is added to the Teamroom templates as shortcut.
Note: If you have licensed “Customizing”, the “Add to Templates” context menu command is
available. In this case, you can specify in a further step whether the template should be
added as a copy to the Teamroom templates of the Teamroom (or superordinate
Teamroom) or to a template collection.

The Teamroom template is displayed in the create dialog in the “Teamroom Templates”
category.

Note:

e Documents that already serve as Teamroom templates provide the “Tools” > “Remove From
Teamroom Templates” context menu command.

e To display a list of all Teamroom templates, click the “Templates and Presettings” action and
navigate in the “Templates” list. Here you can also add and remove Teamroom templates.

e Objects that are assigned to other Teamrooms can also be used as Teamroom templates.
Make sure that the team members are authorized in the other Teamrooms to use the
templates.

3.14 Wastebasket and Orphan Objects

When deleting objects of Teamrooms they are not deleted immediately but put in the
Teamroom wastebasket. The “Open Wastebasket” action is only available if at least one object
is in the wastebasket. Objects in the wastebasket can be permanently deleted (“Empty
Wastebasket” or “Delete”) or restored.

You can find objects that are assigned to the Teamroom but no longer stored in the Teamroom
via the “Tools"” > “Show Orphaned Objects” context menu command.

3.15 Displaying New Events

In the card view, the number of changes of Teamrooms is displayed, since you viewed the
history for the last time.

1. Navigate in a Teamroom with new events.

2. Click the “Show New Events” action.

On the “New Events” tab, you find all current events. The tab is only shown if there are
current events.

Note:

¢ The “Show New Events” action leads to the history that contains older entries, too. The
“Delete History” button allows deleting the history and all versions of the objects that are
assigned to the Teamroom (full control is needed).
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e You can use the “Disable Notification” or “Enable Notification” button to specify whether
you want to see new events about this Teamroom at all. Alternatively, corresponding
context menu commands are available for Teamrooms.

e Which changes are considered as new events can be configured under “account menu (your
user name)” > “Advanced Settings” > “Notifications” > “Settings”.

e You can display the history of objects via the “Tools” > “Show History” context menu
command. If there are too many events, the oldest ones are deleted or events worth
keeping are saved in an archive.

3.16 Hierarchical Teamroom Relations

In order to manage hierarchies of Teamrooms easily and clearly, relations between Teamrooms
are available as metadata. The relations without the complete hierarchy across all levels are
displayed on the “Relations” tab. The relations including the complete hierarchy can be
displayed via the “Tools” > “Show Teamroom Relations” context menu command.

Note:

e The “Relations” tab is only displayed, if the Teamroom is related to at least one other
Teamroom.

e The access rights defined by the Teamroom only apply to assigned objects but not to
assigned Teamrooms. A Teamroom always defines its own security context.

e The Teamroom hierarchy includes all types of rooms.
Relations:

e Superordinate Teamroom
A Teamroom can be assigned to exactly one superordinate Teamroom.

e Referencing Teamrooms
A list of all Teamrooms in which the current Teamroom is stored.

e Subordinate Teamrooms
A list of all Teamrooms that are assigned to the current Teamroom.

e Referenced Teamrooms
A list of all Teamrooms that are stored in the current Teamroom.

e Orphan Teamrooms
A list of all Teamrooms that are assigned to the current Teamroom but which are no longer
stored in this Teamroom.

e Subordinate Teamrooms (incl. Hierarchy)
A list of all Teamrooms that are assigned to the current Teamroom or to a Teamroom in the
Teamroom assignment hierarchy.

e Referenced Teamrooms (incl. Hierarchy)
A list of all Teamrooms that are stored in the current Teamroom or in a Teamroom in the
Teamroom hierarchy.

e Orphan Teamrooms (incl. Hierarchy)
A list of all Teamrooms that are assigned to the current Teamroom or to a Teamroom in the
Teamroom assignment hierarchy but which are no longer stored in the Teamroom.
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3.17 Encrypting a Teamroom

If your organization has Fabasoft Secomo and the “Teamroom Encryption” app is assigned to
you, you can encrypt Teamroomes. If you read, edit or upload documents the encryption and
decryption is carried out on the client. Thus, no unencrypted documents are transferred or
stored.

e When you create a Teamroom, you can directly encrypt the Teamroom by clicking the
“Encrypt” button.

e Existing Teamrooms can be encrypted or decrypted via the properties of the Teamroom
(“Teamroom” tab, “Encrypt Documents” field).

e After you have enabled or disabled the encryption, it takes some time depending on the
size of the Teamroom until all documents are encrypted or decrypted.

¢ A pending encryption or decryption is visualized with an opened or a closed lock symbol.
Note:

e When creating new documents in the web client, the documents are only encrypted after
content is added.

e Working with encrypted Teamrooms is also possible without an installed Fabasoft Cloud
Client, so documents can be uploaded or downloaded. The encrypted preview images and
documents are also displayed.

There are the following restrictions for working without the Fabasoft Cloud Client:

o The document size is limited to 100 MB.
o A maximum of 5 files can be downloaded at the same time.
e When encryption is enabled for a Teamroom, versions of the existing objects are deleted.
e For the objects in an encrypted Teamroom, the Teamroom assignment cannot be changed.

e If your organization has multiple key servers configured, you can select a key server if you
are authorized to do so via organizational policy. Otherwise, the default key server is used.

e Collaboration in an encrypted Teamroom can only occur with users whose organization
also has encryption enabled.

¢ Synchronization of encrypted Teamrooms to the local workstation is possible only when
using encrypted file systems on Microsoft Windows and Apple macOS.

¢ In an encrypted Teamroom, documents can only be decrypted at the workstation, so a
document cannot be analyzed or updated within the Fabasoft Cloud. This results in the
following security features:

o No full text search
Encrypted documents cannot be analyzed or searched for in full text.

o No conversion
Encrypted documents cannot be converted.

o No preview
Encrypted documents cannot be prepared for a viewer (e.g. PDF or 3D viewer).
A preview image or PDF view created at the workstation (using the Fabasoft Cloud Client)
is encrypted and can be displayed in the web client.

o No analysis, updating or generation of encrypted documents on the server (affects e.g.
Microsoft Excel, Microsoft Word, CSV and XML files).
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o No provision of encrypted documents via server-side interfaces (affects e.g. WebDAV or
the cloud network drive).

3.18 Transferring a Teamroom

To relocate the processing of a Teamroom in another data location, in the cloud or private
cloud, you can transfer Teamrooms. The functionality is only available if it is configured
accordingly in the organization.

To transfer a Teamroom, proceed as follows:

1. On the context menu of the Teamroom click “Transfer Teamroom” > “name of the cloud
domain”.

2. Inthe Access Rights of the Source Teamroom field, define the access rights to the source
Teamroom after the transfer.

o Keep Access Rights of Previous Team Members
o Restrict Access to the Members of My Cloud Organization
o Restrict Access to the Team Members With “Full Control”

3. Inthe Dissolve Source Teamroom field, define whether the source Teamroom should be
dissolved.

o Do Not Dissolve
The Teamroom will not be dissolved.

o Assign Activity “Dissolve Teamroom”
A workflow activity will be assigned to the specified recipient at the specified time.

o Dissolve Automatically
The Teamroom will be dissolved at the specified time.

4. Click “Transfer” to confirm the transfer.
If you are not logged in to the target domain, a login dialog is displayed.

6. If requested click “Allow” to grant the “OAuth Client” the “Transfer Teamroom" right (only
necessary once).

7. Click "OK" after the transfer has been completed.
Note:

e The Teamroom and the associated objects are marked as transferred in the source domain.
e The Teamroom and the associated objects are no longer editable in the source domain.
e The Teamroom is stored in the “Personal Folder” in the target domain.

e The user rights are transferred. Users are identified by the e-mail address. If users do not
yet exist in the target domain, new users are created.

o Categories of objects are also considered if they exist in the source and target systems and
can be identified by a unique import ID.

e With the “Transfer Teamroom" > “Restore Version Before Transfer” context menu
command, you can restore the version of the Teamroom, which was saved by default prior
to the transfer. Incompletely transferred Teamrooms will be deleted in the target domain. If
a Teamroom was successfully transferred, the connection to the transferred Teamroom in
the target domain will be lost.
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e With the “Transfer Teamroom"” > “Define Dissolve Period” context menu command, you can
also subsequently specify whether and when the source Teamroom should be dissolved.

¢ With the “Transfer Teamroom” > “Open in <name of installation>" context menu command,
you can navigate directly to the target Teamroom. The corresponding action is also
available for objects in the Teamroom.

3.19 Retracting a Teamroom

After completing the collaboration, the transferred Teamroom can be retracted to the original
place.

Note: Teamrooms that are transferred to another data location cannot be retracted. Another
transfer to the initial data location is possible.

To retract a Teamroom, proceed as follows:

1. On the context menu of the Teamroom click “Transfer Teamroom” > “Retract form
<name>",

2. Click “Retract” to confirm the retraction.
If you are not logged in to the target domain, a login dialog is displayed.

4, |If requested click “Allow” to grant the “OAuth Client” the “Retract Teamroom” right (only
necessary once).

5. Click “OK" after the retraction has been completed.
Note:

e The Teamroom and the associated objects are marked as retracted in the target domain.
e The Teamroom and the associated objects are no longer editable in the target domain.
e [f users do not yet exist in the source domain, users are created.

e If the Teamroom could not be successfully retracted, you can restore the version of the
Teamroom in the source domain and in the target domain, which was saved by default
prior to the transfer, with the context menu command “Transfer Teamroom” > “Restore
Version Before Transfer”.

3.20 Publishing a Teamroom

Teamrooms can be published read-only to another data location, to the cloud or private cloud.
To publish a Teamroom, proceed as follows:

1. On the context menu of the Teamroom click “Publish Teamroom” > “name of the cloud
domain”.

2. Click “Publish” to confirm the transfer.
If you are not logged in to the target domain, a login dialog is displayed.

4. If requested click “Allow” to grant the “OAuth Client” the “Transfer Teamroom” right (only
necessary once).

5. Click “OK" after the transfer has been completed.

Note: Teamrooms may be republished (either all objects or only the changes since the last
publishing).

Fabasoft Cloud 34



3.21 Converting a Folder to a Teamroom

The access rights to Teamrooms and the contained objects are defined by the team specified in
the Teamroom. Folders are used for structuring, but do not have their own rights context.

If you want to give a folder a different right context, you can now use the “Tools” > ‘Convert to
“Teamroom” context menu command to convert a folder to a Teamroom. Conversely, you can
also convert a Teamroom located in another Teamroom into a folder.

Note:

e To convert a folder into a Teamroom, you need to have full control in the Teamroom
associated with the folder. If there are other Teamrooms in the folder, you also need full
control in these Teamrooms.

e To convert a Teamroom to a folder, you need full control in that Teamroom and change
access in the target Teamroom for the folder.
If the converted Teamroom is located in multiple Teamrooms, you can select the target
Teamroom for the folder.

3.22 Calculating the Teamroom Usage

As a user with full control, you can calculate the Teamroom usage (number of objects and
storage usage).

To calculate the Teamroom usage, proceed as follows:

1. Navigate to the desired Teamroom.
2. On the context menu of the Teamroom, click “Tools” > “Calculate Usage".

Click the “Calculate Usage” button, to calculate the current usage. The usage is displayed as
first line in the Usagefield.

4, Click “Close”.
Note:

o All objects that are assigned to the Teamroom are considered (for example, also objects in
the wastebasket and the wastebasket itself).

e A maximum of 400 values or the values of 13 months are kept in the usage list.
e You can remove all entries via the “Delete All Entries” button.

e The last calculated values can also be displayed as columns.

3.23 Dissolving a Teamroom

As a user with full control in a Teamroom, you can delete the Teamroom and all its objects.
To delete a Teamroom and its objects, proceed as follows:

1. Navigate to the desired Teamroom.
2. On the context menu of the Teamroom, click “Dissolve”.

Click “Delete” to confirm that the Teamroom and its objects should be deleted. Shortcuts to
these objects will also be removed from other Teamrooms.

Note: If the Teamroom contains subordinate Teamrooms, you can either resolve all
Teamrooms or only the parent Teamroom.
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4 Working with Lists

Teamrooms and folders show the contained objects in the content area as a list. Three
different list views are provided.

For more information on keyboard operation, see chapter 16.5 “Content Area”.

Content View

The content view is displayed per default. In this list, the most important information for the
objects is shown.
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Detail View

In the detail view, you can modify the column settings to get more information about the listed
objects.
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Preview

In the preview, you can find the most important meta data and the preview of the object. For
documents, the first pages are displayed.
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4.1 Selecting Entries

Several objects in a list can be selected to edit them concurrently.
Select several objects

To select several objects in a list, click the objects while keeping the ctr1 key pressed or mark
them via the “Selection” box.

¢ In the content view, the “Selection” box is displayed when you hover with the mouse over
the right side of the line. In the preview you have to hover over with the mouse over the left
side of the line.

¢ In the detail view, the “Selection” box is displayed left to the first column.

e In the card view, the “Selection” box is shown below the cards.
Select an area

To select an area of an object list, select the first entry and press the shift key. Keep the shift
key pressed and select the last entry of the area you want to select. Doing so, all objects
between the two entries are selected.

Select all entries

Select the box in the column header to select all entries (only detail view).

4.2 Change the View

To switch between the views, open the context menu of the content area.

1. Open the context menu of an empty part of the content area and click “Change View".

2. Select the desired view.
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4.3 Display Settings

"

With the menu bar displayed, you can make appropriate view adjustments via the menu “View
> “Display Settings".

Load

Allows you to load a saved display setting or the product setting.

Reset

Restores the default display settings (only visible if the current settings differ from the default
settings).

Save
The current display setting (view, columns) is saved.
Following storage options are available:

o Set Default View for “<object>" for All Users
The defined view is displayed by default for all users. This option is only available if you
have at least change access.

e Create New Display Setting

o Save as
The display settings can be saved at various levels (personal presettings, room,
configuration, collection for templates and presettings). The available levels depend on
the context and your permissions.

o Name
Assign a name to the new display setting.

o Define as Default for Objects of This Type
Defines whether this display setting is applied to new objects of this type and to existing
objects whose display settings have not been changed. The display setting actually used
is also determined by the evaluation hierarchy.

e Overwrite Existing Display Setting
o Existing Display Setting
Select a display setting to overwrite.

o Define as Default for Objects of This Type
Defines whether this display setting is applied to new objects of this type and to existing
objects whose display settings have not been changed. The display setting actually used
is also determined by the evaluation hierarchy.

Evaluation hierarchy for default display settings

The display settings defined as default are determined based on the following evaluation
hierarchy:

1. Default View for “<object>" for All Users

2. Personal Presettings
Personal display settings are available only to yourself.
Note: All saved personal display settings can be found under “account menu (your user
name)” > “Advanced Settings” > “Presettings”.

Fabasoft Cloud 38



3. Room
Display settings can be saved in the current Teamroom or shelf.

4, Configuration
If the room is based on a configuration, the display settings can be saved in the
configuration.

5. Presetting Collection
Display settings can also be saved in a collection for templates and presettings to which you
have access.

Change

Allows you to define and position the displayed columns via a selection dialog. Alternatively,
columns can also be added, removed and moved using the header bar.

Copy
Copies the current display setting to the clipboard.

Paste

Applies the display setting in the clipboard to the current list.

4.4 Sorting, Grouping and Filtering Objects in a List

The sorting of objects in a list can be easily adapted. You can sort objects depending on various
criteria in an ascending or descending order. It is also possible to sort objects depending on
several criteria at the same time.

You can define the sorting by clicking the “Sort” button in the upper right corner. Alternatively,
you can use the context menu of the content area.

In the detail view, you can also sort the entries via the column header. The detail view provides
additionally the possibility to group a column, to fix a column or to filter the entries depending
on a search criterion. For object, date and enumeration properties, a values filter is available in
addition to the text filter. When using the text filter, all rows containing the entered string are
displayed (case-insensitive). When using the values filter, all rows that correspond to the
selected values are displayed.

Note:

¢ In search-based lists and in the search portal, you can also sort by specific, correspondingly
indexed properties. The sortable properties can be found in the menu of the “Sort” button
in the upper right corner (e.g. Name or Created on/at). In the column header, the “Sort”
context menu command is only available for sortable columns. Clicking on the column
header also only changes the sorting for sortable columns, otherwise nothing happens.

e To display scrollbars for fixed columns under Apple macOS, the option “System Settings” >
“Appearance” > “Show scrollbars” > “Always” must be selected. Scrolling with the “Left” and
“Right” arrow keys works independently of the system setting.

e Keyboard operation: The shortcut a1t + r9 takes you to the column header if the details
are displayed, otherwise to the “Sort” button.

e The values filter is only offered if no element of the property path is defined as "multiple".

e The values filter for date values now has a tree structure and is therefore easier to use with
keyboard and screen reader. The tree elements can be expanded or collapsed using the
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keyboard or by clicking on the corresponding symbol. Expanding and collapsing does not
change the filter behavior and only serves to make operation easier. If subordinate tree
elements have only been partially selected (for example, only one day of several in a
month), then the superordinate tree elements have the status "partially selected". Clicking
on a partially selected element selects all subordinate elements.

e Objects in unsorted lists can be moved not only by drag-and-drop but also with the context
menu commands “Move" > “Prepare for Moving” and "Move" > "Move Before" or "Move
After". Thus, the move functionality can also be used via keyboard operation.

4.5 Modify Column Settings

The columns of the detail view can be adjusted depending on your needs.

To add a column, proceed as follows:

1. Select the object in the list that provides the property you want to add.
2. Open the context menu of a column in the column header.

3. Click “Add Column”.

4. Select the desired property.

Note:

e Which properties are available as columns depends on the type of the object that is
selected in the list.

e For columns that contain objects, properties of these objects can be displayed via the “Next
Level” context menu command.

e For compound properties, the properties of the compound property can be displayed via
the “Details” context menu command.

e To move a column to the right or left, use the “Move to” context menu command. You can
also move columns with drag and drop.

e To optimize the width of the column according to the length of the content, double-click in
the column header between two columns.

e To remove a column, use the “Remove” context menu command.

e Keyboard operation: The shortcut a1t + F9 takes you to the column header.

4.6 Column Editing in the Details View

If you mark a cell and press the F2 key, you can directly edit the content of the cell.

For efficient editing of several objects at the same time possibilities similar to a spreadsheet
program are provided in the detail view.

Editing possibilities:
e copy(ctrl +cq)
o cut(ctrl +x)

e paste(Ctrl +vV)
e delete (pel key)

Several even not adjacent cells within a column can be copied and pasted at the same time. If
the number of selected cells when pasting is greater than the number of selected cells when
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copying, then it is started over with the first value. If fewer cells are selected when pasting, only
values in the selected cells are changed.

Note: Under Linux, no empty object pointers are copied.

The values can also be copied from the Fabasoft Cloud and pasted e.g. in Microsoft Excel.
Pasting values from third-party products in the Fabasoft Cloud is only conditionally possible
(depending on the clipboard format of the third-party product).

Table Handling

The alternatively available table editing can be activated by pressing the “Table Handling”
button (a1t + r2)in the column header. This makes the operation similar to a spreadsheet
program:

e The cells are displayed with border lines.

e The hover highlighting is displayed per cell.

e Cells that cannot be edited are displayed with a gray background.

o Editing a cell is activated with r2, a double-click (fast and slow) or typing letters/numbers.

e Aclick on the object name does not open the object.

Calculations Within Object Lists

For numerical and currency values displayed in a column, the number (of entries with a value),
the total and the average can be calculated. The “Calculate” command is available in the context
menu of the column header for the corresponding column. The result is displayed at the
bottom of the page.

If the list is grouped, the calculations are performed per group and displayed at the end of the
group entries. For filtered object lists, only the entries displayed are used for the calculation.

If a value is changed, for example, with the r2 key a recalculation only takes place after the list
has been updated. The values of the old calculation are grayed out.

4.7 Copy Data Table

If you enable the menu bar, you can use the “Clipboard” > “Data Table” > “Copy” menu
command to copy the list in the clipboard and paste it for example in Microsoft Excel. If some
lines are selected, only those lines will be copied to the clipboard. The order in which the lines
were selected is taken into account.

Note: If you choose "Copy Extended", additionally to the visible columns also entries of shown
object lists and all values of aggregates and aggregate lists are copied as nested table.

4.8 Infobox

The infobox is displayed after about one second, if your mouse is placed over the check box or
symbol of a selected object and not moved. This way you get the most important information
without the need to open the object.

Note: You can disable the infobox in the “Base Settings” with the Show Hints option.
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4.9 Lists in the Property Editor

To reduce the complexity of the property editor and improve the overview, a simplified view is
available for object and aggregate lists. The “Show details” button takes you to a full view of the
list optimized for editing.

Simplified List
The reduced editing options in the simplified list provide an improved overview.

e No menu bar is displayed.

e The number of entries displayed depends on the context. In general, a maximum of 15
entries are displayed. The “Further Entries” button takes you to the full view.

e Sorting and grouping cannot be carried out in the simplified list. These are taken over by
the settings in the full view.

e Only as many columns as space is available are displayed. Thus, horizontal scroll bars can
be avoided.

e Thumbnails are not displayed in the detail view.

e Actions on the entries can be carried out via the context menu.

e Actions concerning the list can be offered via buttons above the list.
e Direct editing with F2 is possible depending on the list.

¢ If there are more entries that can be displayed on a page, the column headings are fixed.

Full List

The full list is used in particular for editing and can be accessed via the “Show Details” button of
the simplified list. If the list is the only field on a tab, the full list can also be displayed directly.

¢ The full view makes optimum use of the window width.
e The full list offers the complete list functionality as usual.

o If there are more entries that can be displayed on a page, the column headings are fixed.

5 Search

The Fabasoft Cloud offers a powerful search and research capability.

5.1 Search With Mindbreeze

You can perform a full text search using the search field in the top bar (a1t + 4)orviathe
search portal (“Search” widget on Home).

To perform a search, proceed as follows:

1. Enter the desired search term in the search field and press “Enter”.
Note: The search is not case-sensitive. If you start directly in the search portal, you can, if
necessary, narrow down the search criteria even before you perform the search. The
following search criteria are offered as standard, which can be extended depending on the
object types found:
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o Where
The objects found must belong to the specified context (e.g. objects assigned to your
organization).

o Date
The objects found must have the specified change date.

o Type
The objects found must be of the specified type (e.g. text document).

o Contained in Teamroom
The objects found must be assigned to the specified Teamroom.

2. The search result is displayed in the search portal. Only results on which you have search
rights are displayed. You can use the search criteria to further restrict the search (e.g. to
Teamrooms or types).

Note:

e In the search result, next to the search field, you can select the type of conjunction of the
search terms: AND (all terms), OR (one of the terms), NEAR (all terms close to each other).

¢ Inthe result list, you can sort by specific, correspondingly indexed properties. The sortable
properties can be found in the menu of the “Sort” button in the upper right corner (e.g.
Name or Created on/at). In the column header, the “Sort” context menu command is only
available for sortable columns. Clicking on the column header also only changes the sorting
for sortable columns, otherwise nothing happens.

e The “Save Search Query” action allows you to save the search term and the currently
selected search criteria under a freely selectable name.

e The "Saved Queries” > “<name>" action allows you to execute a saved search query. The last
five search queries or the last five favorite search queries are displayed.

e The “Saved Queries" > “Further Search Queries” action allows you to view a list of all search
queries. By clicking on a search query, it will be executed. In addition, you can rename,
delete and mark search queries as favorite via the context menu.

e The “Save Search Result” action can be used to persist the search result in a "saved search
result". You can select whether you want to remove entries that are already contained.
Thus, you can easily perform a research even if there are many hits. To display the saved
search result, you can click the “Search” widget on “Home" and switching to the “Saved
Search Results” tab.

The Mindbreeze query language offers the following possibilities. The listed options can also be
combined.

Option Example

Search for a term Objects that contain a text with the term “Contract”
term contract

Not included Objects that contain no text with the term “Contract”
NOT term NOT contract

Search for a whole word or an exact | Objects that contain a text with the phrase “Contract
phrase with Fabasoft”
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"wordl"

"wordl word2 word3"

"contract with fabasoft"

AND operator

terml term2 term3

or

terml AND term2 AND term3

Objects that contain a text with the terms “Fabasoft”
and “Contract”

fabasoft contract

OR operator

terml OR term2 OR term3

Objects that contain a text with the term “Fabasoft” or
“Contract”

fabasoft OR contract

Precedence of logical operators by
brackets

(terml OPERATOR term?)
term3

OPERATOR

Objects that contain a text with the term “Fabasoft” or
“Mindbreeze” and the term “Contract”

fabasoft OR mindbreeze) AND contract

Term near to another term

terml NEAR term2

Objects that contain a text with the term “Fabasoft”
near the term “Contract”

fabasoft NEAR contract

Ranking in the search result
(importance of terms)

terml “"number term2

In the search result ranking, the occurrence of the
term “Contract” is rated twice as highly as “Fabasoft”

contract”2.0 fabasoft

Search for defined fields

metadata:term

The following metadata is generally
available:

Object

e title (Name)

e objsubject (Subject)

e objcreatedby (Created by)

® objchangedby (Last Changed by)
e objterms (Terms)

® objteamroom (Teamroom)

e objprimaryrelated (Origin)

e objfile (File)

e objappconfigurationroom (ApPp
Configuration)

e objroomapp (APP)
e organization (Organization)

Content

Objects that contain the term “Contract” in the subject
objsubject:contract

Content objects with “DOCX" or “MSG" extension that
contain the term “faba”

faba (extension:docx OR extension:msqg)

Content objects with size between 5 KB and 10 MB
mes:size: [5KB TO 10MB]

Content objects with a 2020 change date
mes:date: [2020-01-01 TO 2020-12-31]

E-mail objects sent from “Jones”

from:jones
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e content (Content)

e cxtension (File Extension)

e nes:size (File Size)

e mes:date (Change Date)
E-Mail

e subject (Subject)

e from(From)

e to(To)

5.2 Metadata Search

You can perform a full text search using the search field in the header bar. However, in many
lists and fields you can also search for objects based on specific metadata (“Search” button or
“Add Entry” > “Search").

In the search dialog you can select either an object class, a category of a user-defined form or
an object aspect in the Selection field. When selecting a category or an object aspect, the
Detailed Selection field is displayed, which allows you to additionally select an object class. The
object classes for which the category or object aspect is intended are offered for selection.

You can additionally restrict the search to objects of the current Teamroom or organization.

5.2.1 Defining Search Criteria Using Options

You can define the required values for properties as search criteria. You can specify the type of
value comparison (e.g. “begins with”) using the search option of the respective property.

Short description of all options
Different options are available depending on the property type.

° llequalll
This option is used to find all objects whose value of this property is equal to the defined
value.

|n

e “notequa
This option is used to find all objects whose value of this property is not equal to the
defined value.

e “any value”
This option is used to find all objects whose value of this property is not empty. If this
option is selected, no input is required in the input field. It is therefore displayed inactive.

e “novalue”
This option is used to find all objects whose value of this property is empty. If this option is
selected, no input is required in the input field. It is therefore displayed inactive.

e “begins with”
This option is used to find all objects whose value of this property begins with the defined
string.

e “does not begin with”
This option is used to find all objects whose value of this property does not begin with the
defined string.
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“ends with”

This option is used to find all objects whose value of this property ends with the defined
string.

“does not end with”

This option is used to find all objects whose value of this property does not end with the
defined string.

“contains”

This option is used to find all objects whose value of this property contains the defined
string.

“does not contain”

This option is used to find all objects whose value of this property does not contain the
defined string.

“Full Text” Query
If this option is selected, a full text search in string properties is performed (corresponding
system configuration required). Operators like “AND” and “OR" are supported.

“sounds like"

If this option is selected, a phonetic search is performed. Objects will be found whose value
of this property sounds like the defined string.

Example: A search for “sounds like Meier” will return e.g. “Meyer”, “Meier”, “Maier” and
“Mayr”.

“does not sound like”

If this option is selected, a phonetic search is performed. Objects will be found whose value
of this property does not sound like the defined string.

Example: A search for “does not sound like Meier” will return all objects except e.g. “Meyer”,
“Meier”, “Maier” and “Mayr".

“from”

This option is used to find all objects whose value of this property is equal or greater than
the defined value.

“up to”

This option is used to find all objects whose value of this property is equal or lower than the
defined value.

“between”
This option is used to find all objects whose value of this property is between the defined
values.

5.2.2 Defining Search Criteria Using Wildcards

In the search query, wildcards act as placeholders for any characters or strings.

Example: A search using the string “_andy” in the Name field will return all objects with a name
containing any character followed by the string “andy”.

Wildcards

“*or “%"

These wildcards are placeholders for any string.

Examples:

A search for “*ergy” will return results containing any string followed by the “ergy” string:

“energy”, “synergy”, “allergy”.
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A search for “berg*” will return results containing “berg” followed by any string: “bergamot”,
“bergenia”.

A search for “bl*d” will return results containing “bl” followed by any string and ending with
the character “d": “blood”, “bleed”, “blond".

u

ll?" or -

These wildcards are placeholders for exactly one character. You can either use “?" or
Example: A search for “_andy” will return results containing one arbitrary character
followed by the string “andy”: “Dandy”, “Candy”, “Sandy"”.

un

u_n

The wildcard tilde “~" will run a phonetic search. All objects will be determined that are
pronounced similarly to the defined string. A tilde always has to be entered at the
beginning of the search string.

Example: A search for “~Maier” will return results sounding like “Maier”: e.g. “Meier”, “Mayr”,
“Maier”.

“%%" or “**"

To perform a full text search in string properties, the wildcards “%%" and “**" can be used.
Example: A search for “%%energy” in the NMame field will return all objects with a name
containing the word “energy”.

Most options available via wildcards can also be defined via options in from the. For the “?" and

nmon

wildcards, no equivalent options are available in lists.

Comparison: options and wildcards

“begins with” agreement' corresponds to 'agreement*"

"ends with” agreement' corresponds to '*agreement’

“

contains” agreement' corresponds to '*agreement*"

sounds like” agreement' corresponds to '~agreement'

"“Full Text” Query' agreement" corresponds to '%%agreement’

5.3 Quick Search

This simplified search only searches for a character string without specifying an object type or
further search criteria. If returned entries are not unique, the properties of the objects found
can be viewed via the context menu.

Object Lists

To add an object to an object list in the property editor, a quick search can be performed in the
search field.

Note: The “Search and Add" button is only displayed in object lists in which objects may be
inserted.

To perform a quick search in the search field, proceed as follows:

1.
2.

Click the “Search and Add” button.
Select the desired search mode by clicking on the Cloud/Mindbreeze symbol.

o When using the Cloud search, only the names of objects are searched for.
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o When using the Mindbreeze search, a full text search is performed. In a full text search,
the entered character string is searched in all contents and properties of the object, not
only in the object name.

3. Enter the string you want to search for. In a quick search, the character string entered is
interpreted as the beginning of the name by default. You can also use wildcards (for
example, *).

4, Press the eEnter key to perform the quick search.

All objects whose names correspond to the defined character string are displayed as the
result. Select the desired entry from this list of results by clicking it.

6. The entry is taken over to the object list in which you started the quick search.

Object Properties

A quick search can be performed directly in object properties. The “Search” button next to a
drop-down list indicates that you can perform a quick search.

To perform a quick search in object properties, proceed as follows:

1. Click in the field and press the 1ns key. Alternatively, double-click in the field. In this case,
the system only searches in the name of the objects.
To perform a full text search, press ctrl + Ins or press ctrl and double-click in the field.
In a full text search, the entered character string is searched in all contents and properties
of the object, not only in the object name. This way the field becomes editable.
Note: To cancel a quick search, press the Esc key.

2. Enter the string you want to search for. In a quick search, the character string entered is
interpreted as the beginning of the name by default. You can also use wildcards (for
example, *).

Press the Enter button to perform the quick search.

All objects whose names correspond to the defined character string are displayed as the
result.
Select the desired entry from this list of results by clicking it.

5. The entry is copied to the object property in which you started the quick search.

If you could not find the desired object using the quick search, you can still open the search
dialog using the “Search” button, to perform a search using further search criteria.

5.4 Search Folders

In search folders, the objects contained are determined using a search pattern.

1. Create a search folder in a Teamroom.
2. Define the search criteria via the “Create Search Form” or “Edit Search Form” action.
3. Click the “Save Query” button to use the search form for the search folder.
Hint:
e The contents of the search folder are not updated automatically. Click the “Refresh” button
to perform another search using the saved search pattern.

¢ With the “Find” action, you can perform a search independent of the saved search form.
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¢ When duplicating a search folder, the associated search form is also duplicated if the
search form is assigned to the same Teamroom. If the search form is assigned to a
template collection, it is not duplicated.

5.5 Insight Apps

Insight apps provide aggregated access to information in your cloud organization, customized
to your needs. You can use insight apps to display and highlight important information without
users having to explicitly search for it.

Insight App Management
Insight apps can be managed at the following levels by authorized users:

o collection for templates and presettings
e app configuration (“Insight Apps” widget)
e app rooms and Teamrooms (“Insight Apps” widget in “Templates and Presettings”).

The permissions assignment and releasing for usage mechanism follow the usual pattern.

Note: The “Edit Insight Apps an Al Settings” organizational policy defines which users are
generally allowed to edit insight apps.

Settings
You can define the following basic settings for insight apps. For a description of solution-
specific settings, see the corresponding solution documentation.

“Insight App" tab

o Multilingual Name
The name of the insight app.

e Description
The behavior of the insight app can be described as free text.

o Where
Defines the context (organization, Teamroom, everywhere) in which the search is
performed.

o Use Al Configuration
Defines whether the general organization index for the standard search or a special Al
configuration index from Mindbreeze Al should be used.

o A/l Configuration
Defines the Al configuration used for the search. The following evaluation hierarchy applies:

o defined insight app mapping (Teamroom/app room > app configuration > organization)
o defined Al configuration of the insight app
o default Al configuration at organization level

general organization index for the standard search

O

“Usage” tab

e Show as Action
Defines whether a separate action should be displayed that allows the insight app to be
opened.
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Symbo/
Defines the symbol that is displayed for the action.

Action Name

Defines the multilingual name of the action.

Possible placeholders:

<~objname~>: Name of the current object

<~roomname~>; Name of the Teamroom the current object is assigned to

If the respective user language is not explicitly defined, the following fallback mechanism
applies: language variant (e.g. German (Switzerland)) > language (e.g. German) > English >
insight app name.

Show as Split View

Defines whether a two-part view should be used for display when the insight app is opened
via the action (the insight app on the left and the PDF overview of the current object on the
right).

Current Document

The action is only displayed for objects that have one of the specified object classes and
one of the specified categories.

Contained in
The action is only displayed for objects that are in an object with one of the specified object
classes and one of the specified categories.

Files
The action is only displayed for objects that are in a file with one of the specified object
classes and one of the specified categories.

Expression for Further Restrictions of Usability
The action is only displayed if the expression returns true.

Insight App Designer from Mindbreeze Al

Use the designer to create the insight app you want. Assemble your insight app by clicking on
the elements in the left pane or dragging and dropping them into the drawing area. If
necessary, you can specify additional settings in the left pane. To change elements afterwards,
move the mouse pointer over the element and use the “Move”, “Delete”, and “Edit” buttons.

More information can be found here: https://help.mindbreeze.com/en/doc/Development-of-
Insight-Apps/index.htm#insight-app-designer

Using Insight Apps

Insight apps can be accessed by authorized users as follows:

In the search portal, the “Insight Apps” tab shows all released insight apps from app
configurations, app rooms, Teamrooms and insight app collections to which you have been
granted permission.

Insight apps can be placed directly on “Home" or added to “Favorites”.
In the context of apps, insight apps are available in the "Insight Apps" widget.
In the context of Teamrooms, the insight apps are available on a corresponding tab.

For Insight apps, you can define on the “Usage” tab whether they are offered for execution
as an action or context menu command directly for the defined objects.
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6 Workflow

Users, organizations, organizational units and external organizations can be involved in the
processing of business objects via a workflow.

Typical processes are approval and release processes.

6.1 Executing an Ad Hoc Process

An ad hoc process allows you to define the process flow by yourself. Consequently, you can
react flexibly to situations for which no predefined processes are available.

To execute an ad hoc on an object, proceed as follows:

1.
2.

Navigate to the desired object.

Make sure that all process participants have the necessary access rights on the object. If
necessary, authorize the users in the respective Teamroom.

On the context menu of the object click “Tools” > “Start New Process”.

Select a template for an ad hoc process or start with an empty template. The step is
omitted if there are no predefined processes.

Note: In an empty template, you can also use an existing ad hoc process template by
clicking the “Insert Template” button.

If you start with an empty template, define an activity and a participant for the first task in
the process. Further information about the possible settings can be found in the next
chapter.

Click “Next”, if you do not want to add further activities.

Otherwise, click “Take". You can add further activities by selecting an activity and
participants and clicking “Take” again. The last activity with a defined participant is
considered even if you do not click “Take".

Note: If you need the ad hoc process regularly, you can save it as template. You can specify
the storage location. All saved personal ad hoc process templates can be found under
“account menu (your user name)” > “Advanced Settings” > “Workflow" > “Personal Settings”
tab > Ad Hoc Process Templates.

The first activity is placed in the work list of the defined participant.

Note:

¢ Inan ad hoc process (possibly parallel), activities with different participants can be defined.

Further sequence flows can only be used in predefined processes.

For ad hoc process templates, the applicability can be defined in the same way as for BPMN
processes (Applicable for, Object Class/Category of the File, Object Class/Category of the
Teamroom).

Deadlines can be defined for activities, depending on your settings (“account menu (your
user name)” > “Advanced Settings” > “Workflow” > “Personal Settings” tab).

o Deadlines as dates can be entered directly in the overview.
o Initially invisible time spans can be defined using the “Advanced Settings” button.

o You can either define a time span starting from the current time or using a base date. If
the base date changes, the deadline is recalculated.

Fabasoft Cloud 51



o app.ducx expressions for calculating the deadlines can be defined using the “Advanced
Settings” button. The expressions are re-evaluated when the activity would become
startable and no value already exists.

Note: If an activity is suspended or delegated, expressions can only be defined if the user
has the “Edit BPMN Process Diagrams"” policy.

Example:
datetime visibledate = coonow + 86400;
if (coonow.year == 2023) {

visibledate = coonow + 172800;
}

visibledate;

6.2 Activities and Participants

Activities

By default, following activities are provided (apps can provide additional activities):

Edit
Allows editing a document.

Forward for Editing (only available in BPMN processes)
Allows editing a document.

Close

Allows closing a document, such that no further changes are possible.

Note: The corresponding context menu command is “Tools"” > “Close”. If the object should
be editable again, you can execute the “Tools” > “Revert Status ‘Closed” context menu
command.

Close Documents
Allows closing documents within a folder, such that no further changes are possible.

Close File
Allows closing a file, such that no further changes are possible on the file and assigned
objects.

Release
Allows releasing a document. The document will be signed with a corresponding signature.
If the document is released, additionally a release version is created for the document.

Release and Close
Allows releasing and closing a document. The document will be signed with a
corresponding signature and closed, such that no further changes are possible.

Release Documents

Allows releasing documents within a folder. The documents will be signed with a
corresponding signature. If the documents are released, additionally a release version is
created for the documents.

Release and Close Documents

Allows releasing and closing documents within a folder. The documents will be signed with
a corresponding signature and closed. If the documents are released, additionally a release
version is created for the documents.

Approve
Allows approving a document. The document will be signed with a corresponding signature.
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e Approve and Close
Allows approving and closing a document. The document will be signed with a
corresponding signature and closed, such that no further changes are possible.

e Approve and Close Documents

Allows approving and closing documents within a folder. The documents will be signed with
a corresponding signature and closed.

e Forward for Approval (only available in BPMN processes)
Allows a document to be forwarded for approval.
o Review
Allows reviewing a document.
e Forward for Review (only available in BPMN processes)
Allows a document to be forwarded for review.
e Take Note
Allows taking note of a document. The document will be signed with a corresponding
signature.
o Add Remark
Allows adding a remark to a document.
e Add Comment
Allows adding a comment to a document (see also chapter 3.3.9 “Commenting
Documents”).
e Sign Digitally
Allows creating a PDF document with a digital signature and saving it as final form with the
document. In addition, a corresponding signature is applied to the document and the
document is closed if it is not already closed.
e Prepare Signature Folder
Allows collecting, visually signing and digitally signing several documents of a file.
e Send
Allows sending an object as a link or public link.
e Send Link
Allows sending an object as a link.
e Send Public Link
Allows sending an object as a public link.
e Release for Usage (only available in BPMN processes)

Allows a template, form, etc. to be released for usage. In addition, a corresponding
signature is applied.

Note:

o Activities can also be defined parallel. If a predecessor exists, this can be done via a parallel
gateway or otherwise the first activities can be inserted loosely without a connection by an
edge (duplicating the first activity with ctrl + cand ctrl + V).

e Multi-instance activities can be used for processing an activity sequentially or in parallel by
several participants.

o If the activities “Review"”, “Approve” or “Release” are used in ad hoc processes, the following
applies:

Fabasoft Cloud 53



o Negative results (e.g. “Approval denied”) are reported via an automatically inserted
activity to the person who started the ad hoc process. The remaining commonly
prescribed activities that have not yet been completed are set to “Not Executed”.

o Activities for positive results (e.g. “Released”) are only automatically inserted if they are
the last activity in the process.

¢ If the activities “Review"”, “Approve” or “Release” are inserted in running processes, negative
results are reported to the person who inserted the activities. The remaining commonly
inserted activities that have not yet been completed are set to “Not Executed”.

e For objects that are in the worklist, the work steps are also available in the object actions.
Conversely, the standard actions of the concerned object are also available in the actions of
the activity.

e For activities, the associated work steps are displayed in the properties and in the info box.
For each work step, the following additional information is displayed if it applies:

o Multiple

o Must Be Executed

o Completes Activity

o Conditionally Visible

o With Precondition

o Executed by (for activity instances)

o Started or Completed (for activity instances; process administrators additionally see the
time)

Participants
By default, following participants can be defined:

o Abstract Participant
Abstract participants allow generic sequence flows.

o Process Initiator
The participant who starts the process.

o Current User
The participant who has executed the previous activity or for the first activity, the
participant who has started the process.

o Property of the Object
The participants are evaluated based on a property of the object (e.g. Last Signature by).

o Role by Property of the Object
If an organizational structure is defined in your organization, you can use it in the
workflow to determine the process participants. Thus, for example, workflows for
material requisitions or leave requests can be easily implemented.

= Property
Select a property that contains a user or organizational unit.
Ifitis a user, the primary position of the user is determined and thus the assigned
organizational unit.
If it is an organizational unit, this organizational unit is used.
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= Position
Select the position type (staff member or head) that must be assigned to the primary
position of the process participant to be determined.

» Organizational Unit Type
Optionally, select a level that must be assigned to the organizational unit of the
process participant to be determined. If the organizational unit determined by the
property does not have the required level, the organizational unit with the necessary
level is determined via the organizational unit hierarchy.

o Property of the File of the Object
The participants are evaluated based on a property of the object's file (e.g. Last Signature
by).

o Role by Property of the File of the Object
If an organizational structure is defined in your organization, you can use it in the
workflow to determine the process participants. Works as the “Role by Property of the
Object” abstract participant except that a property of the object's file is used for the
evaluation.

o Property of the Teamroom of the Object
The participant is evaluated based on a property of the object's Teamroom.

o Role by Property of the Teamroom of the Object
If an organizational structure is defined in your organization, you can use it in the
workflow to determine the process participants. Works as the “Role by Property of the
Object” abstract participant except that a property of the object's Teamroom is used for
the evaluation.

o User
A concrete participant.

o Organizational Unit
A whole organization, organizational unit or external organization.

o Distribution List
A list of participants (only usable for multi-instance activities).
Note:

e Users not yet registered can already be selected as process participants. The users will also
receive workflow notification e-mails with a link that allows them to register.

e Distribution lists can only be used together with multi-instances.

e An organizational unit or property of the object can be used both in multi-instances and in
non-multi-instances.

¢ Inthe case of multi-instances, a separate activity instance is created for each resolved
process participant, in the case of non-multi-instances only one activity instance for the
entire organizational unit or property of the object is created.

e Distribution lists are immediately resolved at the start of the process. When a Property of
the Object or Organizational Unitis used, the process participants are resolved during the
runtime of the workflow (when the state of the corresponding activity is set to “Can Be
Started”)

6.3 Executing a Predefined Process

Recurring processes can be efficiently represented with predefined processes.
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To execute a predefined process on an object, proceed as follows:

1. Navigate to the desired object.

2. Make sure that all process participants have the necessary access rights on the object. If
necessary, authorize the users in the respective Teamroom.

In the context menu of the object click “Tools” > “Start New Process”.

Click “Start Process” to directly start the desired process or click “Open Process” to view the
process beforehand.

The first activity is placed in the work list of the defined participant.

6.4 Handling Processes Together

When processes are started together, the same activities that a user needs to execute are
shown grouped together in the worklist. The number of identical activities currently in the
worklist is displayed in parentheses after the name of the grouped activity. Executing a work
step (for example, "Approve") affects all current activities in a grouped activity.

Note: For example, you can start processes together by selecting multiple objects, executing
the “Tools” > “Start New Process” context menu command and clicking the “Process Together”
button in the following dialog.

Summary Dashboard

Clicking on a grouped activity takes you to the overview dashboard. Which processes are
displayed depends on your access rights.

e Overview of Related Processes
Shows the processes in progress and the completed processes.

e My Activities of Processes in Progress
Shows the activities of the current user (planned, in progress, completed) of the processes
in progress.

e My Activities in Progress
Shows the activities in progress of the current user of the related processes. Thus, you can
also process the activities of the grouped activity individually.

o All Activities in Progress
Shows all activities in progress of all process participants of the related processes.

Via the “Show Process Overview" action, you can display all related processes among each
other as individual process diagrams.

6.5 Work List

The work list allows processing the respective activities. By default, the work list can be
accessed via “Home".

The work list consists of following lists (only visible if at least one entry is present):

e 70Do
Contains the current activities that have to be processed.

e Suspended
Contains activities that are suspended for a defined time span.
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o last Finished
Contains completed activities.

e (Concerned Objects
Contains objects of the current activities.

o Tracking
Contains objects of already completed activities.

6.5.1 Executing a Work Item of an Activity

An activity can consist of one or several work steps. Work steps can behave differently:

e One or more work steps of the activity can be defined such that they complete the activity.
The process flow continues after executing the work step.

e A mandatory work step (bold) has to be executed before an activity can be completed. If
only mandatory work steps are still available that also complete the activity, only one of
these work steps must be executed.

e Arepeatable work step can be executed repeatedly.
To execute a work step, proceed as follows:
1. Navigate in the work list in the “To Do”" list.

Localize the desired activity.

Click the desired work step. Depending on the work step, the corresponding action is
carried out (e.g. “Open” opens a document in the corresponding third-party product).

In addition to the name of the work step, the status is indicated in parentheses, if applicable:

e Work step has not yet been executed: no status text

e Work step has already been executed: (repeat)

e Work step could only be carried out once: (executed)

e Mandatory work step that does not complete the activity has not yet been executed: (to do)
e Work step is not yet executable: (not executable)

e Mandatory work step that cannot yet be executed: (to do, not executable)

Note: For work steps that require a password to be entered, the mobile app offers the option
of using biometric authentication instead of a password. This requires an active code lock in the
mobile app (including biometric unlocking) and permanent login.

6.5.2 Suspending an Activity

An activity can be suspended to move the processing to a later date. The activity will be moved
from the “To Do" list to the “Suspended” list. After the defined time period has elapsed, the
respective activity will be moved again to the “To Do" list.

To suspend an activity, proceed as follows:

1. Navigate in the work list in the desired activity.
2. Click the “Suspend"” action.

3. Define the desired time span and click “Next".
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Note: By clicking the “Activate” action, a suspended activity can be prematurely moved to the
“To Do" list.

6.5.3 Delegating an Activity

A user can delegate an activity to another user who should complete the activity.
To delegate an activity, proceed as follows:

1. Navigate in the work list in the desired activity.
2. Click the “Delegate” action.

3. Select a participant and click “Next".
The activity will be stored in the work list of the selected participant.
Note:

e If an activity is set to ignore completion, no new activities can be inserted if the following
activity has already been prescribed. In this case, the “Delegate Multiple” action is available
to still be able to assign a copy of the current activity to multiple process participants.

o If the Team Members Visible to All Members option is disabled for the Teamroom and you
do not have “Full Access” in the Teamroom, the “Delegate” action is not available.

6.5.4 Adding an Activity

The context menu command “Add New Activity” of an activity can be used add ad hoc activities
to the process. When adding new activities the current activity is completed. If mandatory work
steps of the current activity are still open, you will get the current activity again in your work list
as soon as the added activities are completed.

6.5.5 Viewing Processes of an Object

To view the processes of an object, proceed as follows:

1. Navigate in the desired object.
2. C(lick the “Properties” action.

3. Click the “Processes” tab.
4

Click “Open Process"” to display the complete process with any loops and conditions. The
process flow that has already been executed is indicated by bold lines. Paths that were not
traversed are visualized with dashed lines.

5. You can use the context menu of the process elements to execute the commands allowed
in each case. For example, if you have the appropriate rights, you can change the
participant of an activity that has not yet been executed using the “Edit” context menu
command.

6. To make it easier to terminate processes that are no longer relevant, the “Change State”
button is available. This allows you to change the state to “In Progress”, “Suspended”,
“Completed” or “Aborted”.

7. Astarted process can be deleted via the "Delete" button as long as no activity has been
started.

Note:
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e The “Processes” tab is only visible if at least one process is present.
e Completed processes are collapsed by default.
¢ When you collapse or expand processes, the state is saved.

6.5.6 Viewing Activities of an Object

To view the activities of an object, proceed as follows:

1. Navigate in the desired object.
2. Click the “Properties” action.
3. Click the “Activities” tab.

All current, planned and completed activities are shown.

Note: The “Activities” tab and the fields for current, planned and completed activities are only
visible if at least one activity is present.

6.5.7 Process Statistics

To obtain an overview of the running processes, several process statistics are available that
illuminate the individual aspects of process execution.

In the organization policies, on the “Processes” tab, you can define process administrators. The
statistics can be displayed for:

e Process Administrators
Provides an overview of all predefined and ad hoc processes of the organization.

e Process Owners
Provides an overview of all predefined processes for which the user is defined as the
process owner.

Note: The process owner can be defined on the “BPMN Process Diagram” tab of a BPMN
process diagram.

You access the process statistics via your worklist. The statistics are available for the following
three levels: general overview, process definition and specific process.

General Overview

e Process Statistics
Provides an overview of the number of running processes and delayed processes.

e Process Throughput
Shows the number of started and completed processes and their difference in the selected
time period.

e Running Processes
Shows the number of running processes and their changes in the selected time period.

e Running Processes per Process Definition
Shows the percentage breakdown of the process definitions of the running processes.

e Current Activities
Shows the percentage breakdown of the current activities of the running processes.

e Delayed Activities
Shows the percentage breakdown of the delayed activities of the running processes.
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e Planned Activities
Shows the percentage breakdown of the planned activities of the running processes.

¢ Activities With Participants Without Access Rights
Shows the activities in which the participant does not have access to the affected object.

e Start Date of Running Processes
Shows the number of running processes grouped by the start date in the selected time

period.

e Due Date of Activities
Shows the activities of the running processes that need to be processed in the next two

weeks.
o Cadence Jones Locations Support Logout
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Process Throughput
Shows the number of started and completed processes and their difference in the selected

time period.

Running Processes
Shows the number of running processes and their changes in the selected time period.

Current Activities
Shows the percentage breakdown of the current activities of the running processes.

Delayed Activities
Shows the percentage breakdown of the delayed activities of the running processes.

Planned Activities
Shows the percentage breakdown of the planned activities of the running processes.

Activities With Participants Without Access Rights
Shows the activities in which the participant does not have access to the affected object.
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e Start Date of Running Processes
Shows the number of running processes grouped by the start date in the selected time

period.

e Due Date of Activities
Shows the activities of the running processes that need to be processed in the next two
weeks.

e Processes
Displays all processes (including completed processes) of the process definition.

o Cadence jones Locations Support Logout
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e Runtime
Shows the runtime of the process in days compared to the average runtime of the
underlying process definition.

e Activities
Shows the percentage breakdown of the status of the process's activities.

e Overview
Shows the most important metadata of the process.

Note: The “Settings” action can be used to define the time period (from last week to last year) of
the time-dependent statistics.

6.5.8 Substitution

You can set up a workflow substitution. The substitutes receive all activities of the user they
substitute within the defined period of time. Objects to which the substitute has no access are
filtered.
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The substitute can be defined in the worklist via the “Define Substitutes”. Alternatively, the
substitution can also be defined via “account menu (your user name)” > “Advanced Settings” >
“Workflow” > “Substitutes” tab.

For substitutes, the activities in the worklist are made available on the “To Do as Substitute” or
“Suspended/Pending as Substitute" tabs.

Note:

The workflow substitution has no influence on the access rights. The substitute must be
authorized on the objects that are processed using the workflow.

Organization administrators can also define or change a substitution in the member
properties on the “Substitutes” tab. In the organization policies, on the “Workflow” tab it can
be defined whether members can define substitutes themselves.

6.6 Settings

In the account menu (your user name), the “Advanced Settings” > “Workflow” entry provides
following settings:

“Personal Settings” tab

Notify Me About the Following Events

You can define for which workflow events you want to be informed by e-mail or push
notification.

Note: To receive push notifications, you must allow them in your web browser or Fabasoft
Cloud App. Push notifications must be additionally allowed in your organization and, if
applicable, in the organization of the affected object in order to be sent.

Use Tabular Mode for Prescriptions
Defines whether the graphical or tabular process editor is used for prescriptions. The
tabular process editor is especially defined for users who rely on keyboard operation.

Define Deadllines as Time Span (Instead of a Date)
Defines whether deadlines are entered as time span instead of a date.

Show Advanced Settings for Deadlines in Ad Hoc Processes
Allows you to change the way you enter deadlines. Additionally, you can specify the type of
escalation.

Show Deadlines for Ad Hoc Processes per Default
Defines whether the deadlines are displayed by default when prescribing.

Show News About New Activities on the Welcome Screen
Defines whether news about new activities in the worklist are shown on the welcome
screen.

Show News About Activities Which Have to Be Done in Substitution on the Welcome Screen
Defines whether news about new activities in the worklist, which have to be carried out as
substitute, are shown on the welcome screen.

Automatically Open the Next Activity After Finishing an Activity
Defines whether when finishing an activity, the next activity will be opened or whether the
“to do” list will be opened.

Ad Hoc Process Templates
Contains your personal templates for ad hoc processes. If a template is no longer needed
you can remove it.
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e Predefined BPMN Processes
Contains your personal BPMN processes that are released for execution.

6.7 Business Processes With BPMN 2.0

The support of BPMN 2.0 (Business Process Model and Notation) allows you to model business
processes and benefit from the advantages of a platform-independent notation. The created
process diagrams can be directly executed with the workflow engine.

Note: You can only create, edit and release BPMN process diagrams if you are authorized in the
Edit BPMN Process Diggrams organizational policy. Explicit authorization is required as
app.ducx expressions can be created in the context of BPMN process diagrams.

6.7.1 Creating a BPMN Process Diagram

BPMN process diagrams are used to model business processes, which can be directly executed.
The BPMN process diagrams can be used in the context in which they are defined or
referenced. To make BPMN process diagrams generally available for Teamrooms (but not for
app rooms), use a collection for templates and presettings in “Customizing”. Otherwise, BPMN
process diagrams can be stored in app configurations (“Processes” widget), in app rooms
(“Templates and Presettings” action > “Process Templates” widget) or in Teamrooms
(“Templates and Presettings” action > “Process Templates” widget).

To create a process diagram, proceed as follows:

Navigate in the “Processes” or “Process Templates” widget in the desired context.
Click the “Create Process” action.

Enter a name and click “Next".

In the context menu of the process diagram, click “Open”.

LA

Model the desired process and click “Next".
More information about working with the BPMN editor can be found in the next chapter.

6. In the context menu of the process diagram, click “Release for Usage".
Note:

¢ In the properties of the BPMN process diagram, on the “Process execution” tab, the
Automatically Suspend the Process When Deleting the Affected Object and Activate It When
Restoring field defines whether the process is automatically suspended when the affected
object is deleted or canceled and again activated when the object is restored.

e To use a BPMN process, on the one hand the users must be authorized in the
corresponding room and on the other hand the BPMN process must be released for usage.

e On the “Process Execution” tab, all released instances are displayed in the Release Version
field and the Formerly Released for Execution field.

¢ Changes can be released using the “Re-Release” context menu command. Processes that
have already been started continue to run according to the old released BPMN process
diagram. New processes are initiated based on the currently released version.

e You can withdraw the release with the “Withdraw Release” context menu command.
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6.7.2 Working With the BPMN Editor

In the graphical BPMN editor, besides the modeling of the process, cloud users and activities
can be assigned to BPMN elements, in order to be able to execute the process directly with the
workflow engine.

The BPMN editor is subdivided in three areas. The left pane contains the BPMN elements that
can be dragged and dropped on the middle design pane. The right pane (folded by default)
shows properties for the element that is currently selected in the design pane. The right pane is
also used to assign cloud users and activities for process execution.

The keyboard shortcuts ctr1 + zandctrl + v can be used to undo and redo actions. ctrl +
s allows saving changes made in the editor. For copying, cutting, pasting and deleting elements
the keyboard shortcuts ctrl + ¢, ctrl + X, Ctrl + vand bel are provided. The executability
of the process can be checked with the “Check Executability” button.

Executable process must or may contain following elements:

e Pool
The pool consists of activities of a delimited unit (e.g. an organization). Exactly one pool per
process diagram can be put into execution. Thus, the /s executable property must be set to
“Yes" for one pool.

o Inthe Applicable forfield, click the “Edit” button to define the following settings.

» The Applicable forproperty is used to restrict processes to object classes and
categories. This way processes are only offered if they are useful for the object, on
which the process should be executed.

If a restriction is defined, the process can only be executed on objects that have been
assigned one of the listed categories and one of the listed object classes and one of
the listed object aspects.

When selecting activities for tasks in the BPMN editor, only activities are provided that
correspond to the applicability of the process diagram. If the process is restricted to a
category of a user-defined form, the defined fields can be used in the condition editor.
If the process is restricted to the category of a user-defined base form, the process
can also be used for forms derived from the base form.

» The Object Class/Category of the File property can be used to define the object class
or category of the object's file. This allows access to the properties of the file when
defining the abstract participants “Property of the File of the Object” and “Role by
Property of the File of the Object”.

» The Object Class/Category of the Teamroom property can be used to define the object
class or category of the object’'s Teamroom. This allows access to the properties of the
Teamroom when defining the abstract participants “Property of the Teamroom of the
Object” and “Role by Property of the Teamroom of the Object”.

» The Expression for Determining the Visibility property defines an app.ducx expression
that determines whether the process is offered for selection when a process is
started.

» The Expression for Determining the Usability property defines an app.ducx expression
that determines whether the process can be started. This allows, for example, to
check preconditions that must be fulfilled before the process can be started.

o Inthe /nitializations field, click the “Edit” button to define the following setting.
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» The Expression for Initializations property defines an app.ducx expression that allows
defining common initializations and global process parameters.

Lane

Lanes represent responsibilities. A participant can be assigned to a lane. When creating
tasks, the values defined for the lane are used as default values for the tasks, which allows
comfortable working.

Note: When creating a pool one lane is implicitly generated.

Start event

The process flow starts with a start event. For documentation purposes, all types of start
events can be used in executable processes. However, the start event type has no effect on
the execution of the process.

Conditional start event (optional)

A wait action can be implemented using an conditional start event. The process is not
started until the condition (app.ducx expression) has been fulfilled. The check interval
determines how often the condition is checked.

Intermediate conditional event (optional)

A wait action can be implemented using an intermediate conditional event. The process is
not continued until the condition (app.ducx expression) has been fulfilled. The check
interval determines how often the condition is checked.

End event
The process flow ends with an end event.

Terminate end event (optional)
Terminates the whole process (incl. subprocesses) and the process is marked as completed.
When used in subprocesses, only the subprocess is terminated (without special marking).

End error event (optional)
Terminates the whole process (incl. subprocesses) and the process is marked as aborted.
When used in subprocesses, only the subprocess is terminated (without special marking).

Task

A task represents an atomic unit of work that has to be done within a process. Currently,
tasks of type “User” are supported. The task must have a Fabasoft Cloud activity and one or
more participant assigned. When carrying out a process the tasks are displayed in the
worklists of the corresponding users.

o If the activity “Execute Expression in Background” is used, an app.ducx expression can be
executed in the background. The process is not continued until the background task has
been executed.

o Deadlines can be defined as date, time span or expression (£nter Deadline as field). The
“Advanced Settings” button takes you to all deadlines.

o The Started Activity Remain in All Worklists field can be used to define whether the
corresponding activity is removed from the worklists of the additional affected
participants when the activity is started.

o The /gnore Completion field can be used to define whether subsequent activities can be
started although this activity has not yet been completed.

o The Skip Invalid Participantfield can be used to define whether the activity is skipped for
an invalid participant (e.g. inactive user, missing license).

o The Display Activity Only if the Participant Has Access to Affected Object field can be used
to define whether the activity is only displayed in the worklist if the participant has at
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least read rights to the affected object of the process.

Note: If the activity is not visible to any participant, the process stops. When starting the
process, no warning is displayed if the activity goes to a team in which at least one user
has rights to the affected object.

The Disable Substitution field can be used to define whether the activity may be
executed by a substitute.

The Escalation field you can overwrite the escalation definition that is stored with the
respective activity definition. The default escalation is defined for all Fabasoft Cloud
activity definitions. If the default escalation is used, a welcome screen entry is shown and
a notification e-mail is sent to the current workflow participant if the start or completion
date is exceeded.

In the Expression When Completing the Activity field an app.ducx expression can be
defined that is executed when completing the activity.
In the app.ducx expressions, you can use object to access the object of the process.

A loop type can be defined for tasks.

= None
From the defined activity, one instance is created, which is offered to the defined
process participants in the worklist. The first process participant, starting the
processing, takes over the activity. The activity will be removed from all other
worklists.

= Standard
Tasks can be run in a loop. The loop condition can be tested before or after the
iteration. The maximum number of iterations can be defined, too.

= Ml Parallel
From the defined activity, one instance is created for each defined process participant
and stored parallel in the respective worklists. All process participants must process
the activity.

»= MI Sequential
From the defined activity, one instance is created for each defined process participant
and stored sequentially in the respective worklists. All process participants must
process the activity one after the other.

If an activity such as "Approve", "Release", "Review", “Sign”, “Close”, “Approve and Close”,
“Release and Close” or “Close File" is denied, activities are not executed if they belong to
the same multi-instance task. The default behavior can be changed by the process
parameter keepactivitiesstarted:

process.SetProcessParameter ("keepactivitiesstarted", true);

The signdialogtitle, signdialogheading and signdialogdescription process
parameters can be used to customize the texts of the sign dialog. For multilingual strings,
a LanguageStringList can be provided.

For example: process.SetProcessParameter ("signdialogtitle", "Sign");

Sequence flow

The sequence flow describes the order of events, tasks and gateways. A condition
expression (Fabasoft app.ducx Expression Language) may be assigned to a sequence flow
outgoing from a gateway. The expression can be entered directly in the text field or can be
defined with the condition editor.

See also: https://help.cloud.fabasoft.com/doc/Reference-Documentation/prop-
fscdiagrameditor-eventpropscondition.htm
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e Gateway (optional)
A gateway allows the distinction between cases or parallelization in a process. Currently
data-based exclusive gateways and parallel gateways are supported. For a converging
parallel gateway, the join type (AND or OR join) can be defined.

e Subprocesses (optional)
Subprocesses are used to enclosure complexity. Subprocesses can be nested and runin a
loop (type “Standard”). The loop condition can be tested before or after the iteration. The
maximum number of iterations can be defined, too.

o Expanded subprocess
An expanded subprocess is embedded in the process as structuring element.

o Collapsed subprocess
A collapsed subprocess references a separate BPMN process diagram that is therefore
reusable. Released changes to subprocesses are taken over when subprocesses are
expanded.

e Artifacts and data objects (optional)
For documentation purposes all artifacts and data objects can be used in executable
processes. However, these elements have no effect on the execution of the process.

Note:

e Go-to sequence flows can currently not be executed.

« Inthe app.ducx expressions global process parameters can be defined, to influence the
process execution.
process.ClearProcessParameters () ;
process.SetProcessParameter ("key", "value");
process.GetProcessParameter ("key") ;
process.GetProcessParameters () ;

e The keeporiginaldiagramversion process parameter can be used to specify whether the
at the start of the process released versions of subprocesses are retained. This way, re-
releasing subprocesses does not affect processes that are already running;:
process.SetProcessParameter ("keeporiginaldiagramversion", true);

® GetNextActivityInstances can be used to determine the following activity in app.ducx
expressions. HasvalidParticipant can be used to check the validity of the participant.

¢ When initially defining a condition, you can decide whether you want to define the
condition using the condition editor (graphical user interface with predefined properties) or
the code editor (app.ducx expression). Subsequent changes will open the corresponding
editor directly. You can switch from the condition editor to the code editor using the “Open
Code Editor” button. In doing so, the condition is taken over, but must be manually
converted into a valid app.ducx expression.

e Condition expressions are evaluated with nocHECK. This avoids evaluation errors that
properties are not assigned to the object class.

¢ Using the “Show Overview of app.ducx Expressions” context menu command, you get an
overview of all app.ducx expressions defined in the process and, if applicable, in the
subprocesses. This facilitates troubleshooting in particular.

Multilingual Names

If you assign or change your own names for process elements in the BPMN editor, these are
saved in the current user language. For users with different language settings, you can store
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the translated names on the “Translations” tab. In this way, the name is displayed in the BPMN
editor and also in the worklist according to the language settings of the respective user.

6.7.3 Downloading and Uploading a BPMN Process Diagram

BPMN process diagrams may be exported and imported. In case of an executable process
diagram, possibly assignments to cloud users and activities have to be adapted, if the objects
are not available in the target system.

When downloading BPMN process diagrams, the following options are available:

e Download Diagram With Preview
Downloads the XML representation and preview images of one or more BPMN process
diagrams including any sub-processes that may be contained.

e Download
Downloads the XML representation of one or more BPMN process diagrams including any
sub-processes that may be contained.

e Upload
The downloaded BPMN process diagrams can be uploaded again (also in another
installation if applicable). Either a single XML file or an entire ZIP file can be uploaded. If a
ZIP file is uploaded, existing diagrams can be updated.

Download
To download a process diagram, proceed as follows:

1. Navigate in the process diagram and click the “Download” or “Download Diagram With
Preview” action.

2. An XML file or ZIP file will be downloaded that contains the process diagram as XML file.
Note: To download several processes at once as a ZIP file, select them and execute the
“Download” or “Download Diagram With Preview” context menu command.

Upload

To upload a process diagram, proceed as follows:

1. Navigate in the process diagram and click the “Upload” action.
2. Click the “Select File" button.

3. Enter the path to the process diagram XML file and click “Next”.
4

Click “Next” and “Close”.

Note: To upload several processes at once as a ZIP file, navigate in a process list and click the
“Upload” action.

6.7.4 Creating Escalation Definitions

When workflow deadlines expire, the affected workflow participant is notified by default via
welcome screen and e-mail. However, you can also define your own escalation definitions and
use them with the respective activity.

The escalation definitions can be used in the context in which they are defined or referenced.
To make escalation definitions generally available for Teamrooms (but not for app rooms), use
a collection for templates and presettings in “Customizing”. Otherwise, escalation definitions
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can be stored in app configurations (“Processes” widget), in app rooms (“Templates and
Presettings” action > “Process Templates” widget) or in Teamrooms (“Templates and
Presettings” action > “Process Templates” widget).

Settings of an Escalation Definition

e Name
The name of the escalation definition.

e [£scalations
Defines the desired escalations.

(¢]

Escalation Time

Defines the time of escalation.

= Time Span
Defines a time span in days, hours and minutes (working days are not considered). If
no operator and base date are specified, the time span is starting from now.

= Operator
Defines whether the time span is added to or subtracted from the base date.

= Base Date
Defines the base date for calculating the deadline (“Visible in Worklist From", “To Be
Started at the Latest by” or “To be Completed at the Latest by"). If the base date
changes, the deadline will be recalculated.
Note: For “Visible in Worklist From", escalations probably do not make sense, as the
activity is automatically moved to the “To Do” list.

Repetition

Defines how often the notification should be repeated.

= Time Span Until Next Escalation
Defines a time span in days, hours and minutes until the next notification (working
days are not considered). Leave blank if you do not want a repetition.

» Repeat Until
Defines how long the notification will be repeated (“Infinite”, “Date”, “Date Value of a
Property”).

» £nd Date/Date Value of a Property
Depending on Repeat Untilan end date or a property can be defined.

Recipients of Escalation Message

Defines the recipients of the notification (e.g. "Current Participant" or "Responsible for

Process").

Expression for Computing the Subject

Allows using an app.ducx expression to change the default subject of the notification e-

mail.

Expression for Computing the Additional Message

Allows using an app.ducx expression to add an additional text to the notification e-mail.

e Applicable for
The use of the escalation definition is restricted to the listed object classes and categories
of the object.

Fabasoft Cloud

69



o Object Class/Category of the File
The use of the escalation definition is restricted to the specified object classes and
categories of the object's file.

o Object Class/Category of the Teamroom
The use of the escalation definition is restricted to the listed object classes and categories
of the object's Teamroom.

Note:

e |f no date can be determined, no notification will be sent.

¢ If the escalation definition is no longer usable in the corresponding context (e.g. due to a
change in usability), no notification is sent.

Default Escalation

With the generally available default escalation, a notification is sent to the current workflow
participant one minute after the expiration of 7o Be Started at the Latest by and To be
Completed at the Latest by. The notification is repeated daily. The default escalation is defined
for all Fabasoft Cloud activity definitions.

7 Customizing

You can adapt your solution to your requirements by means of model-based customizing.

Here you will find a brief overview of the customization options available to you. All options are
described in detail in the following chapters.

e Templates
Nearly all objects and especially documents can be defined as templates. In this way new
objects or documents based on a template can be created.

e Text Modules
You can use text modules to insert predefined standard texts into Microsoft Word
documents.

e Insight Apps
Insight apps provide aggregated access to information in your cloud organization,
customized to your needs.

e Forms
User-defined forms can be used to add fields to objects for storing application-specific data.
To apply logic or specific behaviors to the fields, Fabasoft app.ducx expressions can be
used.

o (Categories
Categories can be assigned to objects and thus influence the behavior of the objects.

e Processes
Processes can be individually defined reflecting your business and organizational structure.
BPMN process diagrams are used to design executable business processes. Beside
predefined BPMN processes, ad hoc processes can be started as needed.

e Display Settings
Display settings can be provided to users who need special views on lists.
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e Search Forms
Search forms can be provided to users who need an overview of currently existing objects
based on defined search criteria.

e Time Intervals
Time intervals can be selected for a follow-up, for example.

7.1 General Information

In order to use customizing objects, on the one hand the users must be authorized in the
corresponding room and on the other hand the customizing objects must be released for
usage depending on the context.

Customizing Levels
Customizations are managed at different levels:

e Organization
Organization-wide customization is done by defining customization collections in the
“Templates and Presettings” dashboard. See the following chapters for more information.
Note: Organization-wide BPMN process diagrams, forms and categories are not available in
an app context by default. If these customizing objects have to be available in an app
context, they must be explicitly referenced in the app configuration or in the app room.

* App
In apps, such as contact management, you can make customizations in the app
configuration that are only valid within the app configuration context.

e Room
In rooms (e.g. app rooms or Teamrooms), customizations can be made that are only valid
within the room context.

e Personal
Personal customizations can only be used by the users themselves. The following
customizing objects can be managed at the personal level: templates, ad hoc process
templates, display settings, search forms and time intervals.

Release for Usage
In order to use customizing objects, they must be released for usage depending on the context.

Rules

e Customizing objects must be released if they are assigned to a customizing collection or an
app configuration.

e Forms and BPMN process diagrams must also be released if they are assigned to a room.

e Personal customizing objects do not have to be released.
Actions and Context Menu Commands

The actions are available to administrators and processors of a customizing collection
(organization level) or app administrators (app level).

¢ Release for Usage
You can create a release version using the “Release for Usage” action.

e Re-Release
Changes can be released using the “Re-Release” action.
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Note: A corresponding status symbol is displayed for changed customizing objects. In the
case of compound customizing objects, a status symbol is only displayed if the root object
has changed.

¢ Navigate to Release Version/Navigate to draft Version
You can view the draft or release version.

e Compare With Release Version/Compare With Draft Version
You can compare the metadata of the draft version with the release version (except forms).
For Microsoft Word documents, content comparison is also possible.

e Withdraw Release
You can use the “Withdraw Release” action to withdraw the release.

Release Process

In app configurations or customizing collections, you can define a release process in the
settings, on the “Default Values” tab, in the Release Process for Templates and Presettings field.
Release processes must contain the “Release for Usage” activity.

If a release process is defined, the following actions or context menu commands are offered:

e Start Release Process
Starts the defined release process.

e Open Current Release Process
Opens the release process that is not yet completed.

e Start Release Process Again
Restarts the release process (is only displayed when the current release process is
completed).

Structuring Folders

In order to structure customizing objects logically or hierarchically, corresponding folders (e.g.
template folders or text module folders) are available, which can be created via the respective
action.

7.2 Dashboard

The “Templates and Presettings” dashboard provides your access point to the customizing.

When you are added to a customizing configuration as an app user, a dashboard is
automatically created and placed on “Home". When you are removed as an app user, the
dashboard is also removed.

The “Templates and Presettings” dashboard is divided into the following areas:

o (Collections for Templates and Presettings
Shows the collections you are allowed to read or edit.

e Personal Templates
Shows the templates you created for yourself.

e Personal Processes
Shows the ad hoc process templates you created for yourself.

e Personal Presettings
Shows the presettings you created for yourself.

You can perform the following actions:
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Create Collection
With the “Create Collection” action you can create a new collection for templates and
presettings as app administrator.

Switch to Configuration
With the “Switch to Configuration” action you can view the configuration.

Settings
With the “Settings” action you can define common properties of the dashboard like the logo
or notification setting. Notifications are disabled by default.

7.3 Configuration

In the customizing configuration, you can manage the collections, artifacts and general settings
as an app administrator.

Areas

The configuration is divided into the following areas:

Collections for Templates and Presettings
Shows the available collections.

Template Categories
Shows the available template categories. Template categories are used to group the
templates in the create dialog.

Text Module Categories
Shows the available text module categories. Text module categories are used to display text
modules hierarchically when inserting them into a Word document.

Insight Apps
Shows the available insight apps.

Forms and Categories
Shows the available forms and categories.

Processes
Shows the available custom processes.

Thesauri
Shows the available thesauri that allow indexing.

Failed Background Tasks

Shows failed background tasks (only visible if at least one failed background task is
available). You can perform following manual actions: “Define Next Execution”, “Send Link”
and “Delete”.

Note:

To be able to store objects from a different context, you must adjust the Restrict Shortcuts
Within Teamroom field in the configuration settings accordingly.

In the default use case, you only need the “Collections for Templates and presettings”,
“Template Categories” and “Text Module Categories” areas.

Actions

You can perform the following actions:
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Create Collection
With the “Create Template Collection” action you can create a new collection for templates
and presettings.

Create Template Category
With the “Create Template Category” action you can define a new template category.

Create Text Module Category
With the “Create Text Module Category” action you can define a new text module category.

Translations

The “Translations” action can be used to export or import a CSV file containing the
multilingual names of the customizing objects of the configuration. This enables an external
translation.

Settings
With the “Settings” action you can make advanced configuration settings.

Settings

The general settings can be found in chapter 10.1.2 “General Configuration Settings".

7.4 Collections for Templates and Presettings

Collections are used to manage templates, text modules, insight apps, forms, categories,
processes, presettings and to define access rights (“Permissions” action). Collections can be
created by app administrators.

Areas

The collection for templates and presettings is divided into the following areas:

Templates
Shows the available templates.

Text Modules
Shows the available text modules.

Insight Apps
Shows the available insight apps.

Forms and Categories
Shows the available forms and categories.

Processes
Shows the available processes.

Presettings
Shows the available presettings.

Actions

You can perform the following actions:

Create Template
With the “Create Template” action you can define any object as a new template.

Create Text Module
With the “Create Text Module” action you can define a new text module.
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¢ Create Insight App
With the “Create Insight App” action you can define a new insight app.

e Create Category
With the “Create Category” action you can create categories.

e Create Form
With the “Create Form" action you can create user-defined forms.

e Create Process
With the “Create Process” action you can define an ad hoc process template or a BPMN
process diagram.

e Create Presettings
With the “Create Presettings” action you can define a search form or time interval.

e Upload
With the “Upload” action you can create a template, text module, BPMN process or form
from a file.

o Create Escalation Definition
With the “Create Escalation Definition” action you can create escalation definitions.

Note: Alternatively, you can use the “Tools” > “Add to Templates” context menu command on
an existing object to define a copy of the object as a template in “Customizing”.

Settings

“Template Collection” tab

o Template Categories
In the create dialog the templates with the template categories as additional text are
displayed in the “Templates” area.

e Text Module Categories
Defines in which categories the text modules can be found when they are inserted into a

document.
Additional tabs
e The additional settings can be found in chapter 10.2.1 “General Shelf Settings”.
Note

Collections for templates and presettings can be made available across organizations in a
generally readable manner (“General Settings” tab > Access Protection field). The templates and
presettings must be referenced in the desired context (e.g., in an app configuration) so that
they can be used.

The following restrictions apply:

e Template categories and text module categories cannot be considered. Templates and text
modules are not offered categorized.

e Forms, categories and BPMN processes cannot be provided cross-organizational.

Access Rights

e Full Control
Users with full control can create, edit and delete templates and presettings.
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Change Access
Users with change access can create and edit templates and presettings.

Read Access

Users with read access can only use templates and presettings if they are explicitly
referenced, for example, in the context of an app room. Thus, templates can be defined in
the collection that are not generally offered.

User
Users can use templates and presettings in general.
Note:

o Only users are offered the templates and presettings. If you are a user with change
access and want to use the templates, you must also be defined as a user.

o BPMN process diagrams, forms and categories are not available in an app context by
default. If these customizing objects have to be available in an app context, they must be
explicitly referenced in the app configuration or in the app room.

7.5 Defining Templates

Almost every object type can be used as template. Adjust the metadata or content of the
objects accordingly.

Note: When you define a Teamroom as a template, the objects defined in the Teamroom's
templates and presettings are copied to the Teamroom instance as shortcuts.

In addition, you can make additional settings on the “Template” tab of the object, which are
particularly relevant when using fields in Word templates.

Template Categories

In the create dialog the template with the template categories as additional text is displayed
in the “Templates” area (in addition to the template categories defined in the template
collection).

Template Language
The language of the template can be used to determine text modules in the corresponding
language.

Security Settings and Permissions Must Be Taken From the Template
Defines whether the user can select whether to apply the security settings and permissions
(team members) when instantiating the template. This setting is only available for rooms.

Category

The category is copied to the object created from the template.

Note: If applicable, lists can programmatically allow objects only with certain categories. In
this way, the category can also restrict where the template can be used.

Contained in

Defines the folder types in which the template can be used. This can either be done using
the object class or the category of the folder. If object classes and categories are specified
together, the folder must have a defined object class and a defined category.

Files

Defines the type of files in which the template can be used. You can do this using either the
object class or the category of the file. If object classes and categories are specified
together, the file must have a defined object class and a defined category.
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o Available Fields (Category)
Shows the fields that are available in the Word document based on the category.

o Available Fields (Contained in)
Shows the fields that are available in the Word document based on the definition in the
Contained infield. This creates an intersection of all available fields of the object classes
and an intersection of all available fields of the categories. This ensures that the properties
actually exist in each object class category combination.

e Availlable Fields (Files)
Shows the fields that are available based on the definition in the Files field in the Word
document. This creates an intersection of all available fields of the object classes and an
intersection of all available fields of the categories. This ensures that the properties actually
exist in each object class category combination.

e Additional Restrictions
The template is only offered for selection in the create dialog if the defined expression
returns true.

When you edit the Word document, you will find the “Insert Field” button on the “Fabasoft
Cloud” tab. In the submenu you will find the available fields according to your definitions.

Note: The formatting of fields in Microsoft Word can usually be considered when instantiating
templates and in the PDF preview if a style is set for the field including the surrounding text
after the field has been inserted.

Text Module Placeholders

Text module placeholders can also be inserted into Word templates and will be replaced by the
content of the text module when the template is instantiated. The command “Insert Text” >
“Text Module Placeholder” is available in Microsoft Word on the “Fabasoft Cloud” tab.

The placeholder is displayed as a hyperlink to the text module itself. Thus, the module text can
be easily viewed via the template.

Make sure to insert the placeholder as a separate paragraph (the placeholder must not be part
of another paragraph). This forms a single template paragraph which acts as a surrogate for
the paragraphs of the text module. Those text module paragraphs will replace the single
placeholder paragraph as part of the template instantiation procedure.

For a text module, all templates in which the text module is used are displayed on the
“Templates” tab.

If a template (for example, a file) contains several Word documents, the text module
placeholders in all Word documents are considered during instantiation.

7.6 Using Templates

In the create dialog (e.g. “New"” context menu command in a Teamroom) the templates with the
template category as additional text are displayed in the “Templates” area. For templates
without a template category, “Miscellaneous” is used as additional text. During creation, a copy
of the template is created, which you can edit independently of the template.

7.7 Defining Text Modules

There are two types of text modules:
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Static Text Module (Text)

Allows you to enter unformatted text.

Static Text Module (Word)

Allows you to enter formatted text in a Word document.

Note: Text module placeholders can also be inserted in text modules. Thus, a multi-level
dynamic text module hierarchy can be defined.

Metadata

The following metadata can also be defined:

“Static Text Module” tab

Name
The name of the text module.

Text Module Categories
The text module is offered within the specified categories when you insert it into a Word

document.

Text Module Language

Defines the language of the text module. When inserting text modules into Word templates,
only text modules are displayed that correspond to the language of the template or have
no language defined.

Keep Text Module Placeholders in Document

Defines whether text module placeholders inserted in a Word template are replaced when
a document based on the template is created. Text module placeholders that have not
been replaced can be replaced afterwards in Microsoft Word using the “Replace Text
Module Placeholder” button.

“Usage” tab

Current Document

Defines the categories and object classes of documents in which the text module can be
used.

Note: If a base form category is entered, the text module is also available for documents
that have been assigned a derived form category.

Contained in

Defines the folder types in which the document can be stored in which the text module can
be used. This can either be done using the object class or the category of the folder. If
object classes and categories are specified together, the folder must have a defined object
class and a defined category.

Files

Defines the type of files in which the document can be stored in which the text module can
be used. You can do this using either the object class or the category of the file. If object
classes and categories are specified together, the file must have a defined object class and
a defined category.

Note: If a base form category is entered, the text module is also available for files that have
been assigned a derived form category.

Additional Restrictions
The text module can only be used if the defined expression returns true. This allows you,
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for example, to realize that text module placeholders are removed in certain instances
instead of the corresponding text being inserted.

o Changeability
The changeability of a linked text module in Microsoft Word can be restricted. A linked text
module is editable by any user in Microsoft Word by default.

o Available Fields (Current Document)
Shows the fields that are available in the Word document based on the definition in the
Current Documentfield.

o Available Fields (Contained in)
Shows the fields that are available in the Word document based on the definition in the
Contained infield. This creates an intersection of all available fields of the object classes
and an intersection of all available fields of the categories. This ensures that the properties
actually exist in each object class category combination.

o Availlable Fields (File)
Shows the fields that are available based on the definition in the Files field in the Word
document. This creates an intersection of all available fields of the object classes and an
intersection of all available fields of the categories. This ensures that the properties actually
exist in each object class category combination.

“Translations” tab

Defines the translated text modules assigned to the text module.

Translations

Further text modules can be assigned to a text module as translations. To create a translation
for a text module, the “Create Translation” action is available. If translations already exist, the
"Translations" action can be used to navigate to the corresponding text modules or to create a
new translation.

Translations receive, among other things, the text module category and settings for usage from
the text module of the main language.

Each translation must be released before it can be used. When you release a text module with
translations, a dialog will inform you about unreleased translations. You can release all
translations at the same time. The status “Check Translations” indicates that there is at least
one translation that has not been released.

When you re-release a change, you will be informed in a dialog about translations that have not
yet been edited. You can decide whether no revision is required (e.g. when correcting a spelling
mistake). When you click the “Translation Required” button, the text module is not yet released
and all translations receive the “Revision Required” status. After a change, the status is removed
from the corresponding text module.

Existing text modules can serve as translations of another text module via the “Merge as
Translation” context menu command.

7.8 Using Text Modules

When you edit the Word document, you will find the “Insert Text” button on the “Fabasoft
Cloud” tab. In the submenu click either “Plain Text Module”, “Formatted Text Module”, “Linked
Text Module” or “Text Module Placeholder”. In the following dialog, you can select one of the
text modules that you have access to and insert it into the Word document.
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Text Module Placeholders

Text module placeholders inserted in a Word template are replaced automatically when
creating a document based on that template - if the corresponding text module is not
configured otherwise: a text module has a setting which defines that the corresponding
placeholder should not be replaced automatically. In this case you can replace it subsequently
using the “Replace Text Module Placeholder” button.

Placeholders have to be inserted as a separate paragraph (not as part of another paragraph).
This forms a single template paragraph which acts as a surrogate for the paragraphs of the text
module. Those text module paragraphs will replace (automatically or subsequently) the single
placeholder paragraph as part of the template instantiation procedure.

Linked Text Modules

In Microsoft Word, linked text modules can be inserted that update automatically each time the
document is opened. Depending on the user's permissions, linked text modules can be
modified in the context of the currently opened document. Modified text modules are no
longer updated automatically.

Following buttons are available:

Remove Text Module
Removes the selected text module.

Modify Text Module

Allows the text module to be changed in the context of the current document (if the user is
authorized to do so). Text modules that are marked for modification are no longer updated
automatically.

Reset Text Modules

Allows to reset changes of the focused text module or all text modules. The current,
released content of the text modules is taken over and the text modules are automatically
updated again in the future.

Dissolve Text Modules

Allows you to recursively dissolve the focused text module or all text modules (change
rights required). The current content of the text modules, which may have been changed in
the context of the document, is taken over as continuous text and the links are removed.

The status of a text module is displayed textually and in color in Microsoft Word when you
focus the text module:

Modifiable
Modifiable text modules are highlighted in blue.

Read-only

Text modules that cannot be changed are highlighted in gray and “Read-only” is displayed
in the title.

With Condition

The text module defines an expression for further restrictions of usability. “With Condition”
is displayed in the title.

Modified

The text module was marked as changed by the user. “Modified” is displayed in the title.
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Hidden
The text module is hidden (generally due to the expression for further restrictions of
usability). The text module is grayed out and a placeholder text is displayed.

Broken
The text module returns an error (e.g. if it is in the wastebasket). The text module is
highlighted in red and “Broken” is displayed in the title.

Note:

Linked text modules will replace text module placeholders in the future. The two
functionalities cannot be used together in one document.

In templates, the linked text modules are always displayed with content, regardless of the
condition. In documents, the linked text modules remain available, but the content is
displayed depending on the condition.

Linked text modules are also considered on the server side (e.g. PDF overview). Make sure
that the Update PDF Content on Metadata Change option is enabled on the Microsoft Word
document.

Text modules or linked text modules may only be inserted in normal continuous text (e.g.
not in tables, headers and footers).

Text modules or linked text modules may only contain continuous text with bulleted lists or
numbered lists and tables (e.g. no cross-references, footers, comments and shapes). The
style sheets of the linked text module must match those of the Word document containing
the text module or linked text module.

Text modules must not start with a table.

Linked text modules must not contain tables that reference the properties of a form
category and that are updated using the “Update Tables” context menu command.

Linked text modules that contain a table must not contain any other linked text modules
with tables.

Deleted linked text modules are automatically removed from the document.

Linked text modules (Word) can contain other linked text modules.

7.9 Defining and Using Insight Apps

Insight apps provide aggregated access to information in your cloud organization, customized
to your needs. You can use insight apps to display and highlight important information without
users having to explicitly search for it.

More information can be found in chapter 5.5 “Insight Apps".

7.10 Defining and Using Forms and Categories

User-defined forms can be used to add fields to objects for storing application-specific data.
Categories can be assigned to objects and thus influence the behavior of the objects.

More information can be found in the chapters 11.1 “Forms” and 11.2 “Categories”.

7.11 Defining Processes

There are two types of process templates:
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e Ad Hoc Process Template

e BPMN Process Diagram

Ad Hoc Process Template
To create an ad hoc process template, proceed as follows:

Navigate in the desired collection.
Click the “Create Process” action and select the “Ad Hoc Process Template” entry.
Enter a name and click “Next".

Click “Open” on the context menu of the ad hoc process template.

LA S

Enter the activity and the participant for the first task in the process. For more information
on the options, see chapter 6.2 “Activities and Participants”.

6. Click “Next" if you do not want to add another activity.
Otherwise, click “Apply”. You can add further activities by selecting an activity and
participants and clicking “Apply” again. The last activity with a defined participant will be
considered even if you do not click “Apply”.

Click “Next” to complete the editing.

Click “Release for Usage"” on the context menu of the ad hoc process template.

BPMN Process Diagram

To create a BPMN process diagram, proceed as follows:

Navigate in the desired collection.

Click the “Create Process” action and select the “BPMN Process Diagram” entry.
Enter a name and click “Next".

Click “Open” on the context menu of the BPMN process diagram.
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Model the desired process. For more information on working with the BPMN editor, see
chapter 6.7.2 “Working With the BPMN Editor”.

Click “Next” to complete the editing.

7. Click “Release for Usage” on the context menu of the BPMN process diagram.

7.12 Using Processes

The defined processes are offered for selection when using processes (e.g. “Tools” > “Start New
Process”).

7.13 Defining Presettings

There are three types of presettings:
e Display Settings
e Search Form

e Time Interval
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Display Settings

Display settings can be defined directly in a list via the “View" > “Display Settings” > “Save” menu
command (thereby the storing location can be selected).

Search Form
To create a search form, proceed as follows:

Navigate in the desired collection.

Click the “Create Presettings” action and select the “Search Form” entry.
Enter a name and click “Next".

Specify what you want to search for and click “Next".

Specify the search criteria.

Click “Save Query”.
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Click “Release for Usage” on the context menu of the search form.

Time Interval

Navigate in the desired collection.
Click the “Create Presettings” action and select the “Time Interval” entry.

Enter a multilingual name, time interval, and unit and click “Next".

A W=

Click “Release for Usage” on the context menu of the time interval.

7.14 Using Presettings

You can use the presettings as follows:

e You can apply the display settings in lists via the “View" > “Display Settings” > “Load” menu
command. You can also save display settings (thereby the storing location can be selected).

e Search forms can be selected during a search (e.g. in a search folder).

e Time intervals can be selected for a follow-up, for example.

7.15 Personal Templates, Processes and Presettings

Each user can define his own templates, processes and presettings in the “Personal Templates",
“Personal Processes” and “Personal Presettings” areas of the dashboard.

8 Contact Management

The contact management allows you to create and manage contacts in contact rooms. Based
on user-defined criteria you can specify address lists that can be exported for sending
newsletters, for example.

Contacts can be either contact persons or organizations. Organizations, in the sense of
contacts, should not be confused with cloud organizations (used for user administration).
Duplicate checks support the avoidance of different datasets.

Special property values of contacts (e.g. salutation, address, telephone number and so on) can
be assigned to different contact rooms and are therefore only visible to authorized users in the
respective contact rooms. This makes it possible, for example, to ensure that the business
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contact data of employees are accessible to all employees, while the private contact data is only
accessible to the HR department.

Audit log entries are written for use cases such as copying data tables or exporting contacts.
More information can be found in chapter 12.17 “Auditing”.

Note: The contact management may have to be enabled by an organization administrator
(Organization > Licenses > Solutions > Contact Management with assignment Configured
(Inactive)> "Enable” action).

8.1 Contacts Dashboard

The contacts dashboard is your central access point for contact management.

When you are added to a contact configuration as a contacts user, a dashboard is automatically
created and placed on “Home". If you are removed as a contacts user, the dashboard will also
be removed.

The contacts dashboard is divided into the following areas:

e Recently Used Contacts
Shows the last contact persons and organizations you have used.

e Contact Rooms
Shows the contact rooms in which the contacts are managed. Each contact room defines its
own rights context.

e Address Lists
Shows all address lists. In address lists, contacts can be collected and exported from
different contact rooms.

You can perform the following actions:

e Create Contact Room
As contacts administrator you can use the “Create Contact Room” action to create new
contact rooms.

¢ Switch to Configuration
Use the “Switch to Configuration” action to view the configuration associated with the
dashboard.

e Settings
The “Settings” action allows you to set general contacts dashboard properties, such as the
logo or natification setting.

8.2 Contacts Configuration

In the contacts configuration, you can define as contacts administrator settings for the
metadata of contacts. In addition, you can specify users who are allowed to use the contact
management.

Contacts configurations can be created in the organization by the organization owner,
organization administrator or payment user. The defined contacts administrators can edit the
corresponding contacts configurations.

Note: As contacts administrator, you can switch to the assigned configuration via the contacts
dashboard.
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Areas

The contacts configuration dashboard is divided into the following areas:

Contact Rooms
Shows the contact rooms in which the contacts are managed. Each contact room defines its
own rights context.

The general areas can be found in chapter 10.1 “Configurations”.

Actions

You can perform the following actions:

Create Contact Room
With the “Create Contact Room” action you can define a new contact room.

Translations
The “Translations” action can be used to export or import a CSV file containing the
multilingual names of the customizing objects. This enables an external translation.

Settings
Use the “Settings” action to define settings for the metadata of contacts.

Permissions

The “Permissions” action allows you to specify contacts administrators who can edit the
configuration. Contacts administrators have full control on all contact rooms. Contacts
users are authorized to use the contact management. The respective rights are determined
by the contact rooms.

Note: Based on the specified users the consumed licenses are calculated.

Settings

In the contact configuration, you can make the following settings:

“Contact Person"” tab

Contact Person
Specifies which optional contact person metadata should be displayed for a contact person.

Address
Specifies which optional address metadata should be displayed for a contact person.

Organization
Specifies which optional organizational metadata should be displayed for a contact person.

Further Information
Specifies which optional additional information metadata should be displayed for a contact
person.

Declarations of Consent
Specifies which fields should be displayed for a contact person with regard to declarations
of consent for data processing.

“Organization” tab

Organization
Specifies which optional organizational metadata should be displayed for an organization.

Address
Specifies which optional address metadata should be displayed for an organization.
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¢ Further Information
Specifies which optional additional information metadata should be displayed for an
organization.

“Predefined Values” tab

e Relationship Types
Specify values that you want to be selectable for relationship types (for example, business
partners).

e Industries
Specify values that you want to be selectable for industries (for example, trade).

e Functions
Specify values that you want to be selectable for functions (for example, consultant).

¢ Kinds of Social Media
Set values to be selectable for types of social media (for example, Facebook).

¢ Kinds of Other Information
Specify values to be selected for types of additional information (for example, hobby).

¢ Declarations of Consent
Specify values to be selected for types of declarations of consent (for example, e-mail).

“Externally Managed Fields” tab

e Contact Person
The selected metadata is displayed read-only for a contact person, if the Managed
Externally option is selected for the contact person. This means that the metadata can no
longer be changed via the user interface, but only via the import mechanism.

e Organization

The selected metadata is displayed read-only for an organization, if the Managed Externally

option is selected for the organization. This means that the metadata can no longer be
changed via the user interface, but only via the import mechanism.

Additional tabs

e The general settings can be found in chapter 10.1 “Configurations”.

8.3 Contact Rooms

Contact rooms are used for the structured administration of contacts and to define access
rights (“Permissions” action) and default values (“Settings” action > “Default Values” tab).

You can store the contacts directly in the contact room at top level or structure them further
with folders. Special property values of contacts (e.g. the salutation) can be assigned to
different contact rooms and are therefore only visible to authorized users in the respective
contact rooms.

Address lists allow collecting and exporting contacts from different contact rooms.

In addition to the structured management of contacts, it is also possible to manage them in an
unstructured way. You can find more information on unstructured shelves in chapter 10.2.4
“Unstructured Shelves”.
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8.4 Creating Contact Persons

To create a contact person, proceed as follows:

1. Navigate in the desired contact room.

2. Click the “Create Contact Person” action.

3. Enter the contact person’s data. First name and surname are mandatory fields.
4

Optionally, click the “Show Additional Fields” button to see all available fields of the contact
person.

5. Click “Create”.
Note:

¢ If no main organization is assigned to the contact person, an organization name and the
function in the organization can be assigned textually.

e If organizations are assigned to the contact person, the addresses and telephone numbers
of the current organizations are added to the contact person.

o Before a contact person is created, a duplicate check is automatically carried out (see
chapter 8.6 “Duplicate Check”).

8.5 Creating Organizations

To create an organization, proceed as follows:

1. Navigate in the desired contact room.

2. Click the “Create Organization” action.

3. Enter the organization’s data. The name is a mandatory field.
4

Optionally, click the “Show Additional Fields” button to see all available fields of the
organization.

5. Click “Create”.

Note: Before an organization is created, a duplicate check is automatically carried out (see
chapter 8.6 “Duplicate Check").

8.6 Duplicate Check

When creating or changing contacts, it is checked whether a corresponding contact already
exists. The duplicate check is only performed with contacts that the user, who executes the
action, has access to. If a duplicate has been found, you can clean up or merge the contacts in a
dialog.

Contact persons are recognized as duplicates if

¢ either the e-mail address already exists and/or

¢ the given first name and surname already exist.
Note: If the first name is empty, contact persons with the same last name and also empty
first name will be recognized as duplicates.

Organizations are recognized as duplicates if

e either the e-mail address already exists and/or

¢ the entered organization name already exists.
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To perform a duplicate check, proceed as follows:
1. When creating or editing a contact, a duplicate check is automatically carried out. If a
duplicate is found, a dialog will be opened.

2. Values that differ are highlighted. The new value is highlighted in yellow and the old value is
crossed out. Move the mouse pointer over the corresponding line. You can adjust the
values accordingly by using the “Insert”, “Remove", “Replace” or “Discard” buttons. The
“Restore” button can be used to discard an adjustment.

3. Click “Next" after resolving all conflicts.

8.7 Changing the Assignment of Contacts

Contacts can be assigned to another contact room. Full control is required in the source contact
room and change access in the target contact room. If you do not have the necessary rights, the
change request can also be forwarded to another user.

To change an assignment of contacts, proceed as follows:

1. Navigate to the desired contact.

2. Inthe contact's context menu, click “Change Assignment” (available only for users with full
control).

3. If you have change access in the target contact room, you can change the assignment by
yourself, otherwise you can forward the change request, for example, to a contact
administrator.

o Case 1: Select the target contact room and click “Change Assignment”.

o Case 2: Click “Forward”. Select a user (contact administrator) and click “Forward”. The
selected user receives an activity in the worklist. The assignment to the contact room can
be changed via the “Change assignment” work step.

Note: You can determine contact administrators by switching to the configuration and clicking
the “Permissions” action.

8.8 Using Address Lists

Address lists can be created in a contact room (access rights context) using the “Create Address
List” action. However, the contacts in address lists can be collected from different contact
rooms.

If a user does not have access rights to a contact in the address list, the contact is displayed
with “Access Denied”.

Additional address lists can be created in address lists. This makes it possible to create an
address list hierarchy. For example, an address list “Events” can consist of address lists for
different events. When exporting the “Events” address list, all contacts of the subordinate

address lists are taken into account.

You can manually compose address lists by copying and pasting contacts into the address list.
Alternatively, you can also define search criteria.

To define search criteria for an address list, proceed as follows:

1. Navigate in the desired address list.

2. Click the “Define Search Criteria” action.
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3. Select whether you want to search for contact persons or organizations.
You can also restrict the objects you are looking for to the current contact room or your
organization.

4. Enter the search criteria and click “Save Query".
5. Click on the “Refresh Result” action to apply the search criteria.
Note:

o “Refresh Result” applies the last saved query to the address list.

¢ You can also use the “Define Search Criteria” action for a standard search without saving
the query. You can copy the search hits manually.

8.9 Importing and Exporting Contacts

The import and export of contacts is possible in address lists. When importing contacts, they
are assigned to the contact room of the used address list. If a user-defined form is assigned to
contacts, these properties can also be imported and exported (the programming name of the
respective property serves as the column caption).

Import
Contacts can be imported and updated using a CSV or XLSX file.

To import contacts, proceed as follows:

1. Navigate in the desired address list.
2. C(lick the “Import Contacts” action.

Click the “Download CSV Template” button to obtain a template describing the required
data structure.

4. Inthe Contentfield, enter the path to the CSV or XLSX file that defines the contacts.
5. Click “Start import”.
6. After the import has completed, click “Next".

The imported contacts are stored in the address list and in the corresponding contact room.

The CSV columns are generally user-defined text fields of the type string or date (yyyy-mm-dd).
For multi-value fields (e.g. nameorgext) a carriage return (cr LF) is used as separator.

Note: The externally managed properties of a contact can only be updated, if the specified data
source matches the data source of the existing contact.

Organization

The following table contains all relevant columns for organizations.

CSV Column Field Possible Value

objexternalkey Import ID String

To fill fields with several
lines (e.g. addresses), you
can specify several lines
with the same external key
(objexternalkey) in the
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CSV file.

objclass

Object Class

String
(ContactRoomorganisatio

n)

externaldatasource

External Data Source

String

objcategory Category Import ID or short
reference of a category
(e.g.
FormCategoryf372875)

orgname Name Stl’lng

DI Name (Extended) String list

address.addrstreet Addresses (Street) String

address.addrpostofficebox Addresses(P().Box) Stﬂng

address.addrzipcode Addresses (Zip Code) String

address.addreity Addresses (City) String

address.addrstate Addresses (State) String

zeldzess acdreornitey Addresses (State) String

address.addrtopic

Addresses (Type)

Short reference of an
address type (e.g.
TermBusiness,

TermPrivate)

emailinformation.emailaddress

E-Mail Addresses (E-Mail
Address)

String

emailinformation.addrtopic

E-Mail Addresses (Type)

Short reference of an
address type (e.g.
TermEMaill, TermEMail?2)

telephone. telnumber

Telephone Numbers
(Telephone Number)

String

telephone.addrtopic

Telephone Numbers (Type)

Short reference of an
address type (e.g.

TermBusiness, TermFax)

website

Web Site

String

telephonebusiness

Telephone Numbers

String
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(Telephone Number,

Business)
telephonefax Telephone Numbers String
(Telephone Number, Fax)
telephonemobile Telephone Numbers String
(Telephone Number, Mobile)
e Telephone Numbers String
(Telephone Number, Private)
emailbusiness E-Mail Addresses (E-Mail String
Address, Business)
CUIEBLIZESRZREC E-Mail Addresses (E-Mail String
Address, Private)
addressbusiness.addrstreet Addresses (Street, Business) |String
addressbusiness.addrpostoffice | Addresses (P.O. Box String
box ) !
Business)
addressbusiness.addrzipcode Addresses (Zip Code String
Business)
addressbusiness.addrcity Addresses (City, Business) | String
addressbusiness.addrstate Addresses (State, Business) | String
addressbusiness.addrcountry Addresses (Country String
Business)
addressinvoice.addrstreet Addresses (Street, Invoice) | String
addressinvoice.addrpostofficeb | Addresses (P.O. Box, Invoice) String
OoX
addressinvoice.addrzipcode Addresses (Zip Code, Invoice) | String
seldremslovedes addreiiy Addresses (City, Invoice) String
addressinvoice.addrstate Addresses (State, Invoice) String
FECREPINTOL 68 AT CoTnETy Addresses (Country, Invoice) |String
addressprivate.addrstreet Addresses (Street, Private) | String
addressprivate.addrpostofficeb | Addresses (P.O. Box, Private) |String
(0):4
addressprivate.addrzipcode Addresses (Zip Code, Private) | String

Fabasoft Cloud

91




addressprivate.addrcity Addresses (City, Private) String
addressprivate.addrstate Addresses (State, Private) String
addressprivate.addrcountry Addresses (Country, Private) |String
orgsuppliernr Supplier Number String
orgcustomernr Customer Number String
orgcompanycode Company Code String
orgtradeid Trade Directory ID String
orgvatid VAT ID String
orgdataprocid Data Processing ID String
orgjurisdiction Court of Jurisdiction String

orgindustries

Industries

Import ID of a term

overridekeys

CSV columns of properties
to be overwritten
separated by commas
(otherwise empty values
are ignored and values are
added in list properties)

Note: For overridekeys with multipart CSV column names, specify the string before the dot
(e.g. telephone). Overwriting therefore affects all values of the telephone aggregate and all
other telephone columns serving simplification purposes (telephone.telnumber,
telephone.addrtopic, telephonebusiness, telephonefax etc.). For addresses, e-mail
addresses and telephone numbers you have to specify the respective base column (address,

emailinformation OF telephone).

Contact Person

The following table contains all relevant columns for contact persons.

CSV Column

objexternalkey

Field

Import ID

S EREIE

String

To fill fields with several
lines (e.g. addresses), you
can specify several lines
with the same external key
(objexternalkey) in the
CSV file.
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objclass

Object Class

String (ContactRoomPerson)

externaldatasource External Data Source String

objcategory Category Import ID or short
reference of a category
(e.g.
FormCategory 3 2875).

userfirstname First Name String

persmiddlename Middle Initial String

usersurname Surname String

persposttitle Post Title String

persawardedtitle Awarded Title String

persjobtitle Job Title String

persacademictitle Academic Title String

persnickname Nickname String

perssex Sex String (SEX_FEMALE Of
SEX MALE)

persbirthday Date of Birth Date

perssalutations.salutation Salutations (Salutation) String

perssalutations.addrtopic

Salutations (Type)

Short reference of a
salutation type (either
TermFormalSalutation Or

TermPersonalSalutation)

persmothertongue Mother Tongue Short reference of a system
language (e.g. LANG GERMAN,
LANG ENGLISH)

commlanguage Language for Short reference of a system

Communication

language (e.g. LANG_GERMAN,
LANG ENGLISH)

address.addrstreet Addresses (Street) String
address.addrpostofficebox Addresses (P.O. Box) String
address.addrzipcode Addresses (Zip Code) String
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gadeessisceie Rey Addresses (City) String
address.addrstate Addresses (State) String
sddeebsliaddrcounizry Addresses (State) String
address.addrtopic Addresses (Type) Short reference of an
address type (e.g.
TermBusiness,
TermPrivate)
emailinformation.emailaddress |E-Mail Addresses (E-Mail String

Address)

emailinformation.addrtopic

E-Mail Addresses (Type)

Short reference of an
address type (e.g.
TermEMaill, TermEMail?2)

telephone. telnumber

Telephone Numbers
(Telephone Number)

String

telephone.addrtopic

Telephone Numbers (Type)

Short reference of an
address type (e.g.

TermBusiness, TermFax)

CISRER RO Web Site String

telephonebusiness Telephone Numbers String
(Telephone Number,
Business)

telephonefax Telephone Numbers String
(Telephone Number, Fax)

telephonemobile Telephone Numbers String
(Telephone Number, Mobile)

telephoneprivate Telephone Numbers String
(Telephone Number, Private)

emailbusiness E-Mail Addresses (E-Mail String
Address, Business)

emailprivate E-Mail Addresses (E-Mail String
Address, Private)

addressbusiness.addrstreet Addresses (Street, Business) |String

addressbusiness.addrpostoffice | Addresses (P.O. Box, String

box

Business)
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addressbusiness.addrzipcode Addresses (Zip Code, String
Business)

addressbusiness.addrcity Addresses (City, Business) | String

addressbusiness.addrstate Addresses (State, Business) | String

addressbusiness.addrcountry Addresses (Country, String
Business)

addressinvoice.addrstreet Addresses (Street, Invoice) | String

addressinvoice.addrpostofficeb | Addresses (P.O. Box, Invoice) String

(eD:¢

addressinvoice.addrzipcode Addresses (Zip Code, Invoice) | String

addressinvoice.addrecity Addresses (City, Invoice) String

addressinvoice.addrstate Addresses (State, Invoice) String

sedresslovedes adoroetn Ly Addresses (Country, Invoice) |String

addressprivate.addrstreet Addresses (Street, Private) | String

addressprivate.addrpostofficeb | Addresses (P.O. Box, Private) |String

(eD:¢

addressprivate.addrzipcode Addresses (Zip Code, Private) | String

addressprivate.addrcity Addresses (City, Private) String

addressprivate.addrstate Addresses (State, Private)  |String

addressprivate.addrcountry Addresses (Country, Private) |String

persfunctionbec Function According to String
Business Card

PRSI Supervisor String

persassistent Assistant String

ISEHEEE R CREERENIS Name of the Organization String

persfunctions Functions Import IDs of terms

separated by a carriage
return
IP(CRAEHIE e Main Organization Import ID of an

organization
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perscurremployments.emplorg Current Organizations Import ID of an
(Organization) organization
perscurremployments.emplfuncti Current Organizations String
on g
(Function)
perscurremployments.emplfrom | Cyrrent Organizations String
(From)
perscurremployments. emplto Current Organizations (To)  |String
perspastemployments.emplorg Previous Organizations Import ID of an
(Organization) organization
perspastemployments.emplfuncti | previous Organizations Import ID of a term
on q
(Function)
perspastemployments.emplfrom | preyious Organizations String
(From)
berspastemployments.emplto Previous Organizations (To) |String

persconsentdeclarations

Declarations of Consent

Import IDs of terms
separated by a carriage
return

overridekeys

CSV columns of properties
to be overwritten
separated by commas
(otherwise empty values
are ignored and values are
added in list properties)

Note: For overridekeys with multipart CSV column names, specify the string before the dot
(e.g. telephone). Overwriting therefore affects all values of the telephone aggregate and all
other telephone columns serving simplification purposes (telephone.telnumber,
telephone.addrtopic, telephonebusiness, telephonefax etc.). For addresses, e-mail
addresses and telephone numbers you have to specify the respective base column (address,

emailinformation OF telephone).

Export

Contacts can be exported as CSV file. For property lists, the first value found is exported.

To export contacts, proceed as follows:

1. Navigate in the desired address list.

2. Click the “Export Contacts” action.

By default, the columns to be included in the CSV file are determined by the column
settings of the address list. Adjust the columns if necessary.
Note: The last used settings are saved for the address list, if the export was carried out by a
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user with at least change rights. You can restore the columns according to the address list
by clicking the “Reset” button.

4, Optionally, click “Show Details” to set the order for exporting addresses, phone numbers, e-
mail addresses, salutations and contact rooms. The order of the contact rooms is always
the second criterion. Only the first value found is exported.

Example: If you specify the sequence for e-mail addresses with “Business, Private” and the
sequence of contact rooms with “Room 1, Room 2", the following sequence is defined:

o First, the first business e-mail address assigned to room 1 is searched for.

o if no e-mail address was found, the first business e-mail address assigned to room 2 is
searched for.

o If no e-mail address was found, the first private e-mail address assigned to room 1 is
searched for.

o If no e-mail address was found, the first private e-mail address assigned to room 2 is
searched for.

5. Click “Export”.
The CSV file with the selected columns is downloaded.

Note: Contacts in the wastebasket are not exported.

8.10 Deleting Contacts

To delete a contact (to be placed in the recycle bin) you need to have change access. If property
values of the contact are assigned to a different contact room, also change access is required in
this room. If you do not have the necessary rights, contact a contacts administrator. To delete
permanently a contact (to be removed from the recycle bin) full control is required.

To delete a contact, execute the “Delete” context menu command.

8.11 Using Address Books

Access to contacts is also possible via third-party products such as “Apple Contacts”, which
support the CardDAV standard. A password for applications is required for access. If you have
not yet created one for CardDAYV, create one now (see chapter 13.5 “Access for Applications”).

To display contacts in a third-party product, proceed as follows:

1. Navigate in a contact room or address list.

2. Click the “Add to Address Book List” action.
Note: The “Remove From Address Book List” action can be used to remove the contact
room or address list again.

3. Switch to your third-party contacts product.

4. Configure a new account in the third-party product. Enter your e-mail address for the cloud
log-in as the user name and the generated password for applications as the password.

The cloud contacts are now displayed in the third-party product and can be edited if applicable.

Note: The “Open Cloud Address Book" context menu command of the Fabasoft Cloud
notification symbol can be used to include the address book list in Microsoft Outlook.
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8.12 Serial E-Mails

Via a serial e-mail you can send personalized e-mails to defined recipients from the contact
management.

Note: This functionality is only available if your cloud organization has its own SMTP server
configured.

To send a serial e-mail, proceed as follows:

1. Navigate to a Teamroom and create a “Serial E-Mail” object.
2. Define the metadata for the e-mails to be sent (see below).

The “Define Addressees” action can be used to define the recipients and to generate the
CSV file with the contact data.

4, The “Execute E-Mail Test Dispatch” action can be used to specify test recipients who receive
the specified number of sample e-mails. This allows you to check whether the e-mails meet
your requirements.

5. The “Send Serial E-Mail” action can be used to send the e-mails to the recipients. In the send
overview you can also create or update the CSV file with the recipient data.
You can check the result on the “Transmission Log" tab of the serial e-mail. For the recipient
contacts, the serial e-mail is stored on the “Communication” tab.
When the action is executed again, only e-mails that have not yet been sent are sent (e.g.
due to a sending error).

Metadata
“Serial E-Mail” tab

e Name
The name of the serial e-mail.

o £-Mail Subject

Defines the subject of the e-mail.
o Use E-Mail Message From Document

Defines whether the e-mail text should be entered directly or whether a file should be

uploaded. For directly entered text or for an HTML file, the following placeholders can be

used to personalize the e-mail:
[=addressee FSCFOLIO 1 1001 FieldAddrSurName]
[=addressee FSCFOLIO 1 1001 FieldAddrFirstName]
[=addressee FSCFOLIO 1 1001 FieldAddrSalutation]
[=addressee FSCFOLIO 1 1001 FieldAddrSexSalutation]
[=addressee FSCFOLIO 1 1001 FieldAddrStreet]
[=addressee FSCFOLIO 1 1001 FieldAddrPostOfficeBox]
[=addressee FSCFOLIO 1 1001 FieldAddrZzZipCode]
[=addressee FSCFOLIO 1 1001 FieldAddrCity]
[=addressee FSCFOLIO 1 1001 FieldAddrTitle]
[=addressee FSCFOLIO 1 1001 FieldAddrContact]
[=addressee FSCFOLIO 1 1001 FieldAddrCountry]
[=addressee FSCFOLIO 1 1001 FieldTelNumber]
[=addressee FSCFOLIO 1 1001 FieldOrganization]
[=addressee FSCFOLIO 1 1001 FieldAddrState]
[=addressee FSCFOLIO 1 1001 FieldMiddleName]

o 0O 0O O O o o O O O o o o o o
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o [=addressee FSCFOLIO 1 1001 FieldPostTitle]

E-Mail Message
The e-mail message as text or file.

Attachments
The specified contents are added as attachments to the e-mail. HTML attachments can also
be personalized.

Send Attachments as
The contents can be sent in the original format or as a PDF file. If conversion to PDF is not
possible, the file is sent in the original format.

“Addressees” tab

Name of Sender
Defines the name of the sender. By default, your user name is used.

E-Mail Address of Sender
Defines the e-mail address of the sender. By default, your user e-mail address is used.

Addressees

The e-mail is sent to the defined addressees (contact persons, organizations and address
lists).

Robinson List

Allows filtering the specified addressees by contacts, organizations and address lists.

Create/Recreate CSV File
To determine the contact data from the addressees, a CSV file must be created before
sending.

“Transmission Log" tab

Transmission Errors (Preview)
Shows a limited number of transmission errors that occurred.

Transmission Log
Contains the complete transmission log. If applicable, the corresponding error message is
shown for each e-mail.

9 Material Master

Material master management makes it possible to manage materials and price conditions.
Materials and price conditions can be created and updated via a web service interface, for
example from SAP.

You can find more information on the web service interface here:

https://help.cloud.fabasoft.com/index.php?topic=doc/Fabasoft-Cloud-Web-Services/material-

master-data.htm

9.1 Material Master Dashboard

The material master dashboard is your central access point for material master management.

If you are added to a material master configuration as an app user or app administrator, a
dashboard is automatically created and placed on “Home". If you are removed again as an app
user or app administrator, the dashboard is also removed.
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The material master dashboard is divided into the following areas:

e Recently Used
Shows the materials and price conditions you recently used.

o Material Shelves
Shows the material shelves in which you are authorized. Each material shelf defines its own
access rights context.

e Price Lists
Shows the price lists in which you are authorized. Each price list defines its own access
rights context.

You can perform the following actions:

¢ Create Material Shelf
As an app administrator, you can use the “Create Material Shelf” action to create new
material shelves.

e Create Price List
As an app administrator, you can use the “Create Price List” action to create new price lists.

¢ Switch to Configuration
As an app administrator, you can use the “Switch to Configuration” action to display the
configuration assigned to the dashboard.

e Settings
You can use the “Settings” action to define general properties of the material master
dashboard (e.g. the logo or the notification setting).

9.2 Material master Configuration

As an app administrator, you can define general settings in the material master configuration.

Note: As an app administrator, you can switch to the assigned configuration via the material
master dashboard.

Areas
The material master configuration dashboard is divided into the following areas:

e Shelves
Shows the material shelves and price lists in which the materials and price conditions are
managed. Each shelf defines its own access rights context.

e Sales Organizations
Shows the sales organizations that can be used in the context of material master
management. The organizations are managed in “Contact Management” and referenced
here. You can store individual organizations, but also contact rooms and address lists. You
can find more information on contact management in chapter 8 “Contact Management”.

o Quantity Units
Shows the defined quantity units that can be used for materials.

e The description of the other general areas can be found in chapter 10.1 “Configurations”.

Actions

You can perform the following actions:

Fabasoft Cloud 100



e Create Material Shelf
You can use the “Create Material Shelf” action to create new material shelves.

e Create Price List
You can use the “Create Price List” action to create new price lists.

e Translations
The “Translations” action can be used to export or import a CSV file with the multilingual
names of the customizing objects. This enables an external translation.

e Settings
You can use the “Settings” action to define general settings.

e Permissions
You can use the “Permissions” action to define app administrators who are allowed to edit
the configuration and create shelves. App users are authorized to use the material master
management. The respective access rights are defined via the shelves.

Note: The licenses used are calculated based on the users entered.

Settings

The description of the general settings can be found in chapter 10.1 “Configurations”.

9.3 Material Shelves

Material shelves are used for the structured management of materials and for defining access
rights (“Permissions” action).

You can store the materials directly in the shelf at top-level or use folders for further
structuring.

In addition to the structured management of materials, it is also possible to manage them
unstructured. You can find more information on unstructured shelves in chapter 10.2.4
“Unstructured Shelves".

9.4 Price Lists

Price lists are used for the structured management of price conditions and for defining access
rights (“Permissions” action).

You can store the price conditions directly in the shelf at top-level or use folders for further
structuring.

In addition to the structured management of price conditions, it is also possible to manage
them unstructured. You can find more information on unstructured shelves in chapter 10.2.4
“Unstructured Shelves”.

9.5 Creating Materials

To create a material, proceed as follows:

1. Navigate in the desired material shelf.

2. Click the “Create Material” action.

3. Enter the material's data. The Material Numberis a mandatory field.
4. Click “Next".
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The following fields are available:

Material Number
The material number of the material.

Multilingual Name
The multilingual name of the material.

Sales Organization (Owner)
The sales organization that originally sells the material.

Sales Organizations

The sales organizations that, in addition to the owner, are authorized to sell the material for

the owner.

Quantity Unit
Defines the default quantity unit for the material.

Alternative Quantity Units

Defines additional quantity units with a conversion factor for the material.
Example:

Quantity Unit: Hours

Alternative Quantity Units: Person days with conversion factor 8

9.6 Creating Price Conditions

To create a price condition, proceed as follows:

1

2.
3.
4

Navigate in the desired price list.

Click the “Create Price Condition” action.

Enter the price condition’s data. The Price Condition IDis a mandatory field.
Click “Next”.

The following fields are available:

Price Condition ID
The ID of the price condition.

Material

The material to which the price condition applies.

Sales Organization

The sales organization to which the price condition applies.
Valid From

The price condition is valid from the specified date.

Valid Until

The price condition is valid until the specified date.

Calculation Rule

Defines the calculation rule (percentage, quantity, etc.) for the price condition.
Scale Type

Defines whether there is a quantity scale for the price condition.

Condition Amount (Price)
Defines the price of the price condition.
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e Price Scales
If a quantity scale has been defined as the scale type, the price scales are available.

o Scale Kind
Defines whether it is a from scale or a to scale.

o Scale List
Defines a list consisting of the scale quantity and condition amount.

e Lower Limit
Defines the lower limit of the price.

o Upper Limit
Defines the upper limit of the price.

e Quantity Unit
Defines the quantity unit of the price condition. Only quantity units that have been stored
for the defined material can be selected.

10 General Settings in Configurations and Shelves

The following applications provide the general settings described here:

e Customizing
e Contact Management

e Material Master

10.1 Configurations

The configurations provide the following general configuration settings.

10.1.1 General Configuration Areas

In the configurations you will find the following general areas.
Note:

e To be able to store objects from a different context, you must adjust the Restrict Shortcuts
Within Teamroom field in the configuration settings accordingly.

e The areas differ in “Customizing”.

Templates

This area shows the templates provided by the configuration. The templates are displayed in
the create dialog (e.g. “New" context menu command).

Defining Template Categories for Templates
In the “Create” dialog the templates can be filtered according to the template category.

To define a template category for templates, proceed as follows:
1. In the configuration, navigate in the “Templates” area.
2. C(lick the “Define Template Categories” action.

3. Inthe Template Categories field, enter the desired name for the template category and click
“Click here to create the entered template category”.

Fabasoft Cloud 103



4. Click "Define”.

The template category can be assigned in templates, on the “Template” tab, in the Template
Categories field.

Defining Templates

To define a new template, proceed as follows:

In the configuration, navigate in the “Templates” area.
Click the “New" action and then click the desired entry.
Define the name and click “Next".

Define the content or the metadata of the template.
Click “Properties” on the context menu of the template.
Switch to the “Template” tab.

N o vk~ wWwN =

Select an existing template category in the Template Categories field.
Note: If no template category is defined for a template, the template category “Teamroom
Templates” is assigned to the template in the “Create” dialog.

8. Click “Next".

9. Click “Release for Usage” on the context menu of the template.

Note: A template can only be used after it has been released for usage via the “Release for
Usage” context menu command. Changes must be released using the “Re-release” context
menu command. The release can also be withdrawn.

Text Modules

This area shows the text modules provided by the configuration that can be inserted into Word
documents.

Defining Text Module Categories for Text Modules

Text module categories define the categories under which the text module can be found when
it is inserted into a document.

To define a text module category for text modules, proceed as follows:
1. Inthe configuration, navigate in the “Text Modules” area.
Click the “Define Text Module Categories” action.

In the 7ext Module Categories field, enter the desired name for the text module category
and click “Click here to create the entered text module category”.

4, Click “Define”.

The text module category can be assigned in text modules in the 7ext Module Category field.
Defining Text Modules

To define a text module, proceed as follows:

1. In the contract manager configuration, navigate in the “Text Modules” area.

2. Click the “Create Text Module” action.

3. Select “Static Text Module (Text)"” or “Static Text Module (Word)” and click “Next".

4

Enter the desired name for the “Static Text Module” in the Name field.
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5. Inthe Text Module Categories field, select the desired text module category under which
the text module is to be made available for insertion into the Word document.

6. To make the text module available only for documents in a specific language, select this
language in the 7ext Module Language field.

7. When you create a static text module (text), you can enter the desired unformatted text in
the 7extfield.

Click “Next".

If you have selected a text module (Word), you can enter the required text using the “Edit”
or “Upload” context menu command.

10. Click “Release for Usage” on the context menu of the text module.
Note:

e Atext module can only be used after it has been released for usage via the “Release for
Usage” context menu command. Changes must be released via the “Re-release” context
menu command. The release can also be withdrawn.

e Text modules can be inserted into document templates both directly and as placeholders. If
a text module is inserted into a template as a placeholder, this placeholder is only replaced
by the content of the text module in question when the template is instantiated. on the
“Usage" tab, in the Expression for Further Restrictions of Usability field of the text module,
you can specify an expression that is evaluated when a template is instantiated to decide
whether a placeholder is to be replaced by the content of the text module or ignored and
removed.

e You can create a hierarchy of text module folders (“Create Text Module Folder” action) to
improve the structure of your text modules.

Forms and Categories

This area shows the forms and categories provided by the configuration. For example, custom
forms can be used to add fields to objects for storing customer-specific data. Categories can be
assigned to objects and thus influence the behavior of the objects.

For more information on defining forms and categories, see chapter 11.1 “Forms” and 11.2
“Categories”.

Processes

This area shows the processes provided by the configuration. Users, organizations,
organizational units and external organizations can be involved in the processing of business
objects via workflow by starting a process that can be processed in the worklist. Typical
processes are approval and release processes.

For more information on defining processes, see chapter 6 “Workflow".

Insight Apps

Insight apps provide aggregated access to information in your cloud organization, customized
to your needs. You can use insight apps to display and highlight important information without
users having to explicitly search for it.

More information can be found in chapter 5.5 “Insight Apps".
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Al Settings

This area shows the Al settings that have been made for the current context. For more
information about the Al settings, see here:

https://help.cloud.fabasoft.com/index.php?topic=doc/Administration-Help-Fabasoft-Cloud-
eng/artificial-intelligence.htm

Presettings

This area shows the presettings (view settings, search patterns, time intervals) provided by the
configuration.

App administrators can create search templates and time intervals. In addition, it is possible to
store view settings in the configuration via the “View” > “Display Settings” > “Save” menu
command of lists.

Thesauri

This area shows the thesauri provided by the configuration, which allow keywording.

Failed Background Tasks

This area shows failed background tasks (only visible if there is at least one failed background
task). You can perform following manual actions: “Define Next Execution”, “Send Link” and
“Delete”.

E-Mail Dispatch Errors

This area shows e-mail dispatch errors (only visible if there is at least one e-mail dispatch error).
You can perform following manual actions: “Send Test E-Mail", “Resend E-Mails” and “Delete”.

Note: E-mail dispatch errors are only logged if the Log £-Mail Dispatch Errors option is enabled
on the organization.

10.1.2 General Configuration Settings

You can define the following values in the configuration settings.
“General Settings” tab

e Name
The name of the configuration.

o Subject
A description of the configuration.

o Holiday Table
Defines the holiday table to be used in the configuration context (otherwise the default
holiday table is used).

e Restrict Shortcuts Within Teamroom
Defines which type of shortcuts may be stored in the configuration. You can restrict the
permitted shortcuts to objects that are assigned to the organization or to objects that are
assigned to the configuration.

e Restrict the Downloading or Opening of Content on the Device
Allows to restrict team members who can open or download content at the device.
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e Roles That Are Allowed to Open or Download Content on the Device
Defines which permissions a team member must have in order to open or download
content at the device.

o All Team Members May Add Members
Defines whether all team members can add users to the team or only team members with
“Full Control”.
Members with change access may grant or revoke change access or read access to other
members. Members with read access may grant or revoke read access to other members.

e Restrict Team Members
Defines the organizations, organizational units, teams and external organizations whose
members may be added to the configuration. If the list does not contain any entries,
members can be added without restriction.

e [£nable Advanced Mode
Advanced mode includes, for example, working with multiple shelves, as well as managing
templates and presettings.

o Main Administrator
Defines the user who will receive the automatically generated e-mail messages concerning
the configuration. Otherwise, all app administrators receive the e-mail messages. The user
is also listed as contact in case of missing permissions.

e Support Coordinator
The support coordinator team has access to all support requests in the corresponding
context and can perform the same actions as the support request initiators.

o Support Team
The support team handles the organization-internal management of support requests in
the respective context.

o Activate Trace Output
For example, as a form designer, when you use expressions for calculation or validation, it
can sometimes be difficult to identify errors in the expressions. To simplify analysis, you can
write trace output to the web browser console (cooobi.Trace ("string"); Or

cooobj.Trace ("string", wvalue) ;).
“Logos” tab

The defined logos and the background image are used for the configuration and for all
personal dashboards.

“Al Settings"” tab

The defined Al settings are evaluated for objects in the current context. For more information
about the Al settings, see here:

https://help.cloud.fabasoft.com/index.php?topic=doc/Administration-Help-Fabasoft-Cloud-
eng/artificial-intelligence.htm

“Default Values” tab

o Default Thesaurus for New Terms
If a default thesaurus is specified, new terms can be created directly during tagging.

o Default Categories
When an object is created, the specified category is assigned according to the defined
object class. In the Apply to field, you can specify whether the setting applies to instances,
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templates, or both.
Note: The default categories are also applied to shelves if they have been explicitly defined
for shelves. This also applies to Teamrooms and other rooms contained in shelves.

Default Processes

When an object is created, the specified process is assigned according to the defined object
class or category. In the Apply tofield, you can specify whether the setting applies to
instances, templates, or both.

Note: The default processes are also applied to shelves if they have been explicitly defined
for shelves. This also applies to Teamrooms and other rooms contained in shelves.

Default Background Tasks
When an object is created, the specified background tasks are assigned.

Release Process for Templates and Presettings

In order to use templates, text modules, forms and categories, processes and presettings,
they must be released. If a process is to be used for the release, a BPMN process diagram
can be defined here. Release processes must contain the “Release for Usage” activity.

“Content Settings” tab

Allow Comments
Defines whether PDF comments can be applied to documents.

Allowed Types for Comments
Defines the allowed types of comments (public or private).

Preferred Type for Comments
Defines the type of comment initially selected when commenting (overrides the setting in
the user's basic settings).

Users With Read Access Are Allowed to Comment Publicly
Defines whether users with read access are allowed to add public comments.

Allow Public Links
Defines whether public links may be published.

Generate Cover Sheet for PDF Overviews of Documents
Defines whether a cover sheet is generated for PDF overviews of documents.

Use Watermarks
Defines whether documents are automatically converted into protected PDF documents
with a definable watermark.

10.1.3 General Actions

Following general actions are available:

Translations

The “Translations” action can be used to export or import a CSV file containing the
multilingual names of the customizing objects of the configuration. This enables an external
translation.

For users with administrative rights it is possible to define special invitation texts via the
“Tools” > “Standard Texts for E-Mail Invitations” context menu command, regardless of the
invitation texts stored with the organization.

When inviting new users in the “Permissions” area, the invitation text defined for the
context is offered as a suggestion. The text defined in the configuration applies to
subordinate shelves if they do not define their own text.
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o The “Reset” button takes over the standard text of the organization.

o The “Delete” button removes the standard text from the configuration. This means that
the organization's currently valid standard text is offered again as a suggestion when
inviting new users.

10.2 Shelves

The shelves offer the following general settings. When evaluating the settings, the shelf
hierarchy is considered in addition to the configuration.

10.2.1 General Shelf Settings

You can define the following values in the clipboard settings.
“General Settings” tab

e Name
The name of the configuration.

e Subject
A description of the configuration.

o Holiday Table
Defines the holiday table to be used in the shelf context (otherwise the holiday table of the
configuration or the default holiday table is used).

e Restrict Shortcuts Within Teamroom
Defines which type of shortcuts may be stored in the shelf. You can restrict the permitted
shortcuts to objects that are assigned to the organization or to objects that are assigned to
the shelf. In this way, you can prevent, for example, that shortcuts are stored to which the
members of the shelf do not have access.

e Restrict the Downloading or Opening of Content on the Device
Allows to restrict team members who can open or download content at the device.

e Roles That Are Allowed to Open or Download Content on the Device
Defines which permissions a team member must have in order to open or download
content at the device.

o Team Members Visible to All Members
Defines whether all members are allowed to see the team members. Note that disabling
this setting also restricts other use cases.
Note: Team members with change access can be eventually seen by all members, since
changes are logged in log properties such as Last Change by.

o Only team members with “Full Control” have access to the “Permissions” action, can start
processes, duplicate objects, use templates and release templates and presettings.

o Only team members with “Full Control” see the events by default. The display of events
can also be enabled for team members who are not allowed to view the team. However,
only events that could not lead to conclusions about team members with read access will
be displayed.

o Team members with read access cannot use remarks, public comments, signatures,
processes or comment on news feeds.

o Team members with read access cannot use the time travel.

o Team members with read access cannot be selected as participants in processes.

Fabasoft Cloud 109



o Team members with read access cannot create public links.

o Team members with read access cannot view the “Processes” and “Activities” tabs of
assigned objects.

o Display Events for Tearm Members Who Are Not Allowed to View the Team
Only team members with “Full Control” see the events by default. The display of events can
also be enabled for team members who are not allowed to view the team. However, only
events that could not lead to conclusions about team members with read access will be
displayed.

o All Team Members May Add Members
Defines whether all team members can add users to the team or only team members with
“Full Control”.
Members with change access may grant or revoke change access or read access to other
members. Members with read access may grant or revoke read access to other members.

e Restrict Team Members
Defines the organizations, organizational units, teams and external organizations whose
members may be added to the shelf. If the list does not contain any entries, members can
be added without restriction.

e Main Administrator
Defines the user who will receive the automatically generated e-mail messages concerning
the shelf. Otherwise, all shelf administrators receive the e-mail messages. The user is also
listed as contact in case of missing permissions.

e Support Coordinator
The support coordinator team has access to all support requests in the corresponding
context and can perform the same actions as the support request initiators.

e Support Team
The support team handles the organization-internal management of support requests in
the respective context.

e Activate Trace Output
For example, as a form designer, when you use expressions for calculation or validation, it
can sometimes be difficult to identify errors in the expressions. To simplify analysis, you can
write trace output to the web browser console (cooobi.Trace ("string"); Or

cooobj.Trace ("string", wvalue) ;).
“Logos” tab
The defined logos are used for the shelf.
“Al Settings"” tab

The defined Al settings are evaluated for objects in the current context. For more information
about the Al settings, see here:

https://help.cloud.fabasoft.com/index.php?topic=doc/Administration-Help-Fabasoft-Cloud-
eng/artificial-intelligence.htm

“Default Values” tab

o Default Thesaurus for New Terms
If a default thesaurus is specified, new terms can be created directly during tagging.

e Default Categories
When an object is created, the specified category is assigned according to the defined
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object class. In the Apply tofield, you can specify whether the setting applies to instances,
templates, or both.

o Default Processes
When an object is created, the specified process is assigned according to the defined object
class or category. In the Apply tofield, you can specify whether the setting applies to
instances, templates, or both.

o Additional Default Background Tasks
When an object is created, the specified background tasks are assigned.

Note: The default properties overwrite or extend the settings in the configuration.
“Content Settings” tab

o Allow Comments
Defines whether PDF comments can be applied to documents.

o Allowed Types for Comments
Defines the allowed types of comments (public or private).

e Preferred Type for Comments
Defines the type of comment initially selected when commenting (overrides the setting in
the configuration or user's basic settings).

o Users With Read Access Are Allowed to Comment Publicly
Defines whether users with read access are allowed to add public comments (overrides the
setting in the configuration).

o Allow Public Links
Defines whether public links may be published.

e Generate Cover Sheet for PDF Overviews of Documents
Defines whether a cover sheet is generated for PDF overviews of documents.

o Use Watermarks
Defines whether documents are automatically converted into protected PDF documents
with a definable watermark.

Note: The content settings overwrite the settings in the configuration.

10.2.2 Templates and Presettings

Via the “Templates and Presettings” action, you can access the following areas.

Templates

This area shows the templates provided by the shelf. The templates are displayed in the create
dialog (e.g. “New"” context menu command).

Text Modules

This area shows the text modules provided by the shelf that can be inserted into Word
documents.

Forms and Categories

This area shows the forms and categories provided by the shelf. For example, custom forms
can be used to add fields to objects for storing customer-specific data. Categories can be
assigned to objects and thus influence the behavior of the objects.
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For more information on defining forms and categories, see chapter 11.1 “Forms” and 11.2
“Categories”.
Process Templates

This area shows the processes provided by the shelf. Users, organizations, organizational units
and external organizations can be involved in the processing of business objects via workflow
by starting a process that can be processed in the worklist. Typical processes are approval and
release processes.

For more information on defining processes, see chapter 6 “Workflow".

Insight Apps

Insight apps provide aggregated access to information in your cloud organization, customized
to your needs. You can use insight apps to display and highlight important information without
users having to explicitly search for it.

More information can be found in chapter 5.5 “Insight Apps".

Al Settings

This area shows the Al settings that have been made for the current context. For more
information about the Al settings, see here:

https://help.cloud.fabasoft.com/index.php?topic=doc/Administration-Help-Fabasoft-Cloud-
eng/artificial-intelligence.htm

Presettings

This area shows the presettings (view settings, search patterns, time intervals) provided by the
shelf.

App administrators can create search templates and time intervals. In addition, it is possible to
store view settings in the configuration via the “View" > “Display Settings” > “Save” menu
command of lists.

Thesauri
This area shows the thesauri provided by the shelf, which allow keywording.

For objects, corresponding terms can be selected directly in the 7erms field. Alternatively, the
“Choose Terms"” button allows a structured selection using the thesaurus hierarchies.

10.2.3 General Actions

Following general actions are available:

e For users with full control it is possible to define special invitation texts via the “Tools” >
“Standard Texts for E-Mail Invitations” context menu command, regardless of the invitation
texts stored with the organization.

When inviting new users in the “Permissions” area, the invitation text defined for the
context is offered as a suggestion. The text defined in the configuration applies to
subordinate shelves if they do not define their own text.

o The “Reset” button takes over the standard text of the configuration or organization (if
not defined for the configuration).
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o The “Delete” button removes the standard text from the shelf. This means that the
currently valid standard text of the configuration or organization is offered again as a
suggestion when inviting new users.

10.2.4 Unstructured Shelves

If you want to manage a large number of objects in a shelf, an unstructured shelf is a good
option, which allows each user to individually specify which objects are to be displayed using
search criteria.

Using the “Tools"” > “Display Entries in Flat List” context menu command, users with full control
can convert a shelf into an unstructured shelf. Note that in general this will delete all existing
folders.

The following options are now available to you:

e Search or Adapt Search
If no manual search criteria are currently defined, you can use the “Search” action to specify
what and with which search criteria you want to search. The result is displayed directly in
the shelf.

o If search criteria have already been defined, you can change them accordingly using the
“Adapt Search” action.

o To change what you want to search for, first execute the “Reset Search” action. This will
display the “Search” action again.

o The list is not updated automatically and can be customized manually. So, for example,
objects you have created will be displayed even if they do not match the current search
criteria.

e Refresh
Updates the list based on the current search criteria. This will undo any changes you have
made to the list (e.g. cut or move objects) and display objects that have been created in the
meantime and match the search criteria.

e Further Search Functions
The following additional search functions are available.

o Reset Search
Resets the current search criteria. An empty list is displayed.

o Save Search Form
If manual search criteria are defined, they can be saved for reuse.

o Load Search Form
Loads a saved search form. Only search forms that make sense in the context of the
shelf are offered. The entries in the list are updated accordingly.

Using the “Tools” > “Structure List Entries in Folders" context menu command, you can convert
an unstructured shelf back into a structured one. In doing so, in general the objects are stored
in folders.

Note:

e A maximum of 10000 objects will be returned as search result. When the maximum is
reached, a corresponding dialog is displayed.

e The origin of objects is the unstructured shelf.
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e “Open Origin” opens the unstructured shelf.
Note: The object is only possibly visible in the query-based list.

e Objects in query-based lists of the shelf have no link state (unless the object is assigned to
another shelf).

e Unstructured shelves do not have orphaned objects.

e Automatic change of shelf assignment is not applied. The shelf assignment can be done
manually using the corresponding context menu command.
Note: For structured shelves, the assignment is changed when an object is cut and located
in exactly one other shelf.

e Unstructured shelves cannot be converted into folders.
e Time travel is not available in unstructured shelves in the query-based list.

e Unstructured shelves cannot be kept up-to-date in the mobile app or in the Fabasoft Cloud
Folder.

11 Advanced Use Cases

You can create user-defined forms and process documents automatically.

11.1 Forms

With the graphical form editor you can create new forms with drag-and-drop and extend
objects with new properties without programming knowledge.

Either you can add a form to an existing object (shown in the properties of the object) or you
can create basic objects based on a form.

Note: You can only create, edit and release forms and categories if you are authorized in the
Edit Forms and Categories organizational policy. Explicit authorization is required as app.ducx
expressions can be created in the context of forms and categories.

Form Fields
You can use the following form fields on your form:
¢ Input Field
A single-valued field of a particular type (e.g. string, date or object).

e Item List
A list of fields of a particular type (e.g. string, date or object)

e Multiline Text
A multi-valued field of type plain text, code or HTML.

e Check Box
One or more check boxes (multiple selection is possible).

e Radio Buttons
One value can be selected from several values with radio buttons.

e Combo Box
One value can be selected from several values in a drop-down box.

e Standard Property
Provides the ability to display standard properties of objects on the user-defined form.
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Separator
Used to structure related properties.

HTML Text
Allows providing formatted descriptions on the form.

Types

You can define the following types for input fields and item lists:

String

Integer

Float

Date

Date and Time

Timespan

Numerator (only input fields)
Hyperlink

Password

Currency

Object
You must also define the type of objects allowed (for example, standard objects).
Compound Type

You must also select either a standard type or a type defined via a form. You can choose
between standard and chart display.

Note: If the form has already been released, the type of a field can only be changed to
compatible types (e.g. from string to hyperlink or password).

Additional Settings

Depending on the type, you can make further settings for form fields. In general, you can
specify:

“General” tab

Label

Mandatory field

Description (is displayed with the field as an additional description to the label)
Help text (is displayed as context-sensitive help)

Initialization value

“Advanced” tab

Programming name
Readability or changeability depending on user rights
Mask (string and integer)

Expressions for computing and validating
You are supported by syntax checking and auto-completion when entering an app.ducx
expression. You can find more information in the white paper ,Model-Base Customizing".
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“Display” tab
¢ Control (the used control, based on the field type, is displayed read-only)
e Compute Control Styles
¢ Compute Control Options
o Display in New Row (if disabled, the field will be displayed next to the previous field)
¢ Field Width (in percent in relation to the other fields in a row)

Trace output

When you use expressions for calculation or validation, it can sometimes be difficult to identify
errors in the expressions. To simplify analysis, you can write trace output to the web browser
console. To do this, you must go to the context menu of the Teamroom where the form is used,
choose “Tools"” > “Activate Trace Outputs” and allow trace output.

Call in expressions:
e cooobj.Trace("string");
e cooobj.Trace ("string", value);
Output:
The output is a JSON data record.
o C
Context of the call (Teamroom).

e d
Current time.

e S
Section of the expression (if available).

o
The text to be traced (first parameter of the trace call).

e U
Current user.

Y,
The value to be traced (second parameter of the trace call).

11.1.1 Creating a Form

Forms can be used in the context in which they are defined or referenced. To make forms
generally available for Teamrooms (but not for app rooms), use a form and category collection
in “Customizing”. Otherwise, forms can be stored in app configurations (“Forms and Categories”
widget), in app rooms (“Templates and Presettings” action > “Forms and Categories” widget) or
in Teamrooms (“Templates and Presettings” action > “Forms and Categories” widget).

To create a form, proceed as follows:

1. Navigate in the “Forms and Categories” widget in the desired context.
2. Click the “Create Form" action.
Define the initial data of the form and click “Next".

o Enter a multilingual name.
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o Define a base form, if you want to take over tabs and fields of another form.
Note: The base form property can only be changed when the form is not released for
usage.
Template categories (component objects) can also be used as base forms. When
template categories of installed software components change, the forms based on them
are marked as “Changed After Release”. These forms must be re-released to apply the
changes.

o Define the incoming category for registration, if you want to register objects based on
the form in a specific way.
Note: When using the “Category for Generic Registration With Form”, only the user-
defined form is displayed without default tabs during registration.

o Define the base class to specify which objects the form is basically suitable for. If the
form is used directly as a template, the template will have the corresponding object
class.

» Object With User Data
Can be used for base objects, objects with object list and documents.

= Document With User Data
Can be used for documents.
Note: If the form is used directly as a template, a content (“Content” tab) can be saved.

= Container With User Data
Can be used for objects with object list.
Note: You can additionally specify whether it is a file. For the subordinate objects, the
reference to the file is saved. This makes it possible, for example, that the properties
of the file are also available as fields in Microsoft Word. In addition, file-typical actions
such as “Replace”, “Close”, “Cancel”, “Restore” and “Scan” are automatically available.

» Room With User Data
Can be used for rooms.
Note: If the form is used directly as a template, roles analogous to a Teamroom are
available.

o If you specify a symbol, it will be displayed instead of the object class symbol for objects
that have the form assigned.

o Abstract forms cannot be used directly but serve as base forms.

o Check Suppress Template Creation, if you want to prevent that objects based on the
form can be directly created. In this case, the form can only be assigned to existing
objects (using the form category).

4. Arrange the desired fields with drag-and-drop.
5. Click “Next".

6. Inthe context menu of the form, click “Release for Usage”.
Note:

e To use a form, on the one hand the users must be authorized in the corresponding room
and on the other hand the form must be released for usage.

e Changes can be released using the “Re-Release” context menu command.
e You can withdraw the release with the “Withdraw Release” context menu command.

e You can export a form as JSON file with the “Download” action. The import takes place via
the “Upload” action.
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e An existing, currently not released category can be converted into a form (“Tools” >
“Convert to Form” context menu command). Thus, no migration is necessary if the category
is to be extended by user-defined fields.

Backward Linking

For an input field or an item list of type “Object” (type of content: forms), a backward linking
with another input field or item list of type “Object” can be defined. In the case of backward
linking, the other object is automatically referenced in the object entered in the field.

Note: The field or fields for backward linking can be located either on one form or on two
forms.

To define a backward linking with only one form involved, proceed as follows:

Create the form.

Define an input field or an item list of type “Object”.

Select “Forms” as type of content.

Define the form you have just created as the default form for objects in the field.

If the backward linking is to refer to a second field, define a corresponding second field.

Apply the changes so that you can define the link.

N o vk~ wWwN =

Edit the first field again. In the Link to Fieldfield, which is now available, you can define the
field for backward linking.

8. Apply the changes.
To define a backward linking with two forms involved, proceed as follows:

Create the first form.

Define an input field or an item list of type “Object”.

Select “Forms” as type of content.

Define the form you have just created as the default form for objects in the field.

Apply the changes.

o A~ wN =

Create the second form in the same way as the first form, but select the first form as the
default form for objects in the field.

7. Edit the field in the first form again.

8. Define the second form as the standard form for objects in the field.

9. Define the field for the backward linking of the second form in the Link to Field field.
10. Apply the changes.

Note: You must release both forms for usage at the same time.

Example

The following example shows in particular the possibility of using expressions in forms. The
amount of each installment is to be calculated based on a total amount and a payment
frequency.

Create a form (“Object With User Data” base class) with following three properties:
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o Total Amount (input field)
Type: Currency
Programming Name: totalpayment
e Payment Frequency (radio buttons)
Options: Monthly (ID: 1), Quarterly (ID: 2), Semi-Annual (ID: 3), Annual (ID: 4); The ID is
determined by the order of the options.
Programming Name: payment frequency

o /nstallment (input field)
Type: Currency
Programming Name: installment

To calculate the installment dynamically, you must define expressions for the fields:

o For the Total Amountand Payment Frequencyfield enable the Handle Changes of Values
option and enter true as expression. This means that if you change the values, the
installment value is updated directly.

o For the /nstallmentfield enable the Compute Value of Field option and enter the following

expression:
Calculating Value
Currency @installment = cooobj.totalpayment;

if (Q@installment.currvalue) {
// switch based on the ID of paymentfrequency
switch (cooobj.paymentfrequency) {
case 1:
@installment /= 12;
break;
case 2:
@installment /= 4;
break;
case 3:
@installment /= 2;
break;
}
}

@installment;

11.1.2 Downloading and Uploading Forms

You can download forms as JSON files and upload them again. The following options are
available to you:

Download

e To download a form, execute the “Download” action or context menu command. The form
is downloaded as a JSON file. If other forms are referenced in the form (e.g. a basic form),
these forms are not included in the JSON file.

e To download several forms at the same time, select them and execute the “Download”
context menu command. The forms are downloaded together as JSON files in a ZIP file.
Note: You can also include structuring folders, whereby also all subordinate structuring
folders and forms are considered. The structuring is adopted accordingly when uploading.

¢ When downloading, the translations, the incoming category for registration, the symbol, the
retention settings and the default background tasks are also considered.
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e To be able to download forms, you need at least read rights and you must be authorized by
the “Edit Forms and Categories” organizational policy.

Download Fully

e To download a form fully including the dependent forms, execute the “Download Fully”
action or the context menu command. The form and the dependent forms are downloaded
together as JSON files in a ZIP file. If there are no dependent forms, the form is downloaded
as JSON file.

¢ If you do not have read access to a dependent form or the dependent form is in the
wastebasket, a corresponding message is displayed. You can still download the form
without the affected dependent forms. Please note, however, that the form will not work as
desired if you upload it in another installation in which the dependent forms concerned are
not available in the desired version.

Upload

e To upload a form directly to an existing form, execute the “Upload” action or context menu
command on the existing form and select a JSON file.

e To upload a form in a list, execute the “Upload” action and select a JSON file.
o If no form with the key in the JSON file exists, a new form is created and stored in the list.

o If a form with the key in the JSON file already exists, it is updated, regardless of whether
the form is in the current list. If the form is not in the current list, a shortcut is inserted,
too.

e To upload multiple forms in a list, execute the “Upload” action and select a ZIP file with the
forms.

e The drag-and-drop import and the importviactrl + candctrl + v of formsis not
possible. Instead, use the “Upload” action.

e When uploading, you can decide whether the incoming category for registration, the
retention settings and the default background tasks should also be considered. If so, the
settings (including empty values) of the JSON file are applied. If not, the settings will not be
applied and the currently existing settings will be retained when updating.

¢ If you upload several forms in a ZIP file, you will first receive an overview of all the forms
contained. Deselect the forms that you do not want to upload.

o Create Selected Forms
Shows the forms that can be newly created.

o Update Selected Forms
Shows existing forms that can be updated.

o Non-Updatable Forms
Shows the forms that you cannot update due to the lack of change rights or because the
forms are in the wastebasket.
If you select the Create Non-Updatable Forms With a New Key option, new forms are
created for existing forms to which you have no rights or which are in the wastebasket.
It is recommended that you do not continue and first request the rights to the listed
forms or restore them from the wastebasket.

e A check of the uploaded forms is carried out and the result is displayed in an overview.
Attention: It is strongly advised not to continue with errors. If you continue, you must fix
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the problems manually before you release the forms for usage. Otherwise you may risk
losing data.

¢ The errors are stored on the “Advanced” tab in the “Import Errors” field of the form for
traceability.

Keys

Forms that were created before the 2025 March Release and have not been edited or
downloaded since then do not have a key for unique identification. This also applies to JSON
files that were downloaded before the 2025 March Release.

The keys can be found on the “General” tab of the forms and form elements.

The keys are essential for identifying the forms and form elements and prevent potential errors
and data loss. The following procedure is therefore strongly recommended:

e If you have JSON files without keys (downloaded before the 2025 March Release), replace
them by re-downloading the forms from the production environment.
Note: JSON files without keys can still be uploaded, but correct identification of the fields
when updating forms cannot be guaranteed (may result in data loss).

o If you are using a test system for form creation, make sure that it has at least the 2025
March Release.

¢ If you have developed forms in a test system, discard them. Download the forms from the
production system and upload them to the test system. This creates a unique link between
the forms. You can then further develop the forms in the test system and upload and
update them in the production system.
Note: If the forms from a test system have never been transferred to the production
system, you can download them and upload them to the production system. This also
creates a unique link between the forms.

¢ Alternatively, a form from a production system can be linked to an existing form in a test
system by executing the “Upload (Migration)” context menu command once (only available
in test systems). Any existing keys for the form in the test system will be ignored and the
keys from the JSON file will be adopted. An attempt will be made to update existing fields,
but correct identification cannot be guaranteed (may result in data loss). Therefore, use the
method described in the previous point whenever possible.

Common Error Messages

o Field "<field name>" ("<property>"): The object with the key "<ID>" could not be found.
The specified user-defined field references an object in the specified property that does not
exist in the system. If you continue, you will lose the entry for the non-existent object.

e The form "<form name>" with the key "<ID>" is replaced by the form "<form name>"
with the key "<ID>".
You are trying to upload a form directly into an existing form, but the forms do not match.
Make sure that you select the JSON file that belongs to the form.

e The key "<ID>" is already used for <object type> "<object name>" (<Fabasoft Cloud ID>).
A new key is generated.
An object with the specified key already exists in another form. A new key is generated to
ensure that the keys are unique. You lose the connection to the original object.

e The backlink between the fields “<field name>" and “<field name>" has been removed.
The property will be cleared.
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The backlink has been changed and cannot be corrected in one step. You have to define the
backlink manually.
Note: If the form was already released, you must first release the form without backlink
changes. Subsequently, you can define the desired backlink manually and release the form
again.

¢ The key “<ID>" for the field “<field name>" is ignored because the uploaded form itself
has no key.
The problem only occurs if the JSON file has been modified. If no key is defined for the form
itself, all other keys are ignored.

e The field “<field name>" has no key and is therefore ignored.
The problem only occurs if the JSON file has been modified. If a key is defined in the form
itself, all other form elements are also identified by a key. Form elements without a key are
ignored.

11.1.3 Metadata of a Form

You can also make the following settings in the properties of a form.
“Advanced” tab

o Available Processing States
You can define processing states that can be selected in the Processing State standard field.

o Name Build Configuration
You can specify a name build for the names of objects based on the form.

e Prepare Commit Configuration
You can define an app.ducx expression that is executed as part of the prepare commit.

e Applicable for
You can specify the object classes for which the form can be used.

“Retention” tab

You can specify whether objects based on the form are retention worthy. This tab displays the
Category (Draft) retention properties. When the form is published, the settings are applied to
the Category (Published).

“Translations” tab

For the languages available in the Fabasoft Cloud, you can provide translations for the names
(labels), descriptions and context-sensitive help. For each multilingual name of the form, you
will find a corresponding entry. In order to define the translation for the description or help text
open the details dialog (e.g., by clicking on the line number). The multilingual text for fields of
type HTML Texthas to be entered in Help Text.

11.1.4 Form Template

In the form's properties on the “Form"” tab, you will find the corresponding templates. You can
use the templates to create objects directly based on the form. If you want to prevent this,
choose Suppress Template Creation and publish the form again.

e Generated Default Template
If you do not define your own template, the default template is used to generate the
template and published template, which are used when creating objects based on the form.
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e Template (Draft)
You can define your own template (e.g. a Word document with default content), which is
used when creating objects based on the form.

e Template (Published)
When releasing a form for usage the Template (Published)is generated from the Template
(Draft).

11.1.5 Form Category

In the form's properties on the “Form” tab, you will find the corresponding Category
(Published).

The category can be used for the following use cases:

¢ Adding a form to an object
¢ Defining the registration behavior
¢ Defining the applicability
o Defining retention worthiness
¢ Defining background tasks
¢ Defining permissions
Note: The settings of the Category (Draft) are applied to the Category (Published)when the

form is published.

Adding a Form to an Object

Not only basic objects that are based on a form can be created but it is also possible to extend
existing objects with a form. This is particularly useful for templates.

To add a form to an object, proceed as follows:

1. Navigate in the desired object.
Click the “Properties” action.

In the Categoryfield (typically on the “General” tab), select the desired category. The
category name corresponds to the form name.

4. Click “Next".

The form is displayed in the properties of the object. When you define the object as a template,
the form is available with each newly created object that is based on the template.

Further Use Cases

A description of the further use cases of a form category can be found in chapter 11.2
“Categories”.

11.1.6 Defining and Using a Compound Type

Forms can also be used to define compound types, which in turn can be used in other forms as
types for input fields or element lists.

Defining a Compound Type

To define a compound type, proceed as follows:
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El

6.

Navigate in the desired Teamroom.

Open the context menu in an empty part of the content area and click “New".
In the “All" category, select the “Form” entry.

Define the initial data of the form and click “Next".

o Enter a multilingual name.

o Define “Compound Type"” as base class.

Arrange the desired fields with drag-and-drop.
Note: Compared to a standard form, the selectable fields and settings are reduced
accordingly.

Click “Next".

Note:

¢ The following additional settings can be made on the "Advanced" tab in the form

properties:
o Key for Unique Lists

Defines the properties that are used as keys for unique aggregate lists.
o Key for Sorting Lists

Defines the properties that are used as keys for sorting aggregate lists.
o Simple View of Properties

Defines the properties that are displayed in the simple representation of an aggregate
list (for example, in the property editor).

e The form is now available as a draft. Publish the form for general use.

Using a Compound Type

To use the compound type, proceed as follows:

AT S

Create a new form or open an existing form.

Define an input field or an element list and select “Compound Type” as type.
Select "Forms" as the type of content.

In the Compound Type User Form field, select the previously defined type.

In the Compound Type Display Mode field, select “Standard” or “Chart”. If you choose
“Standard”, the field values of the aggregate are displayed. If you choose “Chart”, a
Highchart diagram based on the aggregate data is displayed. However, the aggregate must
have a certain structure according to the diagram type. The chart type (line chart by default)
is defined on the “Display” tab in the Expression for Calculating the Control Options field.
Example: dictionary ({ chart: { type: "bar" } });

For more information see:

https://api.highcharts.com/highcharts/

Click "Next" twice to complete the editing.

11.2 Categories

Categories can be assigned to objects (“General” tab) and thus influence the behavior of the
objects.

Categories can be used for the following use cases:
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¢ Defining the registration behavior
¢ Defining default follow-ups

¢ Defining the applicability

e Defining retention worthiness

¢ Defining background tasks

e Defining permissions

User-defined categories can be used in the context in which they are defined or referenced. To
make categories generally available for Teamrooms (but not for app rooms), use a form and
category collection in “Customizing”. Otherwise, categories can be stored in app configurations
(“Forms and Categories” widget), in app rooms (“Templates and Presettings” action > “Forms
and Categories” widget) or in Teamrooms (“Templates and Presettings” action > “Forms and
Categories” widget).

The “Change Assignment” context menu command can be used to change the context of the
category.

Note: You can only create, edit and release forms and categories if you are authorized in the
Edit Forms and Categories organizational policy. Explicit authorization is required as app.ducx
expressions can be created in the context of forms and categories.

Defining the Registration Behavior

By default, the “Register as” context menu command provides all possible registration targets. If
the registration target is well-known, it can be restricted to improve the usability (/ncoming
Category for Registration field).

Defining Default Follow-Ups

To receive a reminder at a specific time, follow-ups can be used (Default Follow-Ups field). You
can find more information on follow-ups in chapter 12.14 “Follow-Ups".

Defining the Applicability

Not every category make sense for every object class. Thus, the object classes for which the
categories are allowed can be restricted (Applicable forfield). In addition, if you want to use
special base dates for follow-ups or retention periods a restriction to the object classes that
provide the desired properties is needed.

If you want to restrict a BPMN process to a category and use activities that are allowed only for
a certain object class, you can define the category accordingly (only the corresponding object
class must be entered).

Defining Retention Worthiness

Compliance rules may enforce that objects must not be deleted for a defined time period
(“Retention” tab).

In the properties of the category, on the “Retention” tab you can define whether objects with
this category are retention worthy. In addition, define a Retention Period and a Base Date for
the Beginning of the Retention Period. The calculation of the concrete retention period is
carried out via a background task, which must be defined on the “Background Tasks” tab.
Note: Alternatively, you can also use the “Create/Edit Background Task” button on the
“Retention” tab.
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In the background task, select the “Determine Retention Period Based on the Category” action.
In addition, determine the date when the background task should run. In general, it makes
sense to use the Base Date for the Beginning of the Retention Period as Base Date for the time
interval and, for example, “Immediately” as time interval.

For disposal, you can define another background task in the category. In general, it makes
sense to define the Retention Period as base date for the execution of the task. As action, you
can either select “Delete Automatically” or “Start Process”. If you want to start a process, you
must also specify the process. In the process, a task with the activity “Retention Period
Exceeded” should be defined.

When the background task is executed, the process is started and can be processed by the
defined users in the worklist. The “Retention Period Exceeded” activity provides the steps
“Delete”, “Extend Retention Period” and “Accept”.

Defining Background Tasks
Background tasks allow you to perform actions at a specific time (“Background Tasks” tab).

More information can be found in chapter 11.3 “Background Tasks".

Defining Permissions

In general, the defined team can access the Teamroom and its contents. Access to individual
objects can also be granted via a category (“Permissions” tab).

Note: In order that the access rights granted via categories are evaluated, the entry “Extended
by category” or “Extended by category and workflow” must be selected in the Access Protection
field of the Teamroom.

11.3 Background Tasks

For categories, background tasks can be stored that execute an action at a definable point in
time.

Actions
Possible actions (extendable by apps):

e Determine Retention Period Based on the Category

e Determine Retention Period Based on the Category and Close (File and Documents)

Execute Expression (App: Forms)
Only available if the user is allowed to create user-defined forms.

Delete Automatically

Anonymize Object
By default, the following data is removed (for special objects, such as support requests or
tickets, additional fields are considered):

o History
o Remarks

o References (referenced objects are deleted if the object is the origin, otherwise objects
are removed)

o Processes (the processes must be completed, otherwise the background task will fail)
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o Versions

e Start Process (App: Workflow)
Note: The background tasks of objects are displayed on the “Background Tasks" tab. Whether
background tasks that have already been processed are displayed depends on the action. You
can override the default setting of the action using the Remove Processed Entries From the List
of Background Tasks field.
Pointin Time
The action can be executed at an explicit time or at a time based on a base date. Optionally, the
execution date can be redefined if the base date is changed.
Repetition
It is also possible to repeat background tasks. The following cases can be distinguished.
Explicit date or date is not recalculated when the base date is changed

You can define a repetition rule that is applied starting with the execution time.

e Unit
Defines the unit of the interval (e.g. day or month).

e Interval
Defines the interval between the repetitions (number).

e Repeat Until
Defines the end time of the repetitions (infinite, explicit date, date value of a property).

Date is recalculated when the base date is changed

The background task is rescheduled after the selected action is executed and the base date is
changed. Only Repeat Until can be defined as a repetition rule.

Suspend Background Task When Deleting

You can define whether the background task is automatically suspended when the affected
object is deleted or canceled and again activated when the object is restored.

11.4 Inbox
In an inbox, rules for the processing of incoming objects can be defined. A rule consists of
conditions and actions.

You can create an inbox in your personal folder (background context menu > “New” > “Inbox").
As for Teamrooms, you can also set a team for inboxes to define the access rights.

Note: You can only create and edit inbox rules if you are authorized in the Manage Inbox Rules
organizational policy. Explicit authorization is required as app.ducx expressions can be created
in the context of inbox rules.

To define rules for an inbox, proceed as follows:

1. Navigate in the desired inbox.
2. Click the “"Manage Rules” action.

Specify whether the rules are to be applied to top-level objects only. If so, the rules are
applied to all objects (including folders) at the top level. Otherwise, the rules are applied to
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all objects (also in folder hierarchies), but not to the folders themselves, since in this case
they are only used for structuring.

Open the “Rule” menu and click “New".

Enter a name for the rule.

Set the conditions for the rule. A condition checks whether the selected property contains
the defined string (case-insensitive). Specify the string without wildcards. If you select the
“Condition as Expression” entry, you can define an app.ducx expression as a condition. All
conditions must be met for the rule to run. Do not specify a condition if the rule should
always be executed.

Specify the actions to be executed.

(¢]

Execute User Defined Expression

Allows defining an app.ducx expression that will be executed. In the app.ducx
expression, you can use cooobj to access the object. You are supported by syntax
checking and auto-completion.

Import Data (Asynchronous)

The content of the incoming CSV file is imported. To do so, the target for the import and
the type of import (e.g. members or organizational structure) must be specified. You can
download templates for the CSV files via the respective manual actions (e.g. “Import
Members” action of an organization).

Extract E-Mail Attachments (Asynchronous)
The attachments are extracted from an e-mail and stored as separate objects for further
processing in the inbox. The e-mail can be kept, moved or deleted.

Define Property Value
Avalue is assigned to a property of the incoming object.

Assign Category
The specified category is assigned to the incoming object.

Classify With Mindbreeze Al
The incoming objects are classified. Based on the classification, a category is assigned to
the object.

OCR Text Recognition (Asynchronous)

For documents that can be converted to PDF, text recognition can be performed.
Note: Only objects are considered for which no text recognition has been performed
since the last content change.

Start Process
The specified process is started on the incoming object.

Assign (Asynchronous)

The incoming document can be assigned based on QR code or PDF keywords. By default,
the Fabasoft Cloud ID (e.g. COO. 1.506.4.4063) of the document whose content is to be
replaced by the incoming document must be stored in the QR code or PDF keywords.
The assignment is performed asynchronously at regular intervals.

» (Close Document
Defines whether the status of the document is set to “Closed” by default. Closed
documents can no longer be changed as long as the status is not removed.
However, the type of assignment and closing can be influenced by an incoming
category of the incoming document.
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= (Continue Process on Object
Defines whether an existing process is to be continued on the target object after
assignment.

= (Continue Process on File of Object
Defines whether an existing process is to be continued on the file of the target object
after assignment.

= Activities to Be Continued Automatically
If a process is to be continued, it is also possible to define activities that are
automatically continued. These activities automatically get the status “Not Executed".
If an activity to be automatically continued currently has the status “Startable” or
“Started”, this activity is set to “Not Executed”. Other activities with the same activity
definition will not be automatically continued in this case.

= Start New Process on Object
Defines whether a new process is to be started on the target object after assignment.
For this purpose, you can specify the desired BPMN process.

= Start New Process on File of Object
Defines whether a new process is to be started on the file of the target object after
assignment. For this purpose, you can specify the desired BPMN process.

= Target for Unassignable Documents
For non-assignable objects, you can define a folder as the target.

8. Click “Next".

9. You can define additional rules, or complete the processing with "Save".

For an object placed in the inbox, the rules are checked according to the order. If all conditions
of a rule apply to an incoming object or no condition has been defined, the defined actions are
executed on the object. Only the first applicable rule is executed.

Note:

e The organization of the placed objects must correspond to the organization of the inbox for
the rules to be applied.

e To be able to define the rules, you must be authorized in the Manage Inbox Rules
organizational policy.

11.5 Classifying and Registering

The Fabasoft Cloud in conjunction with Mindbreeze Al allows you to automatically classify
documents and extract metadata. Especially when interacting with custom forms, you have a
powerful concept for the incoming classification of documents for your particular application.

The following steps explain the basic operation:

1. In alearning phase, Mindbreeze Al is trained to classify the documents. For the extraction
of the metadata from documents, regular expressions can be defined.

2. In productive mode, when classifying documents (either manually or automatically
triggered), the metadata and classification are requested from the Al service. Feedback can
further improve the quality of the classification.

3. For the classification value, a category with a corresponding import ID is searched and
assigned to the document.
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4, The category can be used to start a specific registration or to initialize a process. If
metadata can be retrieved from the document, the data will be prefilled and highlighted in
color.

11.5.1 Prerequisites

The classification requires a Al service, which can be configured by the organization
administrator (for more information, see the administration help).

11.5.2 Using Categories

The classification value calculated by Mindbreeze Al is used to determine a category based on
the /mport /D of the category. The following processing can be defined via the category:

o type of registration
e standard process
e retention rules

Categories are used in the context of different apps and can be created or managed there (e.g.
custom forms).

11.5.3 Using Forms

User-defined forms (see chapter 11.1 “Forms”) can be taken into account during classification.
The corresponding Category (Published)is displayed in the properties of the form. Define in the
properties of the category classification value as /mport /D, which is returned by Mindbreeze Al
for the corresponding type of documents. This way the registration is based on the form.

The metadata extracted during classifying is applied to the corresponding fields when
registering.

Note: If the programming names of the user-defined fields do not match the Mindbreeze Al
keys, your organization administrator must enter the corresponding mapping in the Al service.

11.5.4 Inbox

Documents can be classified automatically via the inbox. To do so, you can define a rule that
performs the “Classify With Mindbreeze Al” action (see also chapter 11.4 “Inbox").

11.5.5 Workflow

When using the “Register” activity, documents can be classified and registered via the workflow.
You can start an ad-hoc process with the prescribed activity “Register”. In a predefined BPMN
process, the activity can also be used (the usability has to be restricted to documents).

The following steps can be performed via the activity. Only appropriate work steps are offered
in the respective context.

e Open
Opens the document.

o Classify and register
Classifies the document with Mindbreeze Al and opens the appropriate registration form.
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e Registering
Opens the registration form.

e Do notregister
Removes the activity from the worklist without performing a registration.

11.5.6 Register

When you register a document, you can capture metadata of the document in a split view (on
the left the metadata, on the right the document). If necessary, the document is also assigned
(e.g. to afile).

Register (generic)

The generic registration is available if no category could be determined by the classification. In
this case, you can capture metadata in a split view.

Register as (incoming category)

An incoming category determines the registration and assignment of the document. The
incoming category can be assigned directly to a document or to a category that is assigned to a
document. If no category is assigned to a document, the incoming categories of the licensed
apps are also considered.

Register as (form)

When a form category is assigned to a document, the user-defined metadata can also be
entered in a split view.

11.6 Form Inbox

The form inbox allows you to capture data using an HTML form and store it in the Fabasoft
Cloud. You may also use an Inbox room as an alternative to a “Form Inbox”.

To create a form inbox and receive the identification of the form inbox, proceed as follows:

1. Navigate in the desired Teamroom.

2. Open the context menu of an empty part of the content area and click “New".

3. Inthe “Tools” category, select the “Form Inbox” entry.

4. Enter a name and click “Next".

5. In the context menu of the form inbox, click “Properties”.

6. On the “Form Inbox” tab in the /Dfield, you can find the unique ID of the form inbox. Copy
the ID to use it further on in the HTML form.

7. Click “Next".

As an alternative to a “Form-Inbox” you can also create an “Inbox” room. In that case you have
to use the Fabasoft Cloud ID as identifier for this Inbox room.

To define a corresponding HTML form on a page of your web site, proceed as follows:

1. Create an HTML form on a page of your web site.
2. Define the following attributes of the HTML form:
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Attribute: action

Value: https://at.cloud.fabasoft.com/foliop/createobject

Note: Change the host in the URL to de.cloud. fabasoft.com if your form inbox is
located in Germany or to ch.cloud. fabasoft.com in Switzerland.

Attribute: method
Value: post

Attribute: accept-charset
Value: urr-8

Attribute: enctype
Value: multipart/form-data

3. Define a hidden field named objectclass and specify the Fabasoft Cloud ID or the full
reference of the object class from which an instance is to be created in the form inbox
when the HTML form is submitted. For example, you can use the following object classes:

o

(@]

(@]

Folder: COODESK@1.1:Folder

PDF Document: FSCACROBATR1 .1 :PDFObject

Microsoft Word Document: COOMSOFFICEQL.1:WinWordObject

Microsoft Excel Worksheet: cOoOMSOFFICERL.1:ExcelObject

Microsoft PowerPoint Presentation: COOMSOFFICER1.1:PowerPointObject
Generic Content: GENCONT@1.1:ContentObject

Object with Form Data: FSCUSERFORMS@1.1001:0bjectWithUserForm OF

FSCUSERFORMS@1.1001:DocumentWithUserForm Or
FSCUSERFORMS@1.1001:ContainerWithUserForm

4, As an alternative to the objectclass field, you can define a hidden field named
objecttemplate, in which you store the Fabasoft Cloud ID of an object (e.g. a template) that
is to be copied when the HTML form is submitted.

5. Define another hidden field named inbox and set its value to the /D field of the form inbox
(or the Fabasoft Cloud /D for an Inbox room).

6. If necessary, define additional fields.

You can specify the following fields in the HTML form (unless otherwise specified, the fields are
optional):

Field in HTML Form  Description

objectclass Required field (as long as objecttemplate is Not used): Defines the

Fabasoft Cloud ID or full reference of the object class from which an
instance is to be created in the form inbox after the HTML form is
transferred.

objecttemplate Only evaluated if objectclass does not exist. Defines the Fabasoft

Cloud ID of an object that is to be copied after submitting the HTML
form. The user "Form Poster Fabasoft Cloud" must have the right to
read and copy this object (and dependent objects). Moreover the
template must belong to the same cloud organization as the form inbox
object. A template must be either a Document (Contentobiect), an
Object With Object List(Compoundobiject) or a Basic Object
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(BasicObject).

inbox

Required field: Defines the /D of the form inbox. Alternatively, the
Fabasoft Cloud ID of the form inbox can be used.

redirect

Required field: Defines the URL the submitter is redirected to after
submitting the HTML form. The URL has to be defined absolutely
including protocol and host. Protocol and host must match the URL of
the page on which the form is embedded.

errorredirect

Defines the URL the submitter is redirected to in case of a processing
error. If this parameter is omitted, the user will be redirected to the
page defined by redirect. The URL has to be defined absolutely
including protocol and host. Protocol and host must match the URL of
the page on which the form is embedded.

The error code and an error description are provided in the errorcode
and error parameters.

redirecttype

Defines how the redirect should be executed. Valid values are "302",
"303", "307", all other values will be ignored. By default, the redirect is
executed in the web browser by script or meta tag http-
equiv="REFRESH". If this form field is set the redirect is initiated on the
server by responding with the appropriate http status code and the URL
in the http header "Location".

objname

Defines the name of the created object.

objsubject

Defines the subject of the created object.

objcategory

Defines the category of the created object.

If an objcategory is specified, fields that are assigned to the category
can also be submitted as HTML fields. The Programming Name of the
category fields must match the name of the respective HTML fields. The
category must be usable for the created object (e.g. check property
“Applicable for"). Categories created by a user form can only be used if
they belong to the same cloud organization as the form inbox.

content

Allows uploading a file, which is then stored in the Fi/efield of the
generated object.

This is only possible if the File property is assigned to the object class
specified as objectclass. The relevant HTML field must be of type file.
When saving, the system does not check whether the file extension of
the uploaded file matches the data type of the object class. You can use
the accept attribute in the input field to restrict the selection to specific
file types. Only one file can be uploaded via this field.

attachmentkeys

Defines the names of the HTML fields (separated by a comma) for
submitting additional files.

For the uploaded files, documents are instantiated in the Fabasoft
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Cloud, which are then stored in the property specified in the
attachmentattrdef field of the instance of objectclass. The specified
HTML fields must be of type file. If a value is specified in the
attachmentkeys field, it is also necessary to provide a value for
attachmentattrdef. The object class of the objects created for the
uploaded files is determined by the file extension of the uploaded files.
The file names are used as names for the created documents.

attachmentattrdef |pefines the Fabasoft Cloud ID or the full reference of the property, in
which additional uploaded documents are stored.

If a value is specified in the field attachmentattrdef, you also have to
provide the attachmentkeys. For object class Fo/der(coopESK@1.1:
Folder), provide the COOSYSTEM@1.1:objchildren property.

<Reference/Fabasoft|ygoy may also set other properties that a user can change in the

Cloud ID of other . . h . id ified by their full ref

propertiess properties editor. These properties are identified by their full reference
or their Fabasoft Cloud ID (e.g. COOSYSTEM@1.1:objexternalkey).

Note:

e You can find the Fabasoft Cloud /D on the “General” tab in the Properties dialog of the
corresponding object. To identify object classes and properties, you can use the full
reference as well as the Fabasoft Cloud ID. You can determine the reference of properties
by pressing the key combination ctrl + shift + # inthe “Properties” dialog.

e New objects will be created by the user “Form Poster Fabasoft Cloud”. This user will need
change access to the Form-Inbox object or the Inbox room, respectively. When creating a
Form-Inbox within a Teamroom access for this user is granted automatically. However, if
you use an Inbox room you have to add this user explicitly to the team of this room. Just
search for a user with e-mail-address “formposter@fabasoft.com”.

e If a duplicate of an object is to be created (objecttemplate), the user "Form Poster Fabasoft
Cloud" must also have the right to duplicate the object. If referenced objects are to be
accessed (e.g. categories or text modules), the user must also have the necessary access
rights for these objects.

e If you assign a category (objcategory) to the new objects or if you have some rules
configured in the Inbox room that assign categories or initiate a process, the user “Form
Poster Fabasoft Cloud” will need also read access to the Teamrooms where you created the
user form (and thus also the form category) or your processes.

o If you pass a category (objcategory) with the form data but it is not set check whether the
category can be applied to the created object.

<!-- Replace "form inbox ID" with the value of the ID field of your form inbox
and "redirect URL" by a URL of a page that schould be shown after the form was
proccessed on the server.

-—>

<form action="https://at.cloud.fabasoft.com/foliop/createobject”" method="post"
accept-charset="UTF-8" enctype="multipart/form-data">

<input name="encodingfix" type="hidden" value="&#9760;" />
<input type="hidden" name="objectclass" value="COODESK@1l.l:Folder" />
<input type="hidden" name="redirect" value="redirect URL" />
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<input type="hidden" name="inbox" value="form inbox ID" />

<input type="hidden" name="attachmentkeys" value="attachments">

<input type="hidden" name="attachmentattrdef"
value="COOSYSTEM@l.1l:0bjchildren">

<label for="objname">Name:</label>

<input type="text" name="objname">

<br>

<label for="objsubject">Subject:</label>

<input type="text" name="objsubject">

<br>

<label for="attachments">Attachments:</label>

<input type="file" name="attachments" multiple="multiple" accept="pdf">
<br>

<input type="submit" value="Send">
<input type="Reset">

</form>

12 Additional Features

The Fabasoft Cloud provides following additional features.

12.1 Permanent Login

With the help of a device binding, you can remain permanently logged in to the Fabasoft Cloud
App. This is especially useful if you are on the move and your IP address changes frequently.

The permanent login is available both in the Cloud App and on a workstation with Fabasoft
Cloud Client installed.
Fabasoft Cloud App

When logging in to the Cloud App, you need to set up a code lock. If you wish, you can also
enable authentication methods such as Touch ID or Face ID to unlock the app, depending on
the device you are using.

Once you have logged in, you remain logged in until you explicitly log out again. You can also be
logged out, for example, if validity restrictions are defined in the organization policy.

In the settings you can manage the code lock and the alternative authentication methods.

Workstation With Installed Fabasoft Cloud Client

You can also perform a device binding on a workstation with installed Fabasoft Cloud Client. To
do so, click on the link “Log in your device in the Fabasoft Cloud” in the login dialog. You remain
logged in until you explicitly log out again.

Note: For security reasons, a certificate is required to identify the devices used. The
corresponding certificate authorities that are allowed to issue computer certificates must be
defined in the organization policies.

Logging off devices via the web client

Under “Account menu (your user name)” > “Advanced Settings” > “Devices” you can manage
your permanently logged in devices and log out a device if necessary. The next time you use the
Fabasoft Cloud on the corresponding device, you will be prompted to log in again.
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12.2 Edit Common Properties

If you select multiple objects and execute the “Edit Properties” context menu command, you
can change the common properties of the objects at once. This is possible for scalar properties
(e.g. strings), object lists, aggregate lists and aggregates (with scalar values).

Scalar Property

¢ If the corresponding property value is the same in all objects, the value is displayed when it
is commonly edited. Otherwise, an empty value is displayed.

Object List

o If the content of the object list is the same in all objects, the content is displayed when it is
commonly edited. Otherwise, an empty object list is displayed.

o If the content of the object list is the same in all objects, the old object list is overwritten by
the new object list. Otherwise, you can decide whether the new objects are added to the
object list, or whether the old object list is overwritten by the new object list.

Aggregate List

o If the content of the aggregate list is the same in all objects, the content is displayed when it
is commonly edited. Otherwise, an empty aggregate list is displayed.

e If the content of the aggregate list is the same in all objects, the old aggregate list is
overwritten by the new aggregate list. Otherwise, you can decide whether the new
aggregate rows are added to the aggregate list, or whether the old aggregate list is
overwritten by the new aggregate list. If a key will be violated in the case of adding rows,
the corresponding row is ignored.

Aggregate

o If the corresponding aggregate value is the same in all objects, the value is displayed when
it is commonly edited. Otherwise, an empty value is displayed.

12.3 Compare Objects

Two different objects can be compared. To do so, select any two objects and execute the
“Compare” context menu command. If two Microsoft Word documents are involved, the
“Compare Content” button is also available in the comparison dialog.

12.4 Send as E-Mail

Objects can be conveniently sent by e-mail via the corresponding context menu commands:

e Send Link
Opens an e-mail with a hyperlink to the object. In order to access the object the recipients
of the e-mail must have a cloud account and at least read access is required on the object.

¢ Send Public Link
Opens an e-mail with a public link to the object. No cloud account is necessary to access the
object.

e Send File
Opens an e-mail with the file itself as an attachment. This command is only available for
documents.
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e Send PDF
Opens an e-mail with a PDF file as an attachment. For documents, the content is converted
in a PDF file. For Teamrooms and folders an index is generated.
Note: Not all objects can be converted in a PDF document.

12.5 View as PDF

Via the “Tools” > “View as PDF” context menu command a PDF overview can be generated.
Depending on the object type, different contents are generated. For documents, the content is
generated as PDF document. For Teamrooms and folders an index with hyperlinks to the
contained objects is generated. Otherwise, a PDF document contains the metadata of the
object.

Note: In the Teamrooms properties, on the “Content Settings” tab, you can specify whether a
cover sheet should be generated for PDF views of documents assigned to the Teamroom. You
can select which versions or signatures are to be displayed on the cover sheet.

12.6 Support Requests

You can always submit support requests via the support button. In the account menu (your
user name), you can find the “My Support Requests” entry, which leads to the history of your
requests. Here you can reply to open requests or close them. In addition, you can create new
requests.

If applicable, the support will create product change wishes or requests based on your support
requests. You can track these in the “Product Changes"” area (State field).

Note:

e The “My Support Requests” entry is only visible, if you have already submitted a support
request via the support button.

o After submitting your first request, it may take a few minutes that the “My Support
Requests” entry becomes available.

Organization-Internal Support Coordinators

The support coordinator team is given access to all support requests in the corresponding
context and can perform the same actions as the initiators of the support requests. The
support coordinator team can thus assist in the support process in a supportive manner.

Note: A dashboard is available to help the support coordinator team manage support requests.
In the “Research” area, the desired support requests can be determined. Activation of this
functionality can be requested free of charge from Fabasoft Cloud Support
(cloudsupport@fabasoft.com). Subsequently, an organization administrator can authorize the
appropriate members in the service desk configuration (accessible via the service desk
operations dashboard).

Configuration of Support Coordinators

The configuration of the organization-internal support coordinator teams can be done on the
following levels:

e Organization > “Advanced Settings” widget > “Define Organization Roles” action > Support
Coordinatorfield
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e Teamroom > “Settings” action > “Teamroom” tab > Support Coordinatorfield

e App configuration or app room > “Settings” action > “General Settings” tab > Support
Coordinatorfield

The support coordinator team is selected based on the context in which the support request is
created.

Organization-Internal Support Teams

By default, support requests submitted via the support button are handled by Fabasoft Cloud
Support within the scope of the support agreement. For customer-specific apps, there can be a
separate app support that may be involved by Fabasoft Cloud Support.

The app support is specialized in providing assistance with technically and professionally
complex customer apps. This is available to you for an additional fee.

For the organization-internal support coordination you can define support teams that primarily
handle support requests in the respective context. For this purpose, the support team can be
defined at the following levels: organization, app configuration, app room, or Teamroom. This
allows you to provide your organization members with an internal contact person without
losing the ability to forward support requests to Fabasoft Cloud Support if necessary.

The designated support team receives workflow activities for the support requests brought in.
The requests can either be answered directly or additional support requests can be submitted
to Fabasoft Cloud Support. With the answers from Fabasoft Cloud Support, further processing
of the original support requests is possible.

Note:

e Adashboard is also available to help the support team manage support requests.
Activation of this functionality can be requested free of charge from Fabasoft Cloud Support
(cloudsupport@fabasoft.com). Subsequently, an organization administrator can authorize
the appropriate members in the service desk configuration (accessible via the service desk
operations dashboard).

e The support button is only available to external members if a support team has been
defined for the organization.

Configuration of Support Teams

The configuration of the organization-internal support teams can be done on the following
levels:

e Organization > “Advanced Settings” widget > “Define Organization Roles" action > Support
Team field

e Teamroom > “Settings” action > “Teamroom"” tab > Support Team field

e App configuration or app room > “Settings” action > “General Settings” tab > Support Team
field

The support team is selected based on the context in which the support request is created.

Configuration Support Dialog

The support dialog for support requests to the organization's internal support team can be
customized accordingly by an organization administrator:
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Organization > “Advanced Settings” widget > "Define Logo” action > Use Logo und Background
Color in Support Dialog field

Manage Support Requests

When a support request is submitted, the defined support team receives the workflow activity
“Edit". As a support team member, you can perform the following steps:

Set Responsible User

Defines the responsible user (necessary to be able to perform the further work steps).
Thus, it is visible in the service desk dashboard by whom the request is processed.

Reply

Allows you to enter a response to the submitter. The answer can be marked as a suggested
solution.

Close
Closes the support request. If necessary, a message can still be added.

Further Information Required
Allows you to get more information from another user.

Request at Fabasoft Support

If the problem cannot be solved internally, a new support request can be generated for
Fabasoft Cloud Support. As soon as this request has been processed, the original support
request is put in your worklist again.

Service Desk Dashboard

A dashboard is also available to help the support team manage support requests. Activation of
this functionality can be requested free of charge from Fabasoft Cloud Support
(cloudsupport@fabasoft.com).

The service desk dashboard is divided into the following areas:

My Support Requests
Shows all requests assigned to the current support employee or not yet assigned to a
support employee.
o grey symbol

The request has the state “Work in Progress” and no support employee is assigned.
o no symbol

The request has the state “Work in Progress” and a support employee is assigned.

o yellow symbol
The request has the state “Waiting for Customer”.

o green symbol
The request has the state “Closed”.

Support Requests in Progress
Shows all requests with status “Work in Progress” regardless of the support employee.

Requested at Fabasoft Support
Shows all current requests to the Fabasoft Cloud Support.

Recently Processed
Shows the last hundred requests on which an action was performed.

Fabasoft Cloud 139


mailto:cloudsupport@fabasoft.com

e Product Changes
Shows the product changes. If a support request leads to a story or a defect, a product
change can be created by the Fabasoft Cloud Support or app support. You can use the
Statusfield to track the implementation status.

e Research
Allows searching for product changes, support requests and support request reports.

e Support Reports
Displays the generated support reports. The “Create Support Reports” action can be used to
create evaluations of the processed requests in a specific time period.

12.7 Working with a WebDAV Client

The Fabasoft Cloud supports the platform-independent WebDAV standard. This way it is
possible to access documents in the Fabasoft Cloud via WebDAV client applications (e.g.
Microsoft Windows Explorer or Apple Finder).

The data is accessible via following WebDAV URL: <URL of the cloud>/folio/webdav
Example: https://at.cloud. fabasoft.com/folio/webdav

If you use the default WebDAV URL, “Home" is used as the base folder. Alternatively, you can
also specify an object and, if necessary, a property directly as the base. In this way, path length
problems can be avoided, for example. In general, the property can be omitted, since usually
only one list per object is visible as a WebDAV resource.

Syntax:

.../webdav/ [<object>-<property>]

Example:
.../webdav/[C00.1.506.3.4961]
.../webdav/[C00.1.506.3.4961-C00.1.1001.1.324006]

Mapping a network drive using the Fabasoft Cloud Client

1. Open the context menu of the Fabasoft Cloud Client by right-clicking the notification
symbol in the taskbar of the operating system.

Click the “Open Cloud Network Drive” command.

For access, a password for applications is needed. By clicking “Open Network Drive (New
Password), a password for applications is automatically generated. The password is stored
in both in the Fabasoft Cloud and in the credential manager of the operating system.

If a valid password is stored on the local computer, the network drive is directly opened.

The network drive is opened in the Microsoft Windows Explorer or Apple Finder and this way
you have access to your folder structure in the Fabasoft Cloud.

Note:

¢ Inthe web client, you can revoke the password for applications by opening the account
menu (your user name) and clicking the “Advanced Settings” > “Access for Applications”
command. Click the “Revoke” button in the corresponding row with the description
“Network drive for <computer name>".

e You cannot view the generated password for applications that was created with the
Fabasoft Cloud Client.
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¢ In the credential manager of the operating system only one, the last current password is
stored. If, for example, you map a network drive manually as described below and store the
credentials in the operating system permanently, the password will be used further on also
in the Fabasoft Cloud Client, even if you previously generated an own password.

Mapping a network drive manually

Alternatively, you can map a network drive also manually. This is, for example, necessary on
smartphones since no Fabasoft Cloud Client is available.

1. For access, a password for applications is needed. Create a password by opening the
account menu (your user name) and clicking “Advanced Settings” > “Access for
Applications”. Create a password valid for “Network Drive (WebDAV)". Additional
information can be found in chapter 13.5 “Access for Applications”.

2. Switch to the corresponding third-party product and define the WebDAV URL (see the
beginning of this chapter), your e-mail address (used for the cloud log-in) and the generated
password for applications. In the following, you will find a description for the third-party
products Microsoft Windows Explorer and Apple Finder.

Microsoft Windows Explorer

Click “Tools” > “Map network drive”. Select a drive letter and enter the WebDAV URL in the
Folderfield. Click “Finish”. If no valid password is stored on the local computer, enter your
e-mail address and the password for applications. If you store the credentials permanently,
the password is used also for further connections.

Apple Finder

Click “Go" > “Connect to Server”. Enter the WebDAV URL in the Server Address field and click
“Connect”. If no valid password is stored on the local computer, enter your e-mail address
and the password for applications. If you store the credentials permanently, the password
is used also for further connections.

Notes for working with WebDAV

¢ If you import a folder on top-level or in a folder that is not assigned to a Teamroom, the
folder will be converted into a Teamroom in the Fabasoft Cloud.

e Documents cannot be imported on top-level or in a folder that is not assigned to a
Teamroom.

12.8 Time Travel

The time travel allows you to view documents and metadata to specific times in the past. Via
the “Time Travel” > “Start Time Travel” action you can start the time travel. Use the timeline to
reach easily and quickly the desired pointin time.

e “Start Time Travel”, “Continue Time Travel”, “End Time Travel”
Select the version you want to view or end the time travel. As an alternative to selecting a
version, you can specify a point in time.

e “Save Current Version”
Saves a version of the current state. The version can also be treated as “release version”.
This way, team members with read access can only see this version. A new release version
replaces a possibly present release version.

e “Clean up Versions”
You can delete versions that are no longer needed.
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o How many versions should be kept?
You can define the maximum number of versions you want to keep.

o How many days versions should be kept?
You can define how many days the versions should be kept at maximum.

o Apply these rules automatically
You can specify that in the future too many or too old versions will be automatically
deleted.
Note: To disable automatic execution, run the "Clean up Versions" action again. Remove
all values, disable this option and click "Clean up".

o “Select Versions”
You can explicitly select and delete versions via the “Select Versions” button. The button
is displayed if there are at least two versions.

e “Compare”
Compares the selected version with an arbitrary other version. The contents of Word
documents can also be compared.

e “Restore”
The current version is replaced by the selected version.

e “Delete”
You can delete the currently displayed version that is no longer needed.

Note: The timeline is not operable with the keyboard.

12.9 Calendar

Calendars allow you to manage events and tasks, and to share them with other team members.
In addition, you can access your calendars with third-party products via CalDAV.

12.9.1 Creating a Calendar

To create a calendar, proceed as follows:

1. Navigate in the desired Teamroom.

2. Open the context menu of an empty part of the content area and click “New".
3. Inthe “Calendar” category, select the “Calendar” entry.
4

Enter a name and click “Next".

In the calendar, you can create events and tasks. The calendar can also be downloaded as an
iCalendar file (ICS).

12.9.2 Creating an Event

To create an event, proceed as follows:

1. Navigate in the desired calendar.
2. Click the “Create Event” action.

3. Enter the data of the event.
4

Click “Create”.
Note: If you have specified at least one attendee, you can use the “Create and Send” button
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to create the event and also send an e-mail to the defined attendees with the event as an
ICS file.

Note:

e An event can be sent subsequently via the “Send Event” context menu command.
o If a sent eventis updated or deleted, you can send an event update or event cancellation.

¢ Via the sent e-mail the event can be opened, accepted, provisionally accepted or declined.
The respective status is displayed for the event in the Attendees field.

12.9.3 Access via CalDAV

Calendars can also be accessed by third-party products via CalDAV. For access, a password for
applications is required. If you have not created a password for CalDAV, create one now (see
chapter 13.5 “Access for Applications”).

If your third-party product supports calendar lists, you can manage them in the Fabasoft Cloud.
Otherwise, you can embed a calendar directly via the Calendar URL (properties of the calendar).

To manage the calendar list, proceed as follows:

1. Click the account menu (your user name) and then click “Advanced Settings” > “Calendar”.
2. Inthe Calendarfield, add the wanted calendars. Via the URL

webcals://<server>/<vdir>/caldav (e.g.
webcals://at.cloud. fabasoft.com/folio/caldav)you can access the calendar listin a
corresponding third-party product.

3. The calendar shown in the Default Calendarfield can also be accessed via the URL

webcals://at.cloud.fabasoft.com/folio/caldav/home.

4. Click “Save" to apply the changes.
Note:

e Depending on the third-party product, you may replace webcals:// by https://.

e Calendars can also be managed by the context menu commands “Add to Calendar List” and
“Remove From Calendar List".

If you are using Apple iOS, you can include your calendar list as follows:

1. Navigate to “Settings” > “Passwords & Accounts” > “Add Account”.
Select the entry “Other” > “Add CalDav Account”.
Enter your account information.

o Server
webcals://<cloud server>/<vdir>/caldav

Example: webcals://at.cloud. fabasoft.com/folio/caldav

o Username
The e-mail address you use to log in to the Fabasoft Cloud.

o Password
The generated CalDAV application password (see chapter 13.5 “Access for Applications”).

4. Now you can access your Fabasoft Cloud calendar list with the Apple Calendar app.
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12.10 Address Book

When using the contact management, you can manage your contacts in contact rooms and
address lists. In addition, you can access your address book list via CardDAV with third-party
products.

You can find your address book list under “Account menu (your user name)” > “Advanced
Settings” > “Address Book”. In the Address Book Listfield, add the wanted contact rooms or
address lists. Via the URL https://<server>/<vdir>/carddav (e.g.
https://at.cloud.fabasoft.com/folio/carddav)you can access the address book listin a
corresponding third-party product.

CardDAV

Access to contacts is also possible via third-party products such as “Apple Contacts”, which
support the CardDAV standard. A password for applications is required for access. If you have
not yet created one for CardDAYV, create one (see chapter 13.5 “Access for Applications”).

Access is possible via the central CardDAV URL. For example:

® https://at.cloud.fabasoft.com/folio/carddav
® https://de.cloud.fabasoft.com/folio/carddav

e https://ch.cloud.fabasoft.com/folio/carddav

Microsoft Outlook

The “Open Cloud Address Book” context menu command of the Fabasoft Cloud notification
symbol can be used to include the address book list in Microsoft Outlook.

12.11 Newsfeed

With the newsfeed, you can keep your team members up to date with the latest news.

12.11.1 Creating a Newsfeed

To create a newsfeed, proceed as follows:

1. Navigate in the desired Teamroom.

2. Open the context menu of an empty part of the content area and click “New".
3. Inthe “Collaboration” category, select the “Newsfeed” entry.

4, Enter a name and click “Next".

12.11.2 Writing Posts in the Newsfeed

Any user who has change rights in the Teamroom can write posts in the newsfeed. These posts
are readable for all team members. For a newsfeed, it can be configured that team members
with read access can also write posts.

To write a post in the newsfeed, proceed as follows:

1. Navigate in the newsfeed.
2. Enter the text in the textbox and possibly add an attachment.
3. Click “Send".
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Any user can remove their posts. Team members with full control can remove any post.
Note:

e A maximum of 2000 characters can be entered.
e Team members with read access cannot add attachments.
e Posts can be commented.

¢ If you share a link, starting with http://, https:// or ftp://, it will be displayed as a hyperlink. If
you follow this hyperlink, it will be opened in a new window.

e With <code></code> source code can be displayed formatted.

12.12 Watermarks

It can be defined that documents in a Teamroom are automatically converted to secured PDF
documents with a definable watermark. Team members with read access only see the PDF
documents whereas team members with change access or full control see the source
documents.

To define a watermark for a Teamroom, proceed as follows:

1. Navigate in the desired Teamroom.

2. Open the “Permissions” tool and click “Watermark Settings”.
3. Inthe Use Watermarks field, select “Yes".
4

Define the desired settings for the watermark. With the Watermark for All Users option, you
can test the settings by yourself.

5. Click “Next".

Note: Watermarked Teamrooms and assigned objects cannot be duplicated by users who only
have access to PDF documents with watermarks.

12.13 Multimedia Files

Multimedia files can be displayed directly in the web browser, depending on the format.

e For images, alternative text and a description can be added on the “Image Properties” tab.

e The alternative text defined for an image is stored as an a1t attribute in the img tag when
the image is displayed and is thus accessible for screen reader users. If an image
description is defined, the “Show Image Description” context menu command is available.

e If an audio description is provided for audio objects (“Audio Properties” tab > Alternative
Textfield), the “Open Transcript Document” context menu command is available.

e Forvideo and audio objects, on the “Video Properties” or “Audio Properties” tab, in the
Tracks field, VTT files can be stored to enable a timed text track to be displayed alongside
the media content.

12.13.1 Images

You can export images in different formats in the file system or in the clipboard.
To export an image, proceed as follows:

1. Navigate to desired image and mark it.
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2. Open the “Clipboard” menu and click “Download Image".
Note: Make sure that the menu bar is displayed (“account menu (your user name)” > “Basic
Settings” > “Show Menu Bar”).

3. Define the size and target format.

4. Click “Copy Image to Clipboard”, “Copy Link to Clipboard” or “Download Image”.

Note: In the “Clipboard” menu, you will additionally find the menu entries “Copy Image for
Presentation” and “Copy Image for E-Mail” that export the marked image in different formats to
the clipboard.

12.13.2 Video and Audio Files

You can convert video files to MP4, OGV or WEBM. For audio files, MP3 and OGG are available.
To convert a video or audio file, proceed as follows:

1. Navigate to the desired multimedia file.

2. On the context menu of the multimedia file, click “Save as <format>".

The conversion runs in the background and may take longer depending on the size of the
source file. The result of the conversion can be found in the properties of the multimedia file,
on the “Content” tab in the File in Different Formats field.

12.14 Follow-Ups

When using the follow-up functionality, an e-mail can be sent to a user or a process can be
started at a particular time.

To define a follow-up, proceed as follows:

1. Navigate to the desired object.

2. On the context menu of the object, click “Tools” > “Create Follow-Up" or “Manage Follow-
Ups” (at least one follow-up is already defined).

3. If you mark the follow-up as personal (only valid for the "Send e-mail" action), it will not be
visible to other users.

4. Select the Actionthat should be executed.

o Send E-Mail
Define Recipients for the e-mail. In the Message field, you can specify the e-mail text.

o Start Process
Define the process that should be executed.
Note: The process has to be released for the organization.

5. If applicable, enter a reason. The text is displayed as a suffix of the follow-up name and
calendar event.

6. Define the point in time of the follow-up and whether it should be repeated. For more
information, refer to the “Point in Time” and “Repetition” sections below.

7. Click “Next".

Upon reaching the follow-up point in time and after processing the automatic task the defined
action will be executed.
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Note:

e For non-personal follow-ups, substitutes and successors will be considered.

¢ “Immediately after last change on/at” can also be selected for the execution time. Changes
within the first 10 seconds after definition of the follow-up are ignored. After that, the next
change to the object is considered.

¢ A default category can be defined for follow-ups (“Default Values” tab in app configurations
or app rooms).

o If a form category is assigned to a follow-up, the name build of the form category is
considered for the follow-up name.

o If a follow-up date has been defined as an explicit date, this can be changed
programmatically via a low-code expression using the ReCalculateResubmissionDate
action.

Example:
cooobj.myproperty.FSCNOTIFICATION@1.1001l:0objresubmissions[0] .FSCNOTIFICATION@L.
1001:ReCalculateResubmissionDate (null, datetime ("2030-01-01"));

Pointin Time

You can either specify an explicit date or let the date be calculated based on a base date field of
the object. Optionally, the execution date can be redefined if the base date is changed.

Note: In addition to the date, the specified time is also considered. For fields without a time,
00:00:00 is used as the time.

Repetition

It is also possible to repeat follow-ups. The following cases can be distinguished.

Explicit date or date is not recalculated when the base date is changed

You can define a repetition rule that is applied starting with the execution time.

e Unit
Defines the unit of the interval (e.g. day or month).

e Interval
Defines the interval between the repetitions (number).

e Repeat Until
Defines the end time of the repetitions (infinite, explicit date, date value of a property).

Date is recalculated when the base date is changed

The background task is rescheduled after the selected action is executed and the base date is
changed. Only Repeat Until can be defined as a repetition rule.

Follow-Ups Dashboard

You can manage the follow-ups in the follow-ups dashboard. The dashboard is divided into the
following areas:

e Calendar
Shows all follow-ups of the “My Follow-Ups” list.

e My Follow-Ups
Shows the follow-ups that were created by you or in which you are entered as the recipient.
You can also store other follow-ups by yourself. You can use the “Settings” action to adjust
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the filter criteria and to find the CalDAV URL, which you can use to integrate your follow-ups
as a calendar in Microsoft Outlook, for example.

e Further Follow-Ups
Shows follow-ups determined by you. You can define the search criteria using the
“Determine Follow-Ups"” action.

12.15 Cloud Mail Import

Using the cloud mail import, you can automatically query mailboxes and import e-mails. In this
process, cloud mail folders allow you to filter e-mails based on conditions. You can use cloud
mail dispatchers to assign e-mails to different folders.

A typical scenario would be that you query the e-mails in your mailbox and select a cloud mail
folder as the target folder. In the cloud mail folder, you set a condition that only e-mails that
contain the word "Invoice" in the subject should be stored. In a cloud mail dispatcher, define
the cloud mail folder as the source folder and store all e-mails with "Car" in the subjectin a
folder. The destination folders of the first dispatcher can be source folders for further
dispatchers. Thus, a dispatcher cascade can be built until all e-mails have been sorted into the
desired folders.

Note: “Cloud Mail Import”, “Cloud Mail Folder” and “Cloud Mail Dispatcher” can be created in a
Teamroom.

Cloud Mail Import
You can define the following settings:
“E-Mail Server” tab

o Name
The name of the cloud mail import.

e Protocol
Defines the protocol to be used to access the e-mail server.

o Server
Defines the fully qualified domain name of the e-mail server on which the mailbox is
hosted.
Note: The data required in the following for communication with the e-mail server can be
found, for example, in the configuration of your e-mail client or in the documentation of
your provider.

e When using the Microsoft Graph API, an administrator must create an app in your Microsoft
portal that defines the required API access rights. To do this, navigate to “Microsoft Entra
ID" and register a new app.

Allow “Accounts in this organizational directory only”.

As redirect URI for the platform “Web" define
https://at.cloud.fabasoft.com/folio/cmigraphauthcodecallback (USe de Or ch instead
of at based on the data location).

Assign the following Microsoft Graph APl permissions (delegated permissions): Mail.Read,
Mail.ReadWrite and User.Read.

o Server
Use the default value “graph.microsoft.com”.
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o OAuth 2.0 Authorization Endpoint
Use the default value
“https://login.microsoftonline.com/{tenant_id}/oauth2/v2.0/authorize".

o OAuth 2.0 Token Endpoint
Use the default value “https://login.microsoftonline.com/{tenant_id}/oauth2/v2.0/token”.

o Scope
Use the default value “https://graph.microsoft.com/.default offline_access”.

o Microsoft Directory (Tenant) ID
Defines the “Directory (Tenant) ID” of your Microsoft environment.

o Microsoft Application (Client) ID
Defines the “Application (Client) ID"” of the app defined in your Microsoft environment.

o Microsoft Client Secret (Value)
Defines the “Client Secret (Value)” of the app defined in your Microsoft environment.

o Port
Defines the port for accessing the e-mail server. The input is optional when using the
standard port for the respective protocol (e.g. 110 for POP3).

o User Name
Defines the user name to be used to access the mailbox.

o Password
Defines the password to be used to access the mailbox.

o Mailbox Folder
Defines a special mailbox folder to be queried.
Note: When using the IMAP protocol or Microsoft Graph API, you can specify a specific
folder to be retrieved.

e Recipient Filter
If an e-mail address is specified, only e-mails sent to the specified e-mail address will be
imported (To, CC, BCC).

e Delete After Retrieval
Defines whether the e-mails are deleted from the e-mail server.

o When using the IMAP protocol
If this field is enabled, all e-mails are retrieved from the mail server and then deleted. If
this field is disabled, only unread e-mails are retrieved and then marked as read.

o When using the POP3 protocol
This field cannot be disabled. All e-mails are retrieved and then deleted.

o When using the Microsoft Graph API
If this field is enabled, retrieved e-mails are deleted from the mail server.

o Target Folder
Defines the folder in which the retrieved e-mails are stored. If no folder is specified, the
"Cloud Mail Import" itself is the target folder.

“Automation” tab

o Retrieve Automatically
Defines whether e-mails should be retrieved automatically.

e /nterval
Defines the time interval for automatic retrieval.

Fabasoft Cloud 149



Automation Enabled for
Shows all your cloud mail imports and dispatchers with automatic execution.

Context Menu Commands

Retrieve E-Mails
You can manually retrieve the e-mails.

Enable Automatic Retrieval/Disable Automatic Retrieval
You can enable or disable the automatic retrieval.

Authenticate
When using the Microsoft Graph API, you must authenticate yourself and allow access.

Reset Synchronization Status

When using the Microsoft Graph API, if you reset the synchronization status, again all e-
mails will be considered the next time you retrieve them and not just the new e-mails since
the last synchronization.

Cloud Mail Folder

You can specify the following settings:

“Cloud Mail Folder” tab

Name
The name of the cloud mail folder.

Maximum Age (Days)
E-mails older than the specified days will be deleted (creation date).

Maximum Number of E-Mails
If the number of e-mails exceeds the specified maximum number, they will be deleted.

Conditions

Only e-mails that match the defined conditions will be stored (OR conjunction). A condition
consists of a property (e.g. “Subject”) and a pattern (any string). The value of the property
must contain the pattern string to match the condition (case-insensitive).

Note: The conditions are checked when e-mails are to be stored in the cloud mail folder via
the cloud mail import.

Target Folder (Not Matching)

Defines the folder where e-mails that do not match the conditions will be stored.
Note: This folder should always be defined in order not to lose any e-mails.

Cloud Mail Dispatcher

You can specify the following settings:

“Dispatcher” tab

Name
The name of the cloud mail dispatcher.

Condlitions

E-mails are placed based on the defined conditions (OR conjunction). A condition consists of
a property (e.g. “Subject”) and a pattern (any string). The value of the property must contain
the pattern string to match the condition (case-insensitive).

Source Folder for E-Mails
Defines the source folder from which e-mails are distributed.
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o Target Folder (Matching)
Defines the target folder for e-mails that match the conditions.

o Target Folder (Not Matching)
Defines the target folder for e-mails that do not match the conditions.

“Automation” tab

o Dispatch Automatically
Defines whether e-mails should be dispatched automatically.

o Interval
Defines the time interval for automatic dispatching.

e Automation Enabled for
Shows all your cloud mail imports and dispatchers with automatic execution.

Context Menu Commands
e Dispatch E-Mails
You can manually dispatch the e-mails.

e Enable Automatic Dispatch/Disable Automatic Dispatch
You can enable or disable the automatic dispatching.

12.16 Data Import

You can use an Excel file to create or update objects with the desired metadata. If you want to
create objects of different object classes, you need one Excel file per object class.

Note: As an alternative to the Excel file, you can also use a CSV file with UTF-8 character
encoding.

To import data records from an Excel file, proceed as follows:

1. For example, in a Teamroom, open the “Tools” menu and click “Import Data".
Note: Make sure that the menu bar is displayed (“account menu (your user name)” > “Basic
Settings” > “Show Menu Bar”).

2. Select the Excel file you want to import and click “Import”. A description of the required
data structure of the Excel file can be found below.

3. Select the container and the list in which the objects are to be created or updated. For
example, the objects can be created in the Contentslist of a Teamroom.

4, Select the object class for the newly created objects.

If necessary, select a category (incoming category, form category) to be assigned to the
newly created objects.

6. If the container already contains objects, select a key that identifies the objects. This allows
you to update existing objects. The key can also consist of several properties. If you do not
specify a key, new objects will always be created. In general, the /mport /D (objexternalkey)
is used as the key.

7. Click “Next"” to import the data records.

New objects are created from the data records or existing objects are updated.

Format of the Excel File

e For each property that is to be filled with a value, a column is required.
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¢ In the header row, the respective property is defined based on the reference of the
property.
Note: To determine the reference of a property, open the properties of a sample object.
Using the shortcut ctrl + shift + # you can show or hide the references of the properties.
Clicking on the reference copies it to the clipboard. The short reference (part after the
colon) can be used if it is unique (instead of for example coosYSTEM@1.1:0objexternalkey
just objexternalkey). Alternatively, the multilingual name of the property can be specified,
but this is discouraged to ensure uniqueness.

o Each additional row represents the values of an object.
Note: If possible, always use a unique ID to determine the objects to be referenced.

e You can also define an overrideKeys column in which you can enter column names
separated by commas or one below the other (a1t + Enter). This results in the following
behavior:

o Ifthe overridekeys column does not exist, empty values are taken over and lists are
overwritten.

o Ifthe overrideKeys column exists and the column name is entered, empty values are
taken over and lists are overwritten.

o Ifthe overrideKeys column exists and the column name is not entered, empty values
are not taken over and new entries are added to lists.

Example table:

objexternalkey objname objsubject OverrideKeys
Import1 Object Name 1 Subject of object 1

Import2 Object Name 2 Subject of object 2 objname,objsubject
Note:

e The specified properties must be modifiable for the values to be imported. For example,
Created by is not modifiable.

e The changes must be permitted:
o Mandatory fields cannot be emptied.
o The uniqueness of lists is maintained.
o Objects of non-permitted object classes cannot be stored.

e In order to assign several objects to a list, the individual objects must be specified one
below the other in the corresponding cell (a1t + Enter).
Mapping the Values

The import will attempt to convert the specified strings to the appropriate property data types,
although not all data types are supported.

Procedure:

e Enumeration
o Reference of the enumeration value

o Name of the enumeration value
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o Numeric value of the enumeration value

Date/Time

o ISO 8601
O dd.mm.yyyy HH:MM:SS

Currency

o Currency symbol (e.g. EUR, USD) + space + value

o Value + space + currency symbol
Object
o Fabasoft Cloud ID

o MX URL with Fabasoft Cloud ID (. ./mx/C00.a.b.c.d)

o Reference with prefix #

o Import ID with prefix ?

o User (member or external member of the organization if not specified by e-mail

address).
= E-mail address

» Object name

* Last name + space + first name
* First name + space + last name

o Organization element (team, organizational unit, external organization)

»= Object name

o Country
* |SO 3166 ALPHA-2
» |SO 3166 ALPHA-3

= Multilingual name

o Organization (contact management)

= E-mail address

»= Object name

o Contact person (contact management)

» E-mail address

» Object name
o Processing state

= Multilingual name
o Category

= Multilingual name
o Terms

= Multilingual name

= Multilingual name of synonyms

o Object (allowed in the property)

» Object name
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» Multilingual name

e In all other cases, an attempt is made to assign the value to the property.

12.17 Auditing

“Auditing” allows you to track access to objects. Not only changes to properties are displayed,
but you can also find out when and by whom the contents of an object were read.

12.17.1 Creating a Search Folder for Audit Logs

To create a search folder for audit logs, proceed as follows:

1. Navigate in the desired Teamroom.

2. Open the context menu in an empty part of the content area and click “New".
3. Click the “Search Folder for Audit Logs” entry.
4

Enter a name and fill out the fields depending on your search criteria.

Note: If you do not define a Teamroom, only a limited time range can be investigated. If an
organization is defined, you can extend the time interval up to 3 months, if an audit
originator is defined, you can extend the time interval up to 7 days, otherwise only a
maximum of two hours can be investigated.

5. Click “Next".

Navigate in the search folder and click the “Refresh” action. All objects matching your search
criteria will be displayed (except for objects that have already been deleted). Use the “Export
Audit Log" action to check the audit log entries of deleted objects.

Note:

e You can create search folders for audit logs only if you have been authorized in the
organization policies.

e To change the search criteria, click “Properties” in the context menu of the search folder
and adjust the search criteria accordingly.

12.17.2 Showing Audit Log Events

To show the audit log events of an object, proceed as follows:

1. Navigate in the search folder for audit logs.
Mark the desired object.

Open the “Object” menu and click “Show Audit Log".
Note: Make sure that the menu bar is displayed (“account menu (your user name)” > “Basic
Settings” > “Show Menu Bar").

All events are displayed that occurred during the specified period. The “Show Changes” context
menu command, can be used to read the versions of the object.

Note: Alternatively, you can also navigate to the desired object, select it and execute the “Tools”
>“Show Audit Log" menu command.

12.17.3 Exporting the Audit Log

To export the audit log events as CSV file, proceed as follows:
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1. Navigate in the search folder for audit logs.
2. Click the “Export Audit Log" action.
3. After the report generation has finished click the “Download” button, to export the CSV file.

12.18 Adjusting Access Rights After a Membership Exclusion

If a member's organization membership is terminated, all access rights to the organizational
Teamrooms are revoked and, if a successor has been defined, the successor is entered in the
Teamrooms instead of the former member. Users who have all rights in the affected
organizational Teamrooms and are members of this organization will be notified by e-mail. The
successors will also be informed by e-mail. The links in the e-mails can be used to check the
Teamrooms and make any necessary adjustments.

Note: When terminating a membership in external organizations, organizational units or teams,
those with full control in the Teamroom are also informed by e-mail, if the Teamroom is
restricted to the affected external organization, organizational unit or team.

For Teamrooms of other organizations the following applies:

¢ If the user's membership in his or her main organization is terminated, users with full
control in Teamrooms of other organizations will also be informed about the exclusion and,
if applicable, about the successor. The access rights can be manually adjusted by a user
with full control.

o If the user's membership in one of his or her non-main organizations is terminated, only
Teamrooms that are restricted to the affected organization are handled.

12.19 Handle Infected Documents

Avirus scan is carried out regularly. If viruses are found, the respective Teamroom
administrators are informed by e-mail. Using the “Handle Infected Document” action,
Teamroom administrators can either mark the document as incorrectly classified or download
and clean it. Be aware of the risks involved in downloading infected files to your computer.
Cleaned documents can be uploaded again using the “Upload” action.

13 Account Menu

The account menu with your user name is located in the top bar and allows you to set up basic
settings.

Your organization administrator can define default values for the basic settings, notification
settings and workflow settings. In addition, the organization administrator can specify whether
these settings can be changed by you.

13.1 Login and Password

Here you can view or change various log-in settings.

e Password
You can change your password. Do not use a password that you also use for other
websites.
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E-Mail Address
Displays your log-in e-mail addresses (can be changed by the organization administrator).

Mobile PIN
Displays your data for two-factor authentication (can be changed by the organization
administrator).

13.2 Contact Data

You can define your own contact data.

On the “Data Protection” tab, you can generate an excerpt that contains only your personal
data (contact data) stored in the user administration. Please note that cloud organizations
manage their data themselves (user data) and that further personal data may appear in it.
Personal data in user data cannot be contained in this information.

13.3 Basic Settings

The basic settings can be used to adapt the web client to your needs. When saving the basic
settings, the page is reloaded to enable them.

“General” tab

Language

Defines the language of the web client.

Note: By default, the mobile app is displayed in the device language. If the device language
basically matches the user language in the basic settings, the language characteristic
defined in the basic settings is preferred.

Example: If the device language is German (Austria) and the user language is German
(Switzerland), the strings for German (Switzerland) are displayed. If the device language is
English (US) and the user language is German (Switzerland), the strings for English are
displayed.

Locale

The selected locale affects the representation of property values such as the format of the
date or the decimal separator.

Default Currency
The default currency can be considered in currency properties.

Show Menu Bar
Defines whether the menu bar is shown.

Show Hints
Defines whether object hints are displayed in an info box.

Read Properties by Default
Defines whether the properties of an object are displayed in read-only or edit mode (for
example, when using the “Properties” action).

Preferred Type for Comments
Defines which comment type (public or private) is initially selected when using the
integrated PDF viewer.

Start With
Defines which element on “Home" should be displayed initially after login.

Fabasoft Cloud 156



o Show Upload Confirmation
Defines whether a confirmation dialog is shown when importing files.

e Default Data Location
Defines the data location in which you work by default.

o Show Exit Confirmation
Defines whether a security prompt is displayed when closing the client by closing the web
browser.

“Accessibility” tab

On this tab you can find settings that are helpful when using the keyboard and screen readers.
Refer to chapter 15 “Accessibility” for more information.

13.4 Notifications

You can define about which events you want to be informed. You can be informed either by e-
mail or by events displayed in the Teamroom (“Show New Events” action). In the card view, the
number of changes is displayed on the Teamroom, since you viewed the events for the last
time.

To configure the notifications, proceed as follows:

1. Click the account menu (your user name) and then click “Advanced Settings” >
“Notifications”.

Click the “Settings” button.
Define about which events you want to be informed and click “Save”.
Click the “Define Affected Objects” button.

LA S

In the newly opened window, use, for example, the “Enable Notification” or “Disable
Notification” context menu commands to specify the Teamrooms or dashboards for which
you want to receive notifications and close the window.

Note: For the Teamrooms entered, the setting applies to the entire hierarchy unless a
different setting has been made for a subordinate Teamroom.

For the dashboards with enabled notifications, the Notification Sources field of the
dashboard is considered.

6. Click “Close” to close the notifications dialog.

13.5 Access for Applications

The access with external applications such as CMIS, CalDAV, WebDAV, RSS or web services has
to be protected with an own generated password. The password has a validity period and can
be renewed and revoked. Alternatively, applications can be secured via OAuth or OpenID
Connect.

To generate passwords for applications, proceed as follows:

1. Open the account menu (your user name) and click “Advanced Settings” > “Access for
Applications”.

2. Inthe Passwords for Applications field, click “New".
Select an external application in the Valid forfield.

Choose a validity period.
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5. Click “Next”.

The generated password will be displayed. The password has to be entered at the applications
instead of your own one.

Note:

e If a generated password runs out shortly or has already run out an e-mail is sent to your
login e-mail address.

e To extend passwords, select the menu entry “Renew all”. The passwords will be extended
by the entered validity period. You can also extend a single password by editing the entry.

¢ If you want to change a generated password, you have to revoke it and generate a new one.

e Access of OAuth applications and OpenlID Connect tokens can be revoked via “Advanced
Settings” > “Access for Applications”.

14 Data Locations

A data location determines the physical data location of where your data is saved. You decide in
which data location you want your data to be saved.
Fabasoft currently offers data locations in the following countries:
e Austria
e Germany
e Switzerland
To change the data location, proceed as follows:

1. Click the current data location name (e.g. Austria) in the top bar, to open the data location
menu.

2. C(lick the desired data location entry, to change the data location.
You are now on “Home" of the corresponding data location.

Note:

¢ If you switch to a data location for the first time, an own “Home" is created for this data
location.

e Teamrooms, folders and their content are only available in the data location in which they
were created. The users are available in each data location.

e Changing the data location via the data location menu can be prevented by an organization
policy.

15 Accessibility

Accessibility is an elementary concept of the Fabasoft products. Users with visual impairment
are supported with entry and visual display.

15.1 Notes on Keyboard Operations

The Fabasoft Cloud offers full access for users who work with the keyboard instead of the
mouse. As you use shortcuts on your operation system, you can use default key operations as
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for example ctr1 + cin the Fabasoft Cloud. The supported shortcuts can be found in chapter
16 “Keyboard Operations”.

Users who only use the keyboard should define following settings:

1.

Open the account menu (your user name) and choose “Basic Settings".
Switch to the “Accessibility” tab.

Activate the Use Tabular Mode for Prescriptions option because the default displayed
graphical process editor is not suitable for keyboard operation.

If you do not see colors or see colors badly, enable the Show Alternative Text for
Highlighted Fields option.

If you find background images disturbing, disable the Show Background Images in
Dashboards and Home option.

If you need an increased contrast, enable the /ncrease Contrastoption.

In the Highlight Active Element (Focus)field, select either “When Using the Keyboard"” or
“Always Emphasize Especially”.

Save the settings.

15.2 Enhanced Highlighting of the Focus

Under the account menu (your user name), in the “Basic Settings”, on the “Accessibility” tab, in
the Highlight Active Element (Focus)field specify when an active field should be highlighted with
a yellow border:

When using the keyboard

Pressing keys or key combinations (e.g. Tab or shift + Tab) that set the focus on an
element in the user interface enables the enhanced highlighting. A mouse click disables the
enhanced highlighting.

Always emphasize especially

Never emphasize especially

15.3 Zooming

You can zoom text and graphics. The layout adapts itself optimally to the size. Use the web
browser functionality for this.

Shortcuts Actions

Apple key + Plus (Safari)

ctrl + plus (Edge/Firefox/Chrome) Zoom in

Apple key + Minus (Safari)

ctrl + Minus (Edge/Firefox/Chrome) Zoom out

Apple key + O (Safari)

ctrl + 0 (Edge/Firefox/Chrome) Reset to normal size
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If you enable the Use Simplified Resizer option (account menu (your user name) > “Basic
Settings” > “Accessibility” tab), for example, when registering a flap is displayed at the dividing
line of the areas which provides a larger area for positioning the mouse pointer in order to
enlarge or reduce the areas.

15.4 Design in High Contrast

Under the account menu (your user name), in the “Basic Settings”, on the “Accessibility” tab, you
can enable the /ncrease Contrast option to obtain a design with high contrast.

15.5 Notes on Using Screen Readers

The Fabasoft Cloud supports the WAI-ARIA standard (Accessible Rich Internet Applications).
WAI-ARIA is not fully supported by all screen reader programs.

The following screen reader programs are recommended for the use with the Fabasoft Cloud:

e NVDA (NonVisual Desktop Access) with Mozilla Firefox or Google Chrome
¢ JAWS with Microsoft Edge, Google Chrome or Mozilla Firefox

Users who use a screen reader should define following settings:

1. Open the account menu (your user name) and choose “Basic Settings”.
2. Switch to the “Accessibility” tab.

Activate the /nclude All Fields in Tab Order option to include also read-only fields in the tab
order.
Note: If you are using Apple Safari, you additionally have to activate following option in the
web browser: “Safari” > “Preferences” > “Advanced"” > Press Tab to highlight each item on a
webpage.

4, Activate the Use Tabular Mode for Prescriptions option because the default displayed
graphical process editor is not suitable for keyboard operation.

Activate the Show Alternative Text for Highlighted Fields option.

6. Activate the Prepare Forejgn Language Expressions for Speech Output option. This way you
can specify that well-known English terms are specially tagged to ensure correct
pronunciation

7. Save the settings.
Note:

e The web client customizes itself automatically of the browser windows size. That means
that some areas are blanked temporarily, if the space is not sufficient. When using screen
reader programs, the web browser window should be maximized (Windows key + Up), SO
that all elements are in the tabulator order.

¢ If your screen reader offers a reading mode in the web browser (e.g. if you can use buttons
for the quick navigation in the web), it might be possible that you have to switch the mode
off and on again. Whether your screen reader requires your manual intervention, notice
whether the keyboard shortcuts of the Fabasoft Cloud work or not.

o If the Braille output of your screen reader makes a distinction between a level one and a
structured representation, you must set the structured one.

Useful JAWS Settings
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The following JAWS settings permit an optimum work with the Fabasoft Cloud.
Perform the steps below:

1. Open the Fabasoft Cloud in your preferred web browser.

2. Open the JAWS quick settings with the Jaws-key + v. All the necessary settings can be
found in the last category “Personalize Web Settings”. This means that the settings only
apply for the Fabasoft Cloud.

Deactivate the setting “Document automatically reads”.
4. Select for the setting “Document presentation mode” the value “Simple layout”

If you have changed any other general JAWS web settings, you may have to restore the
default settings.

15.6 Accessibility Exceptions

The following functionality is restricted or not accessible:

e BPMN Editor

e Document View

e Content of Widgets

e Adjusting Screenshots (Support Button)

BPMN Editor

The BPMN editor is used to graphically model business processes that can be executed directly.
The BPMN editor is displayed when you open a BPMN process diagram, BPMN choreography
diagram or BPMN conversation diagram.

Keyboard operation and screen readers are not supported (graphical modeling is only possible
using the mouse).

Document View

The document view is used for the integrated PDF preview of documents. The document view is
displayed in the content area when you navigate in a document.

Screen readers are not supported (document structure and navigation are not accessible).

Alternatively, documents can be opened in the corresponding third-party product (if permitted).

Content of Widgets

Widgets show preview lists or graphics and serve in dashboards as access points to the
corresponding areas. For example, widgets are displayed directly on “Home" in the content
view.

Keyboard operation and screen readers are not supported (access to preview lists is not
possible and there are no text alternatives for graphics).

Alternatively, you can navigate into the widget to access the complete, accessible information.

Adjusting Screenshots (Support Button)

For support requests, a screenshot can be edited and transmitted. The support request opens
when you use the “Support” button.

Fabasoft Cloud 161



Keyboard operation and screen readers are not supported (cropping, highlighting and
blackening is only possible with the mouse).

16 Keyboard Operations

Besides working with the mouse also keyboard operation is supported. In this chapter, the
available keyboard shortcuts are grouped according to the application areas.

Note:
e On Apple macOSs, the cmd key is treated the same as the ctr1 key on Microsoft Windows.

e On Apple macOS, the keyboard shortcuts ctr1 + [0-9] are used instead of a1t + [0-9].

16.1 Common Keyboard Operations

Shortcuts Action

Tab Focusses the next control.

Shift + Tab Focusses the previous control.

Enter Executes the corresponding action on the selected element (e.g.
press a button or execute a menu command and open an
object).

Space Bar Activates the selected element.

Menu Key OrF Opens the context menu of the selected element (if existing).

shift + F10

ieftr ;ight' Ui, Dens: Navigates in symbol bars, object lists and structures.
ome, En

Note: In a search result list, press the £nd key to select the last
object currently visible. If there are further results, the reload is
started automatically.

16.2 Global Navigation

All controls are located in tab order. This means you can move from one control to other
forward and back.

Shortcuts Action
Tab Navigates to next menu command.
Shift + Tab Navigates to previous menu command.

(szrl + F6, Ctrl + Shift +|Navigates circular between the areas:

e Home (logo)

e search field
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e tool menu
e actions
e right tool area (if opened)

e content area

Alt + 0 Activates to “Support” button.

Alt + 1 Navigates to “Home".

LG S 2 Navigates to the object list in the content area.
Alt + 3 Navigates to the actions.

Alt + 4 Navigates in the search field.

Alt + 5

Navigates in the opened context-independent tool or in the
tool selection if no context-independent tool is opened.

ALt + 6 Navigates in the “Options” tool bar.

Alt + 9 Activates to “Quick Access” button.

Esc Navigates back step by step until finally the main area is
reached.

Within individual complex controls like menus or structure views, you can use the arrow keys to
navigate in e.g. sub-menus or tree branches.

16.3 Top Bar

In the top bar, the following shortcuts are available.

Shortcuts Action

Right, Down Navigates to next menu command. If the last menu command
is selected, it navigates to the first one.

Left, Up Navigates back. If the first menu command is selected, it
navigates to the last one.

End Navigates to first menu command.
e Navigates to last menu command.
Enter or Space Bar Activates the selected element.
16.4 Menus

The following menus are available:
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Down In the menu bar: Opens the selected menu and selects the first

Menu Bar (of the object list)
The menu bar can be activated via the basic settings and is located above the content area.

Tools
Is used for displaying and reverse clipping of tools.

Actions
Provides the most important actions for the displayed list or object.

User
The user menu with your name is located in the top bar and is used for defining basic
settings.

Locations
The data location menu is located in the top bar and can be used to switch between data
locations.

Sorting
The sorting menu is located right above the content area. It can be reached by pressing a1t
+ F9, if the focus is within the object list.

Column Menu
Can be opened via the columns in the content area.

Context Menu
Offers commands for the selected objects. Can be opened via the context menu key Or
Shift + F10.

Shortcuts Action

entry.

In an open menu: Select the previous entry. If the last first is
selected, it steps to the last entry.

In the menu bar: Opens the selected menu and selects the first
entry.

In an open menu: Select the next entry. If the last entry is
selected, it steps to the first entry.

Right In the menu bar: Selects the next entry. If the last entry is

selected, it steps to the first entry.

In an open menu: Opens the submenu if selected. Otherwise
opens the next menu and selects the first entry.

Left In the menu bar: Selects the previous entry. If the first entry is

selected, it steps to the last entry.

In an open menu: Opens the previous menu and selects the

first entry.
In a submenu: Closes the submenu and selects the first entry in
the menu.

Enter O Enter Or Space Bar executes the selected menu command or
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Space Bar the assigned submenu is opened.

HEE Esc closes the opened submenus and/or menus hierarchically.
On top-level either nothing happens (actions, tools) or it will
navigated in the content area (menu of the object list)

16.5 Content Area
The most important control in the content area is the object list. It includes the title bar and the
menu bar, positioned directly above it.
The object list has the following different views:
e Cards
e Content
e Details
e Preview

Single objects are displayed in the so-called Document View.

16.5.1 Overview of Currently Available Shortcuts

For every Teamroom and folder within Teamrooms you can change the view of the object list
between content view, details and preview. Therefor open the desired Teamroom or folder. The
view can be changed via the menu or context menu command “Change View". The context
menu command is only available, if no object is selected.

Selecting, Copying and Pasting

Shortcuts Action

Arrow keys, Home Or End |Focusses and selects only one entry.

ctrl + Arrow keys, Ctrl +|Navigates to an entry without selecting. All selected entries are
Home, Ctrl + End .
still selected.

Alt + Shift + UpOr bown |In grouped lists, navigates to the previous or next group
header (if present).

Page Up, Page Down Scrolls up or down (web browser functionality) and sets the
focus on the first or last entry on the displayed list part.

Character string The input of the first or from initial letters of the object name
selects the suitable object, if available.

cpaes Boi Selects the focused entry. This is especially useful directly after
navigating in a list. The focus is initially on the first entry that
has not yet been selected.

Ctrl + Space Bar Places or removes the selection from the focused entry, if the
focus is in the first cell.
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Shift + Arrow Keys Extends the selection.
The extension passes differently in all views (see below).
Shift + Home Extends the selection to the beginning of the list.
Shift + End Extends the selection to the end of the list
Ctrl + A Selects all entries in an object list
ctrl + C Copies the selected objects to the clipboard
Ctrl + X Cuts the selected objects
Ctrl + Vv Pastes objects from the clipboard
Actions
Enter Opens the selected object
Del Moves the selected Teamroom objects to the wastebasket or

removes them from the object list, if they are pointers.

Backspace Navigates one page back in the web browser history.

Ctrl + Enter Opens the attribute editor.

F2 Switches selected cell between editor and navigation mode.
BLE o B Navigates to the column header, if the detail view is shown,

otherwise to the sorting button.

Alt + F10 Navigates to the menu of the object list.

16.5.2 Shortcuts for the Card View

The card view, for example, is used by default in the personal folder.

Shortcuts Action

Down Navigates to the card directly below the currently selected card.
If no such card is available, it navigates to the last card in the
row.

Up Navigates to the card directly above the currently selected card.

Left Navigates to the next card in read order.
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Right Navigates to the card before in read order.

End Navigates to last card in object list.

Home Navigates to first card in object list.

Shift + Down Selects all cards below the current card in read order.
Shift + Up Selects all cards above the current card in read order.
Shift + Right Extends the selection to the next card.

Shift + Left Extends the selection to the card before.

Shift + Home Extends the selection to the first card.

Shift + End Extends the selection to the last card.

16.5.3 Shortcuts for the Content View

Within Teamrooms, the content view is used by default.

Shortcuts Action

Down Navigates to next object.

L2 Navigates to previous object.

End Navigates to last object.

Home Navigates to first object-

Shift + Down Extends the selection to the next object.

Shift + Up Extends the selection to the previous object.

Shift + Home Extends the selection to the first object.

Shift + End Extends the selection to the last object.

Alt + F9 Navigates to sorting button.

Alt + F10 Navigates in the menu bar of the object list, if the menu bar is
enabled.

16.5.4 Shortcuts for the Details View

Within Teamrooms, the “Details” view can be used.

Shortcuts Action
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Down One cell down within the current column.

Ue One cell up within the current column.

Left One cell left within the current row.

Right One cell right within the current row.

Home First cell of the current column.

End Last cell of the current column.

Ctrl + Down Next cell within the current column without selecting it.

Ctrl + Up Previous cell within the current column without selecting it.
Ctrl + Left Selects the current row and additionally focusses the first cell.
Ctrl + Right Focusses the last cell of the current row.

Shift + Down Selects an additional cell below the current cell. If the focus is in

the first cell, the entire rows are selected.

Shift + Up Selects an additional cell above the current cell. If the focus is in
the first cell, the entire rows are selected.

Shift + Left Selects the whole row without changing the current focus.
or
Shift + Right

Shift + Home Selects all lines above the current line and the current line. If
the focus is in the first cell, the entire rows are selected.

Shift + End Selects all lines below the current line and the current line. If
the focus is in the first cell, the entire rows are selected.

ALt + FI Navigates to the column header.
Alt + F10 Navigates in the menu bar of the object list, if the menu bar is
enabled.

The column filters can be accessed via the column header. The values filter for date values is
represented by a tree structure. Only one tree element ever has a tabindex. The arrow keys,
pPos 1 and End can be used to navigate between the tree elements. Screen readers can
determine whether an element is expanded via the aria-expanded attribute. If subordinate
tree elements have only been partially selected (for example, only one day of several in a
month), then the superordinate tree elements have the status "partially selected". This is made
clear when using screen readers with the attribute aria-checked="mixed". When a partially
selected element is selected, all subordinate elements are selected.
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16.5.5 Shortcuts for Table Handling

In the detail view, the table handling can be activated via the button “Table Handling" in the
column header (a1t + F2) as an alternative editing mode. Thus, the controls work similarly to a

spreadsheet program.

Note: When switching to the table editing mode, a warning is displayed that entering text in
table cells can in some cases open a dialog and set the focus to this dialog. You can disable the
warning directly. In the basic settings on the “Accessibility” tab, the warning can be enabled
again using the Warn About Context Changes field.

F2

Shortcuts Action

Enables editing the marked cell or saves the changes if editing
already in progress.

Note:

e |n text fields, the cursor is at the end of the text.

e The cell remains marked after editing is finished.

Typing letters or numbers

Enables editing of the marked cell.

Note: In text fields, the current value is deleted.

Tab

e Marks the next editable cell to the right.
Note: This depends on the setting “Include all Fields in Tab
Order”.

¢ Navigates from the last cell of a row to the first cell of the
next row.

¢ Navigates from the last cell of the last row to the next tab
stop on the page and leaves the table.

e If the current cell is being edited, its content is saved.

shift + Tab

e Marks the next editable cell to the left.
Note: This depends on the setting “Include all Fields in Tab
Order”.

o Navigates from the first cell of a row to the last cell of the
previous row.

o Navigates from the first cell of the row to the previous tab
stop and leaves the table.

o If the current cell is being edited, its content is saved.

Enter

o If the current cell is being edited, its content is saved.

e Marks the next editable cell below.
Note: This depends on the setting “Include all Fields in Tab
Order”.

¢ Inthe last row, the mark stays in the current cell.

Shift + Enter

e Ifthe current cell is being edited, its content is saved.

e Marks the next editable cell above.
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Note: This depends on the setting “Include all Fields in Tab
Order".

¢ In the first row, the mark stays in the current cell.

Right ¢ Marks the next cell to the right.
¢ In the last column, the mark stays on the current cell.
¢ If the current cell is being edited, navigation within the cell
moves to the right.
e Group header:
o Opens a collapsed group.
o Navigates from an expanded group header to the first cell
of the first row of the group.
Left e Marks the next cell to the left.
e In the first column, the mark stays on the current cell.
¢ If the current cell is being edited, navigation within the cell
moves to the left.
e Group header:
o Closes an expanded group.
o Navigates from a collapsed group header to the first cell
of the last row above (or to the group header above)
Up e Marks the cell above.
e Upon reaching the first row, the mark stays there.
o If the current cell is being edited, navigation within the cell
moves upwards.
Down e Marks the cell below.
e Upon reaching the last row, the mark stays there.
o If the current cell is being edited, navigation within the cell
moves downwards.
Esc ¢ Ends editing without saving the changes (the focus remains).

¢ If the current cell is not being edited, the selection is
removed (the focus remains).

Space Bar

Enables editing of the marked cell (e.g. text field, drop-down
menu, dialog).

Note: In text fields, the current value is deleted.

End

Navigates to the last cell of the column.

Posl

Navigates to the first cell of the column.

Ctrl + Right

Navigates to the last cell of the row and marks it.

Ctrl + Links

Navigates to the first cell of the row and marks it.
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Ctrl + Up

Focusses the cell above (without selection).

Ctrl + Down

Focusses the cell below (without selection).

Ctrl + Space Bar

Activates or deactivates the selection.

Shift + Arrow Keys

Extends the selection.

Alt + F9

Navigates into the column header.

Alt + F10

Navigates into the menu bar of the object list if it is displayed.

16.5.6 Shortcuts for the Document View

Shortcuts

Ctrl + Shift + Right

Action

Opens the preview of the next element in the
list.

Ctrl + Shift + Left

Opens the preview of the previous element in
the list.

Context Menu Key, Shift + F10 Opens the context menu for the object

displayed in the preview.

16.6 Tools

Tools are displayed in the left area and can be opened directly with the key combinations. The
focus is always moved into the tool. You can find these commands in chapter 16.2 “Global

Navigation”.

16.6.1 Navigation (Tree View)

The tree view allows the navigation in Teamroom and folder hierarchies.

Shortcuts Action

Down Navigates to the next visible entry.

Up Navigates to the previous visible entry.

Right Expands the tree node or navigates to the first entry of the
open node.

Left Navigates to the parent node if an entry is selected in an open
path.
If an expanded node is selected it will be closed.

End Navigates to the last entry.
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—— Navigates to the first entry.

16.6.2 Permissions

The “Permissions” tool for managing team members is very similar to the “Navigation” tool in
terms of keyboard operation. The only difference is that the main nodes are always open. To
speed up the navigation of many members the arrow keys navigate up and down at the top
level directly between the highest nodes not to the next or previous entry. The deeper levels
behave identically to the tree navigation.

16.7 Forms

The Fabasoft Cloud uses forms to display object properties and settings.

Note: Screenreader users should activate the /nclude All Fields in Tab Order option in the Basic
Settings (see chapter 15.1 “Notes on Keyboard Operations"”). This way also read-only fields are
included in the tab order.

Shortcuts Actions

Tab Navigates to the next field.

Shift + Tab Navigates to the previous field.

Enter Saves and closes the form.

Esc Closes the form without saving.

Ctrl + Fl Navigates to the help text of the field, if exists. With Esc the focus

switches back to the field.
Note for screen reader users:

The help area is marked as “document”. When moving the focus to
the help, the screen reader should read the help text. It might be
possible that you have to switch the screen reader in read mode.
For JAWS press ctrl + Y followed by the p1us key on the number

pad.
Ctrl + F6 Navigates to the next form area.
Ctrl + Shift + F6 Navigates to the previous form area.
Alt + 0 Activates the “Support” button.
Alt + 2 Navigates in the first or previously focused field, if the focus is on a

form button or on a tab.

Alt + 7 Navigates to the tabs (if present).

Alt + 8 Navigates to the form buttons.
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Note: In aggregate lists, generally the same key combinations apply as for the details view of
lists. However, the difference is that r2 in aggregate lists toggles the entire list between edit and
navigation mode and not just a cell.

16.8 Process View

The process view, as it can be found on the “Processes” tab, for example, has been
implemented as an open, horizontal tree view. The difference to a standard tree view, however,
is that the nodes cannot be collapsed and the main sequence of entries is not from top to
bottom, but from left to right.

Shortcuts Actions

Right Navigates to the next element.

Left Navigates to the previous element.

Down Navigates to the below element.

e Navigates to the above element.

Home Navigates to the first element.

End Navigates to the last element.

Ctrl + Right Navigates to the next element on the same level.
Ctrl + Left Navigates to the previous element on the same level.
Ctrl + Shift + Left Navigates to the superordinate element.

Context Menu Key, Opens the context menu of the selection.

Shift + F10

Alt + M Marks the currently focused element.

Alt + P Navigates to the marked element.

Alt + G Navigates to the first element with “Startable” state.

16.9 HTML Editor

The HTML editor for formatting text supports almost the same keyboard shortcuts in the text
area as Microsoft Word.

Some of the most important shortcuts are listed below.

Shortcuts Actions

Alt + F10 Enters the editor toolbar.
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Tab Moves to the next editor toolbar button group.

Shift + Tab Moves to the previous editor toolbar button group.

Right Moves to the next editor toolbar button within the group.

Left Moves to the previous editor toolbar button within the group.

Enter OF Space Bar Activated the action of the selected button and moves the focus
from the editor toolbar back to the text area.

Esc Moves the focus from the editor toolbar back to the text area
without any action.

Ctrl + B Applies bold formatting to a text fragment.

Ctrl + I Applies italic formatting to a text fragment.

sleed s T Applies underline formatting to a text fragment.

Ctrl + L Opens the link dialog window.

17 The Fabasoft Cloud Client

The native Fabasoft Cloud Client provides following advantages:

17.

Edit documents directly via your web browser
Import documents with drag and drop

Synchronize documents with the file system

1 Overview

By clicking on the notification icon of the Fabasoft Cloud Client the list of recently used

doc

uments is opened.

Header

If you work with multiple data locations or installations, you can switch between them via
the header. By clicking on the question mark, the support dialog is opened. Via the gear
icon, you can access the options.

Note: If you are working with test systems and different users, a large number of entries
that are no longer required may accumulate. To delete entries that are no longer used, you
can select the desired entries under “More” > “Manage” and delete them.

Footer
In the footer, you can initially start synchronizing or the current state of the synchronization
is shown. By clicking on the synchronization state, you can pause the synchronization.

Document overview
The open, recently edited, renamed, downloaded or uploaded documents are displayed
chronologically. If an error occurs when synchronizing, the affected file is shown with a red
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background.
Via the context menu of the respective document you can

o view the document in the Windows Explorer (if it is synchronized),
o view the document in the web client or

o copy a link to the document into the clipboard.

In the “About” dialog it is shown whether the Fabasoft Cloud Client is current (green check
mark). If this is not the case, you can start the update directly.

17.2 Synchronization

The Cloud Folder allows you to synchronize folder structures with the file system.
The Fabasoft Cloud Folder offers two types of synchronization:

e Entire Home
When you synchronize your entire home, navigating through the folder structure in the file
system automatically synchronizes the contents of the current folder.

e Dedicated Synchronized Folder
If you use a dedicated synchronized folder, the entire contained folder hierarchy is
synchronized to the file system by default.

Note: The Cloud Folder supports local NTFS 3.1 file systems on Microsoft Windows, and local
HFS+ or APFS file systems on Apple macOS. Each Cloud Folder is assigned to one user and one
device only. Hence, several users cannot synchronize into the same Cloud Folder, and one user
cannot synchronize from several devices into the same Cloud Folder. The Cloud Folder is not
supported on Microsoft Windows server operating systems.

17.2.1 Using the Synchronization for the First Time

Depending on the organization settings, you can decide whether you want to synchronize your
entire “Home" or just one dedicated folder with the file system.

To activate the dedicated synchronized folder, proceed as follows:

1. Click the account menu (your user name) and then “Advanced Settings” > “Synchronization”.
2. Click the “Enable Synchronized Folder” button.

3. Click the “Enable” button. All previously synchronized data is removed from your devices.

4. Click “Close".

The dedicated synchronized folder is automatically stored on “Home".

Note: Deactivating the dedicated synchronized folder works in the same way (“Disable
Synchronized Folder” button).

Start Synchronization

On the notification icon in the task bar, execute the “Open Cloud Folder” context menu
command.

e If you synchronize “Home", the top level is synchronized to the file system. When you
navigate in a folder, the contents of this folder are synchronized (at the first level). You can
also synchronize entire folder hierarchies (see next chapter).
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¢ If you use a dedicated synchronized folder, the entire folder hierarchy is synchronized to
the file system by default.

e The successful synchronization is visualized by a green checkmark.

Now you can edit the files and folders either in the web client or in the file system.

17.2.2 Selecting Folders and Documents for Synchronizing

You can select folders and documents for synchronization as follows:

¢ If you synchronize “Home", the contents of the current folder are automatically
synchronized and kept synchronized as you navigate through the folder structure.
Note: If you use a dedicated synchronized folder, the entire folder hierarchy is
synchronized to the file system by default.

e To synchronize an entire folder hierarchy and keep it synchronized, you can use the “Cloud

Folder” > “Keep Folder Up to Date” context menu command for folders.

e Synchronized folders can be excluded from synchronization using the “Cloud Folder” >
“Remove Local Files” context menu command. Thereby the local files of the entire folder

hierarchy will be deleted. This has no effect on the corresponding objects in the Fabasoft

Cloud.
Note:

e Synchronization takes place automatically in the background, but can be deactivated via the

options dialog of the notification icon ("General” tab > “Cloud Folder” > Offfine field).

¢ If you no longer need synchronization, you can remove the Cloud Folder from the file
system using the “Delete Folder” button in the options dialog of the notification icon.

¢ Synchronization can also be started in the web client. To do so, navigate to the desired

Teamroom or folder and carry out the “Synchronize” action. The action is only available if

the Teamroom or folder is stored in a hierarchy starting from your “Home".

If you use a dedicated synchronized folder, the Teamroom will be stored in the dedicated

folder, too.

17.2.3 Symbols for Visualizing the Status

Notification Symbol

The notification icon displays status information about the synchronization (e.g. paused). When

using multiple Cloud Folders, the status refers to the currently selected Cloud Folder.
File System
Following symbols visualize the synchronization status in the file system:

¢ Not synchronized
Not synchronized folders are displayed without any special visualization.

e Synchronized
Synchronized folders and documents are marked with a green check mark.

o Keep folder up to date

Folders in which the entire hierarchy should be synchronized are represented with a blue

border.
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e Modified
The element has been modified locally or a synchronization process is currently carried out.

e Error
If an error occurred, the context menu provides corresponding commands under “Resolve
Error”.
In order that changes and errors can be easily identified, they are displayed over the entire
hierarchy.

17.2.4 Context Menu of the Notification Symbol

In the context menu of the Fabasoft Cloud notification symbol following commands that are
relevant for the Cloud Folder are available:

e Open Cloud Folder
Opens the folder in the local file system that was created for synchronizing.

e Synchronize
Starts the synchronization process manually.

Note: If you work with different cloud installations, you can also choose the system that should
be synchronized in the context menu.

17.2.5 Context Menu of the Cloud Folder

In the context menu of synchronized elements, the following commands are available under
“Cloud Folder™:

¢ Show in Cloud Web Client
The web client is opened and the element is selected.

e Show Properties in Cloud Web Client
Opens the properties of the element in the web client.

e Copy Link
Copies the link to the respective object to the clipboard.

e Keep Folder Up to Date
The entire folder hierarchy is synchronized and is kept synchronized.

e Remove Local Files
The local files are removed. This has no effect on the corresponding elements in the
Fabasoft Cloud.
If a folder contains unsynchronized documents, an error will be displayed. When you
execute the context menu command again, the unsynchronized documents are removed
and a backup is stored in \Users\<user>\Documents\My Recovered Documents.
Note: If you want to cancel the download of a too large file, you can execute this context
menu command on the parent folder.

17.2.6 Resolving a Conflict

If a document has been changed in the web client and file system simultaneously, this is
detected during synchronization. For visualization, a yellow call sign is displayed on the
notification icon and in the web client on the document.

To resolve the conflict via the file system, proceed as follows:

Fabasoft Cloud 177



1. Click the notification icon.
2. Click “Resolve Conflict” for the corresponding document.

In the following dialog, you can choose whether you want to continue using the current
version or the last version before the conflict. The content of the discarded version is still
accessible via time travel and can be taken over manually, if necessary.

Alternatively, you can execute the “Resolve Conflict” context menu command in the web client.
If you edit the document using the web client, the conflict dialog opens automatically.

17.2.7 Error Handling

If an error occurred, the context menu provides corresponding commands under “Resolve
Error”. In order that errors can be easily identified, they are displayed over the entire hierarchy.

17.2.8 Document Exchange via LAN

By default, synchronization or editing/reading of documents is carried out over the internet
with the Fabasoft Cloud. Depending on your amount of data and your internet access, this may
take some time.

Use document exchange via LAN to achieve a significant reduction in the required internet
bandwidth and a significantly increased speed. When data in the Fabasoft Cloud has changed,
all Cloud Folders in the local network are contacted first, whether the changed data is already
available locally. If this is the case, the data is synchronized over the LAN and not over the
internet. After the data was modified it will be stored for 20 minutes on the client to allow other
clients to retrieve the edited document via LAN. Security is ensured in both cases by encryption.

To be able to use document exchange via LAN, you have to enable it:

1. Click the account menu (your user name) and then click “Advanced Settings” > “Fabasoft
Cloud Client".

2. Enable the Al/low Document Exchange via LAN option.

If necessary, define trusted networks for document exchange via LAN.

If no network is configured, document exchange via LAN is possible on Microsoft Windows
in all private networks and on Apple macOS in all networks.

If one or more networks are configured, document exchange via LAN is only enabled in
these networks (connection to the Fabasoft Cloud must be possible). Define one IPv4
address or IPv4 address range per line (in CIDR notation, e.g. 198.51.100.0/24).

4. Click “Next".
Note:

o Files will be provided via LAN without any access check, but the requesting user must know
the object address, the hash and the modification date of the requesting file. Since this
information must be provided by the requesting user, it is assumed that the user has
access to the object within the Fabasoft Cloud to retrieve the information from the server.

e The clients must be connected to both, the LAN (same subnetwork) and the Fabasoft Cloud.

e The communication uses the TCP port 17096 and the IP multicast address 224.0.0.202 or
ff02::1 (local subnetwork). If necessary, appropriate settings must be made in the firewall. If
you are encountering problems with document exchange via LAN, please contact your
network administrator with this information.
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In the Windows firewall, for example, two inbound rules can be defined (one for the TCP
protocol and one for the UDP protocol):

o Program:
C:\Program Files\Fabasoft\Cloud\x64\FabasoftCloudUI.exe (Fabasoft Cloud
Enterprise Client)
C:\Users\<username>\AppData\Local\Fabasoft\x64\FabasoftCloudUI.exe (Fabasoft
Cloud Client)

o Local address, remote address, local port, remote port, authorized users, authorized
computers: any

o Protocol: Tcp or upp

¢ You may provide the data permanently on a dedicated Microsoft Windows device with a
specific user without an interactively logged in session. For this purpose the Native Client
Service can be installed (see https://help.cloud.fabasoft.com/index.php?topic=doc/Fabasoft-
Cloud-Client/microsoft-windows.htm#native-client-service). After installing the Native Client
Service on the device open the cloud folder via the notification icon and set a password for
applications. Synchronize the desired folders with the documents that you want to make
available to other users in the network efficiently.

17.2.9 Synchronization Exceptions

Excluded Files

To avoid the temporary files from third-party products are uploaded, there are following
synchronization exceptions:
¢ Hidden files.

¢ Files that start with ~wrD, ~WRL, ps Or ppt, followed by at least one decimal or hexadecimal
(upper case) digit and followed by . tmp (uppercase and/or lowercase).

e Files that start with ~, followed by an arbitrary string and followed by .id1xk.
o Files that start with acr, followed by an arbitrary string and followed by . tmp.

e Files that start with a least one decimal or hexadecimal (uppercase) digit and followed by
.tmp (Uppercase and/or lowercase).

¢ Files that consist solely of digits (decimal or hexadecimal digits in capital letters). However,
files beginning with “000” followed by any number of decimal digits are excluded from this
rule.

e Files that start with aa, followed by a lower case character, followed by five digits and
optionally followed by a string that also matches the previously stated rule.

e Files that start with 1con follow by a “carriage return” (only Apple macOS).
Note:

e The PDF representation for “Search” is not displayed.

o Folders with more than 10000 objects cannot be synchronized. A corresponding error is
displayed.

Additional file information

Additional file information is not synchronized and will be lost. However, Apple macOS file tags
are synchronized.
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17.2.10 Configuration in the Web Client

Which objects are synchronized on which devices can also be seen in the web client.

1. Open the web client.

2. Click the account menu (your user name) and then click “Advanced Settings” >
“Synchronization”.

3. Onelineis displayed for each device on which you keep objects up to date. Click on the
magnifying glass symbol to see the details.
Note: You can delete all settings using the "Remove Synchronization Settings" button.

o Device
Shows the ID of the respective device.

o Included Objects
Shows the folders that are to be kept up to date.
Note: If a folder is kept up to date, all subordinate objects are automatically
synchronized.

o Excluded Objects
Shows folders that are not synchronized even if they are in a folder kept up to date.

4, Click “Close”.

17.3 Integration in Microsoft Word

The integration is available for Microsoft Word, Microsoft Word for the web, and Microsoft
Word for Mac and gives you the following options.

17.3.1 Microsoft Word

When using Microsoft Word on Microsoft Windows, the following functionality is available.

Buttons

You can perform actions in the Fabasoft Cloud directly from Microsoft Word. The “Fabasoft
Cloud” tab offers the corresponding actions depending on the context.

H oS-
File Home Insert Fabasoft Cloud Design Layout Refer
& [ Copy Link # Create Public Link ﬁ @ =
b= Send Link [ Rename -T
Open Show | Insert Insert
g Release Version Elprnperties inWeb | Text~ Fiekd~-
Fabasoft Cloud Document Document
e Open

You can select the document in the Fabasoft Cloud and open it in Microsoft Word.

e Upload
If the current document was not opened via the Fabasoft Cloud, it can be uploaded to the
Fabasoft Cloud. You can select a location in the Fabasoft Cloud and continue processing
directly without having to close the document.
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Register

If the current document was not opened via the Fabasoft Cloud, it can be registered in the
Fabasoft Cloud. You can select the registration type (e.g. digital asset) and a location in the
Fabasoft Cloud and continue processing directly without having to close the document.

Copy Link
You can put a link to the document in the Fabasoft Cloud in the clipboard.
Create Public Link

You can create a public link to the document. Users can access public links without logging
in to the Fabasoft Cloud.

Send Link
You can create an e-mail draft with a link to the document in the Fabasoft Cloud.

Rename
You can change the name of the document in the Fabasoft Cloud.

Release Version
You can create a version of the document in the Fabasoft Cloud and provide it as a release.
Note: Unsaved changes are saved automatically before the version is created.

Properties
You can edit the properties of the document in the Fabasoft Cloud.
Show in Web
Shows the document in the web client.
Insert Text
Note: For more information on text modules, see chapter 7.7 “Defining Text Modules” and
chapter 7.8 “Using Text Modules”.
o Property
You can insert certain property values as updatable DocProperties.

o Plain Text Module
You can insert available text modules unformatted.

o Formatted Text Module
You can insert available text modules formatted.

o Text Module Placeholder
You can insert text module placeholders in templates.

o Linked Text Module
Inserts a linked text module.
Replace Text Module Placeholder
You can replace the existing text module placeholders of the document with the contents of
the text modules.
Remove Text Module
Removes the selected text module.
Modify Text Module
Allows the text module to be changed in the context of the current document (if the user is
authorized to do so). Text modules that are marked for modification are no longer updated
automatically.

Reset Text Modules
Allows to reset changes of the focused text module or all text modules. The current,
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released content of the text modules is taken over and the text modules are automatically
updated again in the future.

¢ Dissolve Text Modules
Allows you to dissolve the focused text module or all text modules (change rights required).
The current content of the text modules, which may have been changed in the context of
the document, is taken over as continuous text and the links are removed.

e Enable Fields/Insert Field
You can insert certain property values as updatable fields. If you change the value of an
editable field in the Word document, the changed value is taken over into the property.
Note: The “Insert Field” > “Refresh Values” menu command can be used to refresh the field
values without having to close the document.

e Insert Signature Area
If digital signatures are enabled in your cloud organization, you can define signature areas.

e Context (Domain and User Account)
For documents that have not been opened via the Fabasoft Cloud, the context for the
buttons can be selected. If you change the context in Microsoft Office, the context is also
changed in the Fabasoft Cloud Client and vice versa.

Note:

o If the “Fabasoft Cloud” tab is not displayed, ensure that the COM add-ins “Fabasoft Cloud
Domain Hot-Switch” and “Fabasoft Cloud Word Extension” are enabled in Microsoft Word
(“File” tab > "Options” > “Add-ins").

¢ Not all of the buttons listed above are available in the other Microsoft Office applications.

e The following buttons are also available in Microsoft Office applications under “Open” on
the “Fabasoft Cloud” tab:

o Open document (for your Cloud favorites and history)
Allows you to quickly open important or recently used documents for reading or editing.

o Select document
Allows you to select a document from the folder structure of your home area.

Fields
The following property types can be edited in the Word document:
e Integer
e String (also multi-line)
e Date
e Date and time
e Boolean
e Enumeration
The other property types are displayed as read-only fields.
Note:

¢ The short date format defined in the operating system is used for date fields.

e When saving the content, the fields in the PDF view are updated automatically, regardless
of whether the PDF view is generated on the server or on the client.
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¢ On the “Content” tab, in the Update PDF Content on Metadata Change field you can define
whether the PDF view is newly generated on the server when the metadata of the object is
changed. This way, fields that refer to the metadata of the document are displayed with
current values.

e When importing a Microsoft Word document that already has metadata embedded as
fields, the field values are stored in the properties of the Word object. If metadata of
existing objects would change (e.g. when replacing the document), a dialog allows you to
specify which field values should be stored.

User-Defined Properties as Fields

When you add a user-defined form to a Word document, you can insert your defined
properties as fields in the Word document.

17.3.2 Microsoft Word for the Web

To use the integration in Microsoft Word for the web, you must add the Office add-in “Fabasoft
Cloud"” from the Microsoft Store to Microsoft Word for the web (“Insert” menu > “Add-ins” >
“Office Store” > “Fabasoft Cloud”). The “Fabasoft Cloud” area can be opened via the Cloud
ribbon button.

Note: In the organization policies, the Value for SameSite Attribute of Session Cookie must be
set to “None” to be able to use the integration.

When using Microsoft Word for the web, the following functionality is available.

Buttons

You can perform actions in the Fabasoft Cloud directly from Microsoft Word for the web. The
“Fabasoft Cloud” area offers the corresponding actions depending on the context.

e Send Link
You can create an e-mail draft with a link to the document in the Fabasoft Cloud.

e Show in Web
Shows the document in the web client.

e |nsert Text

o Plain Text Module
You can insert available text modules unformatted.

o Text Module Placeholder
You can insert text module placeholders in templates.

e Insert Signature Area
If digital signatures are enabled in your cloud organization, you can define signature areas.

e Login/Logout
You can log out and log in if needed.

17.3.3 Microsoft Word for Mac

To use the integration in Microsoft Word for Mac, the Fabasoft Cloud Client must be installed
and you must add the Office add-in “Fabasoft Cloud” from the Microsoft Store to Microsoft
Word for Mac (“Insert” menu > “Add-ins” > “Office Store” > “Fabasoft Cloud”). The “Fabasoft
Cloud” area can be opened via the Cloud ribbon button.
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When using Microsoft Word for Mac, the following functionality is available.

Buttons

You can perform actions in the Fabasoft Cloud directly from Microsoft Word for Mac. The
“Fabasoft Cloud” area offers the corresponding actions depending on the context.

Send Link
You can create an e-mail draft with a link to the document in the Fabasoft Cloud.

Show in Web
Shows the document in the web client.

Insert Text
Note: For more information on text modules, see chapter 7.7 “Defining Text Modules” and
chapter 7.8 “Using Text Modules”.

o Property
You can insert certain property values as DocProperties. These must be updated
manually.

o Plain Text Module
You can insert available text modules unformatted.

o Formatted Text Module
You can insert available text modules formatted.

o Text Module Placeholder
You can insert text module placeholders in templates.

o Linked Text Module
Inserts a linked text module.

Replace Text Module Placeholder
You can replace the existing text module placeholders of the document with the contents of
the text modules.

Remove Text Module
Removes the selected text module.

Modify Text Module

Allows the text module to be changed in the context of the current document (if the user is
authorized to do so). Text modules that are marked for modification are no longer updated
automatically.

Reset Text Modules

Allows to reset changes of the focused text module or all text modules. The current,
released content of the text modules is taken over and the text modules are automatically
updated again in the future.

Dissolve Text Modules

Allows you to dissolve the focused text module or all text modules (change rights required).
The current content of the text modules, which may have been changed in the context of
the document, is taken over as continuous text and the links are removed.

Insert Field
You can insert certain property values as updatable fields.

Insert Signature Area
If digital signatures are enabled in your cloud organization, you can define signature areas.
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e Login/Logout
To use the functionality, you need to log in to the Fabasoft Cloud for each newly opened
document due to technical restrictions.

17.4 Integration in Microsoft Outlook

The integration in Microsoft Outlook gives you the following options.

Note: The “Fabasoft Cloud” group is only available if the “Fabasoft Cloud Outlook Extension”
add-in (“File” > “Options” > “Add-ins") is enabled.

Display Cloud Area

On the “Start” tab, in the “Fabasoft Cloud” group, you can use the “Home" or “Worklist” button
to display your own task area in Microsoft Outlook. This gives you direct access to your home
area or worklist.

Upload E-Mails

On the “Start” tab, in the “Fabasoft Cloud” group, you can use the “Upload E-Mail” button to
import the selected e-mails in a Teamroom or folder. Alternatively, you can use the “Fabasoft
Cloud” > “Upload E-Mail" context menu command.

Note:

e When choosing the folder using the “Choose Folder” button, you can also create a new
Teamroom or folder.

e When uploading encrypted e-mails, you can decide whether to import the e-mail
unencrypted, for example, to make it readable by other team members. Encrypted e-mail
attachments cannot be decrypted.

Register

On the “Start” tab, in the “Fabasoft Cloud” group, you can use the “Register” button to register
the selected e-mails for example as digital assets. Alternatively, you can use the “Fabasoft
Cloud” > “Register” context menu command.

Replace Attachments With Links

When you compose an e-mail, you can upload attachments directly to the Fabasoft Cloud and
replace them with links. To do so, the “Replace Attachments With Links” button is available on
the “Message” tab.

To replace attachments with links, proceed as follows:

1. Compose an e-mail with attachments.

2. Place the cursor at the position where you want to insert the links.
3. Click the “Replace Attachments With Links” button.
4

In the Folderfield, select a Teamroom or folder where you want to store the attachments.
Alternatively, by clicking the “Choose Folder” button, you can navigate to the desired folder
or create a new folder or Teamroom. The e-mail recipients are added to the newly created
Teamroom with read access rights (can still be adjusted manually).

5. Click the “Add as Link” button, if you want to insert links for cloud users.
Click the “Add as Public Link” button, if you want to insert links that do not require
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authentication in the Fabasoft Cloud. The button is only available if the Teamroom allows
the creation of public links.

The attachments will be uploaded to the Fabasoft Cloud and the links will be inserted in the e-
mail.

Access Check

When you compose an e-mail, the “Check Access” button is available on the “Message” tab. This
enables you to check whether the recipients have access to the cloud objects linked in the e-
mail. You can perform the check manually using the “Check Now" button. Enable the “Always
Check on Send” option to perform the check automatically.

Automatically Upload E-Mails

You can connect a folder in Microsoft Outlook to the Fabasoft Cloud using the corresponding
context menu command. Thereby, you can specify the storage location for the e-mails in the
Fabasoft Cloud. In addition, you can define whether an own menu for copying or moving e-
mails to the folder should be displayed in Microsoft Outlook. When the copy menu is selected,
the original e-mails can optionally be assigned a category to indicate whether they have already
been copied.

E-mails that are stored in the folder manually or via a client-side rule are imported into the
Fabasoft Cloud and moved to the wastebasket in Microsoft Outlook.

Note:

e The e-mails must be stored directly in the folder and not in the subfolder with the
connection information.

e Server-side Outlook rules are not supported.

e Uploading e-mails in encrypted Teamrooms is not supported.

Contact Synchronization

You can synchronize contacts that you manage in the Fabasoft Cloud with Microsoft Outlook.
The “Open Cloud Address Book” command is available in the context menu of the Fabasoft
Cloud notification symbol. If you have not yet assigned a password for applications, you can
generate one directly. Your address book list is added in Microsoft Outlook under “Contacts”
and automatically kept synchronized. With the “Synchronize” context menu command of the
Fabasoft Cloud notification symbol, you can also perform the synchronization manually.

If you use contact management, you can add contact rooms and address lists to the address
book list via the “Add to Address Book List” context menu command. This means that these
contacts are also available in Microsoft Outlook.

Note:

¢ You can find your address book list under “Account menu (your user name)” > “Advanced
Settings” > “Address Book". Here you can manage your contacts and create additional
address books.

e Contacts can be synchronized from the Fabasoft Cloud to Microsoft Outlook and vice versa.

e To enable the synchronized contact folder to be used as an e-mail address book in
Microsoft Outlook, for example when sending e-mails, proceed as follows: In Microsoft
Outlook, navigate to the desired contact folder (e.g. in the “People” area under “My
contacts” or in the “Folders” area under “Contacts”). Enable the “Show this folder as an email
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address book” option in the properties of the contact folder on the “Outlook Address book”
tab.

¢ If you no longer need the synchronized contacts and want to end the synchronization,
delete the corresponding address book list (“Address Book List - <user name>") in Microsoft
Outlook. To restart synchronization, execute the “Open Cloud Address Book” command in
the context menu of the Fabasoft Cloud notification symbol.

17.5 Options Dialog

The “Options” dialog of the Fabasoft Cloud Client offers the following configuration possibilities:
General

e Account
Displays the URL of the current cloud installation. Use the “Reset” button to delete all local
account settings (including the Cloud Folder).
Note: If you click “fully reset” in the following dialog, you can reset all accounts and
directories without checking for local changes. Local changes will be lost.

e Cloud Folder
Displays the base directory of the Cloud Folder in your file system.

o Remove Folder
If you no longer require the synchronization, you can remove the Cloud Folder from the
file system by clicking the “Remove Folder” button. This does not affect the objects in the
Fabasoft Cloud, but not yet synchronized changes in the file system are lost.

o Select Folder
Select a new base folder.
Note: The button is only available, if you have removed the current base folder
beforehand via the “Remove Folder” button.

o Offline
Select this option to turn off the synchronization temporarily (e.g. to avoid roaming
charges).

e Download Folder
You can define the download folder for downloading multiple documents or folder
structures.

o Use Default
The default download folder of the system is used.

e Proxy Server

o Proxy Settings
Opens the proxy settings of the operating system.

o Automatic Proxy Login
Defines whether stored proxy credentials (user name and password) are automatically
used for proxy login. This means that if your proxy requires authentication using a user
name and password, you only need to enter the credentials once.

¢ Run Fabasoft Cloud Client on System Startup
Defines whether the Fabasoft Cloud Client is started automatically when booting the
operating system.

More Options
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The “More Options” button takes you to the user-specific settings in the Fabasoft Cloud. The
default settings are managed by your organization administrator. If necessary, you can apply
these via the “Apply Organizational Settings” button.

Consider in the Web Browser Status
Defines whether errors are displayed in the web browser status.

Allow to Open Web Client
Defines whether the corresponding context menu item is displayed.

Allow to Open Network Drive
Defines whether the corresponding context menu item is displayed.

Allow Contact Synchronization
Defines whether the corresponding context menu item is displayed.

Allow to Open Calendar (Apple macQOS Only)
Defines whether the corresponding context menu item is displayed.

Allow to Open Address Book (Apple macOS Only)
Defines whether the corresponding context menu item is displayed.

Synchronization Mode
Defines the allowed Cloud Folder synchronization types.

Allow Document Exchange via LAN

Use document exchange via LAN to achieve a significant reduction in the required internet
bandwidth and a significantly increased speed. When data in the Fabasoft Cloud has
changed, all Cloud Folders in the local network are contacted first, whether the changed
data is already available locally. If this is the case, the data is synchronized over the LAN and
not over the internet.

Trusted Networks for Document Exchange via LAN

If no network is configured, document exchange via LAN is possible on Microsoft Windows
in all private networks and on Apple macOS in all networks.

If one or more networks are configured, document exchange via LAN is only enabled in
these networks (connection to the Fabasoft Cloud must be possible). Define one IPv4
address or IPv4 address range per line (in CIDR notation, e.g. 198.51.100.0/24).

Contents (Microsoft Windows only)
If you generate a PDF view by default, you still have the option of disabling this option in
individual cases when uploading in order to achieve better performance.

O

Generate PDF Preview on the Workstation (Unencrypted Documents)

You have the option that the PDF view of Office documents is generated locally using
Microsoft Office. This has the advantage that the mapping between the Office document
and the PDF document is much better than converting the PDF document with
LibreOffice on the cloud server.

Generate PDF Preview on the Workstation (Encrypted Documents)

Local generation allows PDF views of Office documents that are encrypted with Fabasoft
Secomo (full end-to-end encryption is ensured). The PDF views are transferred to the
server encrypted as the documents themselves, and can only be decrypted by users who
are authorized in the encrypted Teamroom.

Generate Thumbnails Form the PDF Preview on the Workstation (Encrypted Documents)
Local generation allows thumbnails of Office documents that are encrypted with
Fabasoft Secomo.
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Bandwidth

The settings apply globally to the device.

Download Speed
To limit the download speed for synchronizing, you can specify the maximum bandwidth in
kilobytes per second.

Upload Speed
To limit the upload speed for synchronizing, you can specify the maximum bandwidth in
kilobytes per second.

Certificates (only Ubuntu)

When using a certificate-based authentication under Ubuntu the client certificates have to be
stored in the Fabasoft Client.

18 Glossary

Here you find explanations for terms used in this document.

Button
Buttons are graphical controls that carry out commands.

Click
When you press your left mouse button once and release it again, you achieve a click.

Clipboard

The clipboard enables a simple data exchange between programs or different fields of
applications within an application. Therefore, you usually copy the data via the “Copy"” or
“Cut” command into the clipboard and paste it via the “Paste” command to the new
location.

Context menu
A context menu provides commands, which are reasonable in that current context. Usually
you reach the context menu by performing a right-click.

Double-click
When you press your left mouse button twice in quick succession, you achieve a double-
click (the essential speed depends on the settings of your operating system).

Drag and drop

Drag and drop denotes the opportunity of moving objects from one place to another. For
that, click the object and keep the mouse button pressed. Move the mouse pointer (with
pressed mouse button) to the place, where you want to move the object. Release the
mouse button. The object will be inserted at this point (if it is allowed).

Home
The top level of the content area is named “Home". Further navigation is possible via
widgets.

Menu
A menu provides commands of a certain area. You reach these commands by clicking on
the menu. Menus are located in the menu bar (not visible by default).

Object
In the Fabasoft Cloud you work with objects. Objects store different kinds of information.
The kind of information depends on the object class of the object.
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e Object class
The object class specifies the properties and methods of an object. For example, the object
class Microsoft Word Documentindicates that objects of this object class can contain
Microsoft Word documents.

e Right-click
When you press your right mouse button once you achieve a right-click. Right-clicks are
mostly used to open a context menu at the particular position.

e Selecting
To select an object (e.g. to carry out an action) click the small checkbox of the object.

e Shortcut
Keyboard shortcuts are used to execute actions directly by pressing two or more keys at the
same time.

e Tab
Tabs are used to structure information and input fields on different pages.

19 Open Source Licenses

The open source software contained in the Fabasoft Cloud is licensed under conditions that
require to display the following notes.

A list of the included open source software can be found here:

Open Source Licenses - Fabasoft Software Products

The corresponding copyright annotations and terms of license can be found here:

Open Source Licenses
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